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Copyrights and Trademark Notices
Copyright © 2022 Telestream, LLC and its Affiliates. All rights reserved. No part of this 
publication may be reproduced, transmitted, transcribed, altered, or translated into any 
languages without written permission of Telestream, LLC. Information and 
specifications in this document are subject to change without notice and do not 
represent a commitment on the part of Telestream. Specifications subject to change 
without notice.

Telestream, CaptionMaker, Cerify, DIVA, Episode, Flip4Mac, FlipFactory, Flip Player, 
GraphicsFactory, Kumulate, Lightspeed, MetaFlip, Post Producer, ScreenFlow, Switch, 
Tempo, TrafficManager, Vantage, VOD Producer, and Wirecast are registered trademarks 
and Aurora, ContentAgent, Cricket, e-Captioning, Inspector, iQ, iVMS, iVMS ASM, 
MacCaption, Pipeline, Sentry, Surveyor, Vantage Cloud Port, CaptureVU, FlexVU, PRISM, 
Sentry, Stay Genlock, Aurora, and Vidchecker are trademarks of Telestream, LLC and its 
Affiliates. All other trademarks are the property of their respective owners. 

Adobe. Adobe® HTTP Dynamic Streaming Copyright © 2014 Adobe Systems. All rights 
reserved.

Apple. QuickTime, MacOS X, and Safari are trademarks of Apple, Inc. Bonjour, the 
Bonjour logo, and the Bonjour symbol are trademarks of Apple, Inc.

Avid. Portions of this product Copyright 2012 Avid Technology, Inc.

CoreOS. Developers of ETCD.

Dolby. Dolby and the double-D symbol are registered trademarks of Dolby 
Laboratories Licensing Corporation.

Fraunhofer IIS and Thomson Multimedia. MPEG Layer-3 audio coding technology 
licensed from Fraunhofer IIS and Thomson Multimedia.

Google. VP6 and VP8 Copyright Google Inc. 2014 All rights reserved.

MainConcept. MainConcept is a registered trademark of MainConcept LLC and 
MainConcept AG. Copyright 2004 MainConcept Multimedia Technologies.

Manzanita. Manzanita is a registered trademark of Manzanita Systems, Inc.

MCW. HEVC Decoding software licensed from MCW.

MediaInfo. Copyright © 2002-2013 MediaArea.net SARL. All rights reserved. 

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS “AS 
IS” AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE 
IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR 
PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE COPYRIGHT HOLDER OR 
CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, 
EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, 
PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; 
OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, 
WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR 
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OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF 
ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

Microsoft. Microsoft, Windows NT|2000|XP|XP Professional|Server 2003|Server 2008 
|Server 2012|Server 2016|Server 2019, Windows 7, Windows 8, Windows 10, Media 
Player, Media Encoder, .Net, Internet Explorer, SQL Server 2005|2008|2012|2016|2019, 
and Windows Media Technologies are trademarks of Microsoft Corporation.

NLOG, MIT, Apache, Google. NLog open source code used in this product under MIT 
License and Apache License is copyright © 2014-2016 by Google, Inc., © 2016 by Stabzs, 
© 2015 by Hiro, Sjoerd Tieleman, © 2016 by Denis Pushkarev, © 2015 by Dash Industry 
Forum. All rights reserved.

SharpSSH2. SharpSSH2 Copyright (c) 2008, Ryan Faircloth. All rights reserved. 
Redistribution and use in source and binary forms, with or without modification, are 
permitted provided that the following conditions are met:

Redistributions of source code must retain the above copyright notice, this list of 
conditions and the following disclaimer:

Redistributions in binary form must reproduce the above copyright notice, this list of 
conditions and the following disclaimer in the documentation and/or other materials 
provided with the distribution.

Neither the name of Diversified Sales and Service, Inc. nor the names of its contributors 
may be used to endorse or promote products derived from this software without 
specific prior written permission.

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS “AS 
IS” AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE 
IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR 
PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE COPYRIGHT OWNER OR 
CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, 
EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, 
PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; 
OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, 
WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR 
OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF 
ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

Swagger. Licensed from SmartBear.

Telerik. RadControls for ASP.NET AJAX copyright Telerik All rights reserved.

VoiceAge. This product is manufactured by Telestream under license from VoiceAge Corporation.

x264 LLC. The product is manufactured by Telestream under license from x264 LLC.

Xceed. The Software is Copyright ©1994-2012 Xceed Software Inc., all rights reserved.
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ZLIB. Copyright (C) 1995-2013 Jean-loup Gailly and Mark Adler.

 

Other brands, product names, and company names are trademarks of their respective 
holders, and are used for identification purpose only.

MPEG Disclaimers

MPEGLA MPEG2 Patent
ANY USE OF THIS PRODUCT IN ANY MANNER OTHER THAN PERSONAL USE THAT 
COMPLIES WITH THE MPEG-2 STANDARD FOR ENCODING VIDEO INFORMATION FOR 
PACKAGED MEDIA IS EXPRESSLY PROHIBITED WITHOUT A LICENSE UNDER APPLICABLE 
PATENTS IN THE MPEG-2 PATENT PORTFOLIO, WHICH LICENSE IS AVAILABLE FROM 
MPEG LA, LLC, 4600 S. Ulster Street, Suite 400, Denver, Colorado 80237 U.S.A.

MPEGLA MPEG4 VISUAL
THIS PRODUCT IS LICENSED UNDER THE MPEG-4 VISUAL PATENT PORTFOLIO LICENSE 
FOR THE PERSONAL AND NON-COMMERCIAL USE OF A CONSUMER FOR (i) ENCODING 
VIDEO IN COMPLIANCE WITH THE MPEG-4 VISUAL STANDARD (“MPEG-4 VIDEO”) AND/
OR (ii) DECODING MPEG-4 VIDEO THAT WAS ENCODED BY A CONSUMER ENGAGED IN A 
PERSONAL AND NON-COMMERCIAL ACTIVITY AND/OR WAS OBTAINED FROM A VIDEO 
PROVIDER LICENSE IS GRANTED OR SHALL BE IMPLIED FOR ANY OTHER USE. 
ADDITIONAL INFORMATION INCLUDING THAT RELATING TO PROMOTIONAL, INTERNAL 
AND COMMERCIAL USES AND LICENSING MAY BE OBTAINED FROM MPEG LA, LLC. SEE 
HTTP://WWW.MPEGLA.COM.

MPEGLA AVC
THIS PRODUCT IS LICENSED UNDER THE AVC PATENT PORTFOLIO LICENSE FOR THE 
PERSONAL USE OF A CONSUMER OR OTHER USES IN WHICH IT DOES NOT RECEIVE 
REMUNERATION TO (i) ENCODE VIDEO IN COMPLIANCE WITH THE AVC STANDARD 
(“AVC VIDEO”) AND/OR (ii) DECODE AVC VIDEO THAT WAS ENCODED BY A CONSUMER 
ENGAGED IN A PERSONAL ACTIVITY AND/OR WAS OBTAINED FROM A VIDEO PROVIDER 
LICENSED TO PROVIDE AVC VIDEO. NO LICENSE IS GRANTED OR SHALL BE IMPLIED FOR 
ANY OTHER USE. ADDITIONAL INFORMATION MAY BE OBTAINED FROM MPEG LA, L.L.C. 
SEE HTTP://WWW.MPEGLA.COM.
                                                                                            Lightspeed Live Stream User Guide



 5
MPEG4 SYSTEMS
THIS PRODUCT IS LICENSED UNDER THE MPEG-4 SYSTEMS PATENT PORTFOLIO LICENSE 
FOR ENCODING IN COMPLIANCE WITH THE MPEG-4 SYSTEMS STANDARD, EXCEPT THAT 
AN ADDITIONAL LICENSE AND PAYMENT OF ROYALTIES ARE NECESSARY FOR 
ENCODING IN CONNECTION WITH (i) DATA STORED OR REPLICATED IN PHYSICAL MEDIA 
WHICH IS PAID FOR ON A TITLE BY TITLE BASIS AND/OR (ii) DATA WHICH IS PAID FOR ON 
A TITLE BY TITLE BASIS AND IS TRANSMITTED TO AN END USER FOR PERMANENT 
STORAGE AND/OR USE. SUCH ADDITIONAL LICENSE MAY BE OBTAINED FROM MPEG LA, 
LLC. SEE HTTP://WWW.MPEGLA.COM FOR ADDITIONAL DETAILS.

Limited Warranty and Disclaimers
Telestream, LLC (the Company) warrants to the original registered end user that the 
product will perform as stated below for a period of one (1) year from the date of 
shipment from factory:

Hardware and Media—The Product hardware components, if any, including equipment 
supplied but not manufactured by the Company but NOT including any third party 
equipment that has been substituted by the Distributor for such equipment (the 
“Hardware”), will be free from defects in materials and workmanship under normal 
operating conditions and use.

Warranty Remedies
Your sole remedies under this limited warranty are as follows:

Hardware and Media—The Company will either repair or replace (at its option) any 
defective Hardware component or part, or Software Media, with new or like new 
Hardware components or Software Media. Components may not be necessarily the 
same, but will be of equivalent operation and quality. 

Software Updates
Except as may be provided in a separate agreement between Telestream and You, if 
any, Telestream is under no obligation to maintain or support the Software and 
Telestream has no obligation to furnish you with any further assistance, technical 
support, documentation, software, update, upgrades, or information of any nature or 
kind.

Restrictions and Conditions of Limited Warranty
This Limited Warranty will be void and of no force and effect if (i) Product Hardware or 
Software Media, or any part thereof, is damaged due to abuse, misuse, alteration, 
neglect, or shipping, or as a result of service or modification by a party other than the 
Company, or (ii) Software is modified without the written consent of the Company.
Lightspeed Live Stream User Guide
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Limitations of Warranties
THE EXPRESS WARRANTIES SET FORTH IN THIS AGREEMENT ARE IN LIEU OF ALL OTHER 
WARRANTIES, EXPRESS OR IMPLIED, INCLUDING, WITHOUT LIMITATION, ANY 
WARRANTIES OF MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE. No oral 
or written information or advice given by the Company, its distributors, dealers or 
agents, shall increase the scope of this Limited Warranty or create any new warranties.

Geographical Limitation of Warranty—This limited warranty is valid only within the 
country in which the Product is purchased/licensed.

Limitations on Remedies—YOUR EXCLUSIVE REMEDIES, AND THE ENTIRE LIABILITY OF 
TELESTREAM, LLC WITH RESPECT TO THE PRODUCT, SHALL BE AS STATED IN THIS 
LIMITED WARRANTY. Your sole and exclusive remedy for any and all breaches of any 
Limited Warranty by the Company shall be the recovery of reasonable damages which, 
in the aggregate, shall not exceed the total amount of the combined license fee and 
purchase price paid by you for the Product. 

Damages
TELESTREAM, LLC SHALL NOT BE LIABLE TO YOU FOR ANY DAMAGES, INCLUDING ANY 
LOST PROFITS, LOST SAVINGS, OR OTHER INCIDENTAL OR CONSEQUENTIAL DAMAGES 
ARISING OUT OF YOUR USE OR INABILITY TO USE THE PRODUCT, OR THE BREACH OF 
ANY EXPRESS OR IMPLIED WARRANTY, EVEN IF THE COMPANY HAS BEEN ADVISED OF 
THE POSSIBILITY OF THOSE DAMAGES, OR ANY REMEDY PROVIDED FAILS OF ITS 
ESSENTIAL PURPOSE.

Further information regarding this limited warranty may be obtained by writing:
Telestream, LLC
848 Gold Flat Road
Nevada City, CA 95959 USA

You can call Telestream during U. S. business hours via telephone at (530) 470-1300.

Regulatory Compliance
Electromagnetic Emissions: FCC Class A, EN 55022 Class A, EN 61000-3-2/-3-3, CISPR 22 
Class A

Electromagnetic Immunity: EN 55024/CISPR 24, (EN 61000-4-2, EN 61000-4-3, EN 
61000-4-4, EN 61000-4-5, EN 61000-4-6, EN 61000-4-8, EN 61000-4-11)

Safety: CSA/EN/IEC/UL 60950-1 Compliant, UL or CSA Listed (USA and Canada), CE 
Marking (Europe)

California Best Management Practices Regulations for Perchlorate Materials:
This Perchlorate warning applies only to products containing CR (Manganese Dioxide) 
Lithium coin cells. Perchlorate Material-special handling may apply. See 
www.dtsc.ca.gov/hazardouswaste/perchlorate.
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Obtaining Support | Information | Assistance
Contact Telestream as indicated below.

Telestream Contact Information

Resource Contact Information

Lightspeed Live Support Website: www.telestream.net/telestream-support/
lightspeed-live/support.htm 

Support Email. support@telestream.net

US Phone: 877-257-6245

International Phone: +1 530-470-2036

Terms and times of support services vary, per the terms of 
your current service contract with Telestream.

Lightspeed Live Licensing Website: www.telestream.net/telestream-support/
lightspeed-live/support.htm

License Email: license@telestream.net

Lightspeed Live 
Information, Assistance, 
FAQs, Forums, & Upgrades

Website: www.telestream.net/telestream-support/
lightspeed-live/support.htm 

Support Email: support@telestream.net

For details about the Web API, see the Lightspeed Live 
Stream/Capture Web API Reference on Telestream.net or 
click the More menu  in the web app, select About and 
API Reference.

Telestream, generally Website: www.telestream.net

Sales and Marketing Email: info@telestream.net

Telestream
848 Gold Flat Road
Nevada City, CA USA 95959

Telestream Reseller 
Support

If you purchased your product from a reseller, please 
contact your reseller for support.

International Reseller 
Support

Website: www.telestream.net

See the Telestream website for your regional authorized 
Telestream reseller.

Telestream Technical 
Writers

Email: techwriter@telestream.net

If you have comments or suggestions about improving 
this document, or other Telestream documents—or if 
you've discovered an error or omission, please email us.
Lightspeed Live Stream User Guide
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Return Material Authorization (RMA) Procedure
If your Lightspeed Live Server requires service of any kind, regardless of whether you 
purchased the Lightspeed Live Server from Telestream or an authorized reseller, 
contact Telestream directly for a Return Material Authorization (RMA).

CAUTION: Except for the modular power supplies and disk drives, the Lightspeed Live 
Server is a sealed device, with no user serviceable parts inside. You should never open 
the top cover or attempt to upgrade or alter the server. Doing so exposes you to 
electrical hazard, may damage the unit, and may invalidate your warranty.

Please contact Telestream for all internal service of the server: 

• Email: support@telestream.net

• In the US, telephone: 1-877-257-6245

• From international locations, telephone: 1-530-470-2036.

Provide your organization name, and contact information, the serial number of the 
inoperative unit, and request a Return Material Authorization.

Before returning your Lightspeed Live Server, back up the entire contents of all server 
drives to protect against data loss. See Backing up a Lightspeed Live Server for details.
                                                                                            Lightspeed Live Stream User Guide
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Using Log Files and Other Support Information
These topics explain log files and provide troubleshooting and service information.

 Log Files for Live Stream
Log files can provide valuable information about the operation of Lightspeed Live 
Stream. The following describes how to download the log files and how to change the 
information they contain.

Downloading the Stream Log Files
The Lightspeed Live Stream log files can be downloaded using a browser. The contents 
of the log files may be helpful to Telestream Customer Support to troubleshoot system 
problems. You may want to access and save the log files before making a support call so 
you can email them to Telestream as part of the support process.

Download the Live Services log files by selecting the General Settings Menu  and 
choosing Download System Logs. A zip file will download to your default download 
folder. You can open the zip file and examine the logs, or forward the file to Telestream 
Support with a request for assistance.

These log files are included in the download:

• Devices.csv

• EventLog-Application.evtx

• EventLog-System.evtx

• export.xml

• Processes.cvs

• Registry.cvs

• Services.cvs

• SNMPLogs

• Stats.txt

The SNMPLogs folder contains the following additional items:

• LiveSourceService-[build number]-[date].log—The Source service log records any 
activity with the sources. This includes various activities, such as loss of signal, 
change of format, sources being added, or sources being removed.

• LiveStreamService-[build number]-[date].log—The Stream service log records any 
encoder failures and the service starting.

• packagingLog

• traceLog
Lightspeed Live Stream User Guide
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Changing Log Content Settings
The information created in the log files can be changed by editing settings in the 
configuration files that control logging file generation. The log files are located in 

C:\Program Files\Telestream\Live Stream Server\ and C:\Program 
Files\Telestream\Live Source Server\ folders.

CAUTION: Before making changes to the configuration files, make backups by 
copying the existing files and saving them to a safe location. 

The configuration files are:

• ChannelEncode.exe.config

• ChannelProgram.exe.config

• LivePreview.exe.config

• LiveService.exe.config

• SourceService.exe.config

Note: The default Warn Log level should not be changed unless directed by Customer 
Service or you are tracking a specific issue as an advanced user.

The following fields in the configuration files can be edited to change logging results:

• logconsole

• logfile

• email

• elastic

The above fields can be edited to use any of these logging levels: 

• Off

• Fatal

• Error

• Warn

• Info

• Debug

• Trace

For details about using NLog to modify log file outputs, refer to the NLog tutorial: 
https://github.com/NLog/NLog/wiki/Tutorial#log-levels.
                                                                                            Lightspeed Live Stream User Guide
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Locating the Live Stream Service Tag
When contacting Telestream (Obtaining Support | Information | Assistance) about 
Lightspeed Live Stream always include your system's Service Tag. The Service Tag can is 
located in the Live Stream web application’s About dialog. It is unique to each 
Lightspeed Live Server.

To open the About dialog, click the General Stream Settings icon  in the upper right 
of the Live Stream interface and select About to open the About dialog.

Note: The Service Tag is only present after a Lightspeed Live Server has been 
licensed. The Service Tag continues to display if the server license has expired. 

Service Tag
Lightspeed Live Stream User Guide
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Introducing Lightspeed Live 
Capture & Live Stream
 Telestream’s Lightspeed Live Capture and Lightspeed Live Stream products are 
enterprise-class products hosted on a Lightspeed Live Server to deliver real-time, 
enterprise-class live and tape-based media capture and streaming for media and 
entertainment companies, corporations, government agencies, and educational 
facilities. 

Telestream recommends that you read this chapter first, to become familiar with the 
Lightspeed Live Server and the products it hosts: Lightspeed Live Capture and 
Lightspeed Live Stream.

Next, we suggest that you refer to Installing | Updating | Managing a Lightspeed Live 
Server to install your Lightspeed Live Server(s) in your facility. You can also use this 
chapter to manage and monitor your servers.

Finally, turn to Configuring Vantage for use with Live Capture to get your system initially 
set up and configured to start capturing video. The Up and Running topic describes the 
initial configuration tasks you should complete to get it up and running. 

Topics
■ Lightspeed Live Stream Overview

■ Lightspeed Live Capture Overview

■ Live Capture Web Apps

■ Using Live Stream and Live Capture Concurrently

■ Lightspeed Live Application Program Interfaces

■ Lightspeed Live Server Overview

■ Lightspeed Live Server Specifications
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Lightspeed Live Stream Overview
Telestream® Lightspeed™ Live Stream is an enterprise-class live streaming system that 
ingests, encodes, packages and deploys multiple sources to multiple destinations in 
real-time. 

Lightspeed Live Stream encodes a live program at highest quality and simultaneously 
streams the output over the Internet or intranet via Transport Stream or RTMP, to origin 
servers for distribution to Content Delivery Networks (CDN). Lightspeed Live Stream 
can be deployed on a dedicated server for live, multi-screen services or installed on the 
same server as Lightspeed Live Capture, where they share SDI and network-based 
resources.

Control via Web, 
API, or Calendar.

HLS, DASH, and more

Web 
Service

API

DELIVER

Live
Sources

IP

SD/HD/UHD 
SDI

Lightspeed Live
Stream

Lightspeed Live Server
CDN

Origin

Lightspeed Live Stream runs exclusively on Telestream’s Lightspeed Live Server. 
Lightspeed Live Stream servers can be joined together to create a multi-server 
streaming group. The Telestream Live Service is configured, operated, and controlled 
via the Live Stream web application, and a REST API is also provided for integration and 
control by other systems.

Lightspeed Live Stream ingests multiple baseband SDI live sources in 3G and 12G as 
well as IP sources (MPTS, SPTS, RTMP) via Ethernet. Live Stream also ingests ST 2110 
(both text and HTML-formatted SDP files) when the Lightspeed Live Server is equipped 
with a 25G Ethernet NIC on supported Lightspeed Live servers—see Lightspeed Live 
Server Specifications.

Video output is encoded and delivered to one or more destinations—or to a localhost 
origin server—as Adaptive Bit Rate (ABR) packages, including HTTP Live Streaming 
(HLS), CMAF, ATS, and MPEG DASH (in AVC and HEVC) at SD, HD, or UHD resolutions. 
Hardware-based HEVC encoding is supported with an optional SDI HEVC input card—
see Lightspeed Live Server Specifications.

Lightspeed Live Stream can also record an MP4 version of any variant for use as an 
archive or proxy of a stream or package.
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Note: Lightspeed Live Stream—including the Live Stream web app and background 
processes—operates completely independent of the Vantage Media Processing 
Platform. You can obtain a Lightspeed Live Stream license by contacting Telestream 
Licensing (Obtaining Support | Information | Assistance). 

When you’re ready to get started, proceed to the Up and Running Checklist.

Lightspeed Live Capture Overview
Designed for demanding enterprise-class broadcast and professional video capture 
applications, Lightspeed Live Capture offers premium features and exceptional 
performance. Lightspeed Live Capture excels at performing demanding video ingest 
from similar or mixed format sources, while simultaneously creating multiple high 
resolution and proxy files from any of its inputs.

Lightspeed Live Capture is flexible and scalable. Based on various Lightspeed Live 
Server capabilities, Live Capture supports up to eight 3G HD-SDI inputs with active loop 
through for monitoring, or up to two UHD/4K inputs with active loop through for 
monitoring. When equipped with 12G SDI, it supports two HD SDI or UHD/4K inputs.

Live Capture also supports IP sources such as RTMP, Transport streams, and ST 2110 
(both text and HTML-formatted SDP files) when the Lightspeed Live Server is equipped 
with a 25G Ethernet NIC on supported Lightspeed Live servers—see Lightspeed Live 
Server Specifications.

Lightspeed Live Capture is capable of capturing eight concurrent HD outputs in select 
formats and codecs and two UHD/4K formats in select formats and codecs. Live 
Capture processes video in 16-bit space to preserve source quality and encodes it in 
multiple video formats, creating high-resolution mezzanine concurrent H.264/AVC 
proxy files. Files are written directly to the Live Capture server’s local RAID storage or to 
external shared NAS | SAN storage, or written to remote storage locations via Aspera, 
Signiant and other WAN accelerations products and media storage platforms.

Lightspeed Live Capture is configured, operated, and controlled via the Live and Tape 
Capture Web apps, and a REST API is also provided for integration and control by other 
systems. Optional editing, scheduling, and live playback web apps are also offered.
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VTR | Server

Editing worklfows:
Adobe | Apple | Avid 
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Cameras

VTR | Server
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Live 
Schedule

Live Play

Broadcast | Playout servers

Source
Manager

LightSpeed Live Server

up to 4 x UHD/4K 12G SDI

FTP | S3 | Aspera

More Choices, More Flexibility
Lightspeed Live Capture offers a variety of methods to ingest video: 24/7/365 
scheduled recording of live feeds, RS-422-controlled capture from VTR, manual 
recording including Gang control, DAI (SCTE-104) triggering, recurring segment 
creation, and automated control through a simple Web Service REST API. 

Lightspeed Live Capture provides direct support for capturing video into MXF OP1a, 
QuickTime or Telestream’s TIFO. To maintain closed captions and other ancillary data, 
Lightspeed Live Capture preserves this data in MXF, QuickTime, TIFO and Avid 
proprietary containers.

Media Platform Friendly
Lightspeed Live Capture creates growing files that directly support 3rd party Media 
Asset Management (MAM) and Non Linear Edit (NLE) solutions including Avid Media 
Central | Production, Avid Media Composer, Adobe Premiere, DaVinci Resolve, Apple 
Final Cut Pro and others.

Fast, Parallel Open Media Processing
As a standalone system, Lightspeed Live Capture acquires SDI video from independent 
input channels or through IP connections. Multiple Live Capture servers can be joined 
together to create a Lightspeed Live Capture array under a common control interface.

In addition, Live Capture can be seamlessly integrated directly with Vantage, enabling 
unlimited workflow possibilities via Vantage’s Media Processing Platform.
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When integrated into Vantage, Lightspeed Live Capture workflows support Vantage 
Open Workflows. Open Workflows enable transcoding, packaging, and deployment to 
occur in near real time in Vantage, as the media is being captured. These advanced 
media processing workflows complete within seconds following the end of media 
capture.

File-Based Transcoding on Lightspeed Live Servers
File-based transcoding directly on a Lightspeed Live Server is an optional, separately 
licensed feature. Transcoding options enable Vantage file-based transcoding when not 
in use capturing media, enabling you to utilize your Lightspeed Live Capture Server for 
both live video capture and traditional file-based transcoding.

Note: Live Capture is integrated with Vantage Telestream Media Framework for 
ingesting live, live-linear and tape-based media for serializing streaming media into 
files for processing in production, post-production and broadcast workflows. In the 
context of this guide, it is simply referred to as Vantage. 
If you are performing concurrent ingest and encoding—using Open Workflows 
(Transcode while Ingest workflows)—transcoding must be performed on a separate 
server, not on the Capture server where ingest is executing.

When you’re ready to get started, proceed to the Up and Running Checklist.

Live Capture Web Apps
Lightspeed Live Capture includes several client programs implemented as Web apps:

• Live Capture—The Live Capture Web app enables you to capture live streams and 
save them as files.

• Tape Capture—For tape-based media, the Tape Capture Web application enables 
you to capture tape-based media, typically in conjunction with a VTR.

• Live Schedule—Live Schedule is a Windows service-based web application; an 
optional, separately licensed feature. Live Schedule enables you to create events 
you want captured for each source, and automatically starts and stops capturing 
video on an event-by-event basis. Live Schedule is provided in its own installer and 
must be installed separately from other web apps.

• Live Play—The Live Play web app (see the separate Live Play User Guide) is an 
optional, separately licensed feature. Live Play is an enterprise-class software solu-
tion that provides flexible and scalable SDI video playback on Telestream’s Light-
speed Live Server. Live Play enables you to perform confidence monitoring of file-
based and streaming media by playing it back on-screen and via SDI.

• Source Manager—Source Manager enables you to create, configure, and manage 
all of your video source inputs from a central application.
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• Group Portal—The Group Portal web app in Live Stream enables you to organize 
your servers into an array, configure server redundancy within groups to help 
reduce downtime, and create and assign multiple users and roles.

In the context of Live Capture, its functionality is limited to creating users with spe-
cific privileges for managing or monitoring servers in a group according to typical 
roles.

Live Capture is supported by these Telestream Windows services:

• Telestream Live Source Service

•  Telestream Schedule Service (when Live Schedule is installed)

• Telestream Play Service (when Live Play is installed)

The Vantage domain installed on the Lightspeed Live Server includes these programs:

• Vantage Management Console

• Vantage Workflow Designer

• Vantage Workflow Portal

The Vantage domain also includes these Vantage Windows services:

• Vantage Analysis Service

• Vantage Avid Service (requires optional licensing)

• Vantage Communicate Service

• Vantage Live Service

• Vantage Metadata Service

• Vantage Metric Service

• Vantage Monitor Service

• Vantage Signiant Service (requires optional licensing)

• Vantage SDK Service

• Telestream Cloud Service

• Vantage Transcode Service (requires optional licensing)
• Vantage Transport Service

No other Vantage or Telestream services can be installed or executed on a Lightspeed 
Live Server without a specific license.

Using Live Stream and Live Capture Concurrently
Lightspeed Live Server can host Lightspeed Live Capture or Lightspeed Live Stream 
independently or it can host both systems concurrently, sharing SDI and network-
based sources. 
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Note: Release notes and Support Services are the best sources of compatibility 
information regarding the use of Live Stream and Live Capture on the same server.

Although both products operate independently, the greatest benefits are realized 
when Lightspeed Live Stream is installed on a server with Live Capture coupled to 
Telestream’s Vantage platform for complete workflow orchestration. In this 
configuration, you can concurrently stream and capture live media.

For example, during a live event, you can stream real time video and ingest high-quality 
mezzanine formats such as MXF or QuickTime. 

Through this integration, you can simultaneously make use of both the real-time 
streaming capability and the full range of video processing that Vantage offers.

CAUTION: Because concurrent Live Capture and Live Stream use shared components, 
care is required to avoid over subscription of CPU | GPU | RAM and other resources. 
Source media connected to Lightspeed Live Server hardware ports can be used by 
both Live Capture and Live Stream. See Overview in the Lightspeed Live Capture User 
Guide for details on calculating Live Capture resource usage. See the Lightspeed Live 
Server CPU/GPU Usage Guidelines for information about creating efficient Live Stream 
channels.

File Loop | Slate Sources Not Supported in Capture
Live Stream and Live Capture systems hosted by the same Lightspeed Live Server are 
not constrained in their configuration, which allows for nearly unlimited combinations 
of resources. Live Stream enables you to create File Loop, RTMP, Slate, and Transport 
Stream sources. These sources can also be processed in Vantage’s Capture action, in 
addition to the SDI sources that both Capture and Stream can both use.

However, File Loop and Slate sources are not supported for Capture workflows; they are 
implemented only for use in Live Stream. For information on where sources are 
selected, see the Capture action’s help page Configuring Program Settings topic.

Lightspeed Live Application Program Interfaces
These Lightspeed Live web APIs enable you to monitor and control your Lightspeed 
Live system within a broader, web services-based system or create your own 
customized monitoring system.

■ Lightspeed Live Capture Web API

■ Lightspeed Live Stream Web API

■ Lightspeed Live Source Web API

■ Lightspeed Live Schedule Web API

■ Lightspeed Live Play Web API
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You can also create a web services-based system to control streaming and capture 
beyond the functionality or capability of Telestream’s Vantage Capture and Stream web 
applications, to meet your organization’s requirements.

Lightspeed Live Capture Web API
The Lightspeed Live Capture Web API enables recording of live streaming media in a 
Vantage workflow to be controlled manually via the HTTP web service. The Capture 
web API is implemented in the Lightspeed Live Capture web service.

The Live Capture Web API is described in the Lightspeed Live Capture Web API 
Reference at the bottom of the Live Support page on the Telestream web site.

Lightspeed Live Stream Web API
The Lightspeed Live Stream Web API enables custom programs to remotely control the 
operation of the Live Stream services by implementing it in a custom program. 

To access the Live Stream Web API Reference directly in Lightspeed Live, click the 
General menu in the upper right of the Live Stream web application  and select 
About > Web API Reference.

Lightspeed Live Source Web API
The Lightspeed Live Source Web API supports the insertion of SCTE-35 and ID3 tags. 
Use of the Source API to insert tags can be performed during capture or stream 
sessions. The Source API is implemented in the Lightspeed Live Source web service.

The Lightspeed Source web API is also described in the Lightspeed Live Capture Web 
API Reference.

Lightspeed Live Schedule Web API
The Lightspeed Live Schedule Web API enables scheduling, management, and query of 
capture events to be controlled manually via the HTTP web service. The Live Schedule 
web API is implemented in the Lightspeed Live Schedule web service.

The Lightspeed Schedule web API is described at http://<LSL_Server>:6500/
swagger/index.html, where <LSL_Server> is the host nameof the Lightspeed Live 
Server or keyword localhost when accessed locally.

Lightspeed Live Play Web API
The Lightspeed Live Play Web API enables scheduling, management, and query of 
capture events to be controlled manually via the HTTP web service. The Live Scheduler 
web API is implemented in the Lightspeed Live Scheduler web service.
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The Lightspeed Live Play web API is described at http://<LSL_Server>:8091/
help/index.html, where <LSL_Server> is the name of the Lightspeed Live Server 
or keyword host when accessed locally.

Lightspeed Live Server Overview
Telestream’s Lightspeed Live Server is a high-speed, high-capacity, real-time Windows 
platform specifically configured as a media processing platform. It hosts Live Capture 
and Live Stream. Telestream offers several models of Lightspeed Live servers—in two, 
four, and eight port configurations—to meet application demands and provide 
improved hardware platforms as technology improves.

Note: The Lightspeed Live Server and Lightspeed Server are different hardware 
platforms. Lightspeed Live Server hosts Telestream’s Live products, including Live 
Capture and Live Stream; Lightspeed Server supports Vantage.

The Lightspeed Live Server hosts the Telestream Media Framework with the Lightspeed 
Live Stream and Lightspeed Live Capture web applications (dedicated or co-hosted), 
for high-performance media processing.

User guides and other documentation is provided on flash drive (optional DVD by 
request). The same guides are also published on the Telestream web site.

For details and specifications, see Lightspeed Live Server Specifications.

Lightspeed Live Server Specifications
This table summarizes the Lightspeed Live Server hardware:

Components Description

Operating System Windows Server 2016 | 2019—C2 | C3 | C4 Lightspeed Live 
Server

RAM ECC DDR4 (speed and amount vary by model)

CPU Dual Multi-Core CPUs

GPU 1 GPU

OS Drives 1 SATA SSD drive for Windows OS (top right-most slot)

1 optional OS SSD drive configured in RAID 1 (bottom right slot)

Storage Drives SATA SSD or SAS hard drives
(capacity quantity and size vary by model)

SAS Controller Supports up to 8 SAS3 or SATA3 media drives
Lightspeed Live Stream User Guide
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System Power
The chassis features redundant hot-swappable dual digital power supplies that 
automatically sense the input voltage between 100v to 240v, and operate at that 
voltage. Power cords plug directly into the power supply units at the back of the 
chassis, and the Power On/Off (0/1) button on the front energizes the unit. A green light 
indicates that the power supply is operating. When a power supply fails or is 
disconnected, an amber light on the power supply illuminates and an alarm sounds. 

PCIe Option Slot 1 half-height PCIe 3.0 x8 slot or 1 full-height PCIe 3.0 x16 slot 
(model-dependent)

SDI Video Input/
Output

For Capture and Stream:
Gen 1|C2: One 4-port DIN 1.0/2.3 video card for four SH/HD or 
one QuadLink UHD Processor affinities should be balanced. 
Generally, SDI 1 | 3 | 5 | 7 are assigned an affinity value of 1. SDI 2 
| 4 | 6 | 8 are assigned an affinity value of 2, plus LTC port.

C3|C4: One 8-port DIN 1.0/2.3 video card for eight SH/HD or 2 
QuadLink UHD Processor affinities should be balanced. 
Generally, SDI 1 | 3 | 5 | 7 are assigned an affinity value of 1. SDI 2 
| 4 | 6 | 8 are assigned an affinity value of 2, plus LTC port

OR

One 4-port BNC video card for 2 12G SDI UHD in and 2 out, plus 
LTC port.

Live Stream Only: Optional, 4-port, full-height BNC video card 
for SD/HD or UHD QuadLink 3G SDI plus LTC port, with 
hardware-based HEVC encoding.

USB 3.0 2 front plane, 2 back plane USB ports

Ethernet Four 10G Ethernet 10Base-T ports (back plane)

Ethernet (media) C4: optional 25G Ethernet NIC with 2 SFP28 ports for ST 2110 
processing with SMPTE 2022-7 fall back. When installed, no SDI 
video card can be installed.

VGA Monitor 1 VGA monitor port

AC Inputs 2 redundant AC inputs, 100-240 Volts, 4.5-9.5 Amps, 50-60 Hz.

RS-422 4-port RS-422 VTR interface kits (Capture only). Optional, 
purchased separately. See Connecting VTR Systems.

Operating 
Environment

10 degrees C to 35 degrees C, 8-90 percent humidity (non-
condensing)

Components Description
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Drives
The chassis supports up to eight SAS hot-swappable 2.5" disk drives. The drive bays on 
the left (viewed from the front) support SAS3 media drives, four of which are included 
as standard. These eight storage drives can be configured for RAID 0, 1, 5 or 10 (RAID 5 
set at the factory). The two additional bays on the right support only SSD/SATA drives. 
The top right bay is reserved for the Windows OS drive, and the bay below it is available.

When replacing or adding hard drives, replace with exact manufacture and model of 
drive. Drives vary by model; see Obtaining Support | Information | Assistance for details.

Cooling System
The system cooling design features eight 4-cm counter-rotating fans located in the 
middle section of the chassis. Fan speed is controlled by the IPMI system management 
software to respond to fluctuations in system temperature.

Dual air shrouds direct air flow to the CPUs and other components that require cooling. 
The power supply module also includes a cooling fan.

SDI Video Cards
An SDI video card is installed in one of the Lightspeed Live Server’s PCIe card slots.

Note:  For C4, an optional, 2-port 25G Ethernet NIC enables ST 2110 capture. The C4 
supports either an SDI card or a 25G Ethernet card, but not both in the same server.

Each of these cards is supported for use in Live Capture and Live Stream, except for the 
HEVC card (Stream only):

• 4-SDI 3G Card—provides four SingleLink 3G SDI ports enabling four SD / HD sig-
nals or one QuadLink UHD signal. 

• 8-SDI 3G Card—provides eight SingleLink 3G SDI ports enabling eight SD / HD sig-
nals or two QuadLink UHD signals.

Each SDI port is a DIN 1.0/2.3 connector, which can be converted to BNC with the 
included DIN 1.0/2.3-BNC converter cables. For UHD, SDI-1 through SDI-4 and/or 
SDI-5 through SDI-8 (model-dependent), BNC connectors can be used to provide 
Ultra HD input. The UHD signal is QuadLinked—connected to all four ports (SDI-1 
through 4 or SDI-5 through 8 depending on the model). All other resolutions use 
one port per input.

• 4-SDI 12G Card (C3 | C4)—provides four UHD 12G SDI ports with BNC connectors, 
enabling two UHD input signals and two output signals. 

• 4-SDI HEVC Input Card (for Live Stream only)—provides four 3G SDI ports pro-
viding four SDI signals or one QuadLink UHD signal. This card supports hardware-
based HEVC encoding. This card is a full-height card with BNC connectors.
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Each of these cards provide one port for analog Longitudinal Time Code (LTC) for use 
across all SDI input signals (see Data and Signal Connections).

Ethernet Network Interface Cards
Four 10G Ethernet back plane ports are provided for network connectivity and video 
playback.

For C4 only, an optional 2-port 25G Ethernet NIC for ST 2110 capture may be utilized. In 
servers equipped with a 25G Ethernet card, SDI cards are not supported.
Lightspeed Live Stream User Guide



Introducing Lightspeed Live Capture & Live Stream 
Lightspeed Live Server Specifications

33
SDI Source Video Formats
Lightspeed Live Capture supports the following SDI source formats, in the indicated 
frame rates (A/B refers to Level A/Level B): 

Source               Rate 23.98 24 25 29.97 30 50
50
A/B 59.94

59.94
A/B 60

60
A/B

SD NTSC 525i ■

SD PAL 625I ■

HD 720P ■ ■ ■

HD 1080p ■ ■ ■ ■ ■ ■ ■ ■

HD 1080PsF ■ ■ ■ ■ ■

HD 1080i ■ ■ ■

UHD 3840x2160p
2SI/Square Div.

■ * ■ * ■ * ■ * ■ * ■ ■ ■

UHD 
3840x2160PsF
Square Div.

■ ■ ■

UHD 
3840x2160PsF
Square Div.

■ * ■ * ■ * ■ * ■ * ■ ■ ■

4K 4096x2160PsF
Square Div.

■ ■ ■

* Image division and 3G level are detected automatically based on VPID data. If VPID 
data is not present or is incorrect, image division must be manually set. In the Source 
Manager web app, display the Configure Source panel (when Video Mode is specified 
as QuadLink Video) and set QuadLink Image Division to 2SI. See Configuring SDI Sources 
for details.

SDI Input Audio
– S16-channel 24-bit Little Endian SDI embedded, 48 kHz synchronous

Input Reference (Live Capture Only)
• SD/HD—Reference is derived from an internal free-run clock on each SDI input. 

• QuadLink UHD—Reference is derived from SDI 1.

Output Reference (Live Play Only)
• SD/HD—Reference is derived from internal free run clock or external bi-level or tri-

level reference input.
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Notes: All 16 channels of audio for UHD are provided on SDI 1 and SDI 5 (model-
dependent). 

Sources in the YCbCr 444 or RGB 444 color space are not supported. Only the YUV 422 
color space is supported.

GPU
The on-board GPU accelerates video processing and H.264/H.265 media creation. Using 
the GPU in combination with Lightspeed Live’s powerful dual CPU processors enables 
the creation of streaming and captured media from multiple live sources. 

Expansion Card Slots
Each Lightspeed Live Server provides one optional full- or half-height PCIe card, 
installed by Telestream. 

In order to ensure optimal product performance and warranty coverage, ensure that 
Telestream products are used in accordance with the following product policy. It is 
critical that our product policy be adhered to when using add-in cards:

• Add-in card(s) are to be installed by Telestream, or an authorized agent, at or before 
commissioning.

• Only Telestream-qualified add-in cards can be used. For the most up-to-date list 
refer to the Lightspeed Live Server product sheet on the Telestream.net web site. 
Using untested and unknown add-in cards voids the product warranty.

Note: Except for externally removable power supplies and disk drives, the Lightspeed 
Live Server has no user-serviceable parts. To maintain your warranty, any repair or 
additional PCI card installation and any service inside the sealed top cover must be 
performed by Telestream or an authorized Telestream service technician.

RS-422 VTR Interface Kit Option for Capture
The optional RS-422 VTR Interface Kit (4-port and 8-port versions) provides the ability to 
connect up to four or eight VTR units to the Lightspeed Live Server, and allows a VTR to 
be remotely controlled by the Lightspeed Tape Capture web application to facilitate 
conversion of tape-based media into digital video files.
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Front Panel
The Lightspeed Live Server has a removable front bezel. By removing the bezel, you can 
access the system interface buttons and LEDs, drives, and front USB ports. 

Front Panel Features
The front bezel provides visibility of the system monitoring LED indicators and allows 
pinhole access to the recessed power button. This graphic illustrates the front bezel 
and below, the bays exposed when the bezel is removed:

LEDs On/Off Button

2 USB 3.0

SSD/SATA OS Drive

2 or 4 drives (model 
dependent)

4 optional bay drives Optional SSD or SATA 
drive bay

UID Button

LEDs (left to right)
• System Overheat | FAN Fail | UID

• Network Activity (NIC1)

• Network Activity (NIC2)

• Hard Drive Activity

• Power

Power On/Off Button

The power button is directly below the LEDs. Press the power button to perform a 
normal power up/power down cycle or a hardware reboot (hold the button down for 4 
seconds). A reboot abnormally terminates connected clients and systems and should 
be done only in the event of an unrecoverable system error. Under normal conditions, 
you should close all web apps and client programs and shut down the Vantage domain 
and log out of Windows before cycling power.

UID Button (hidden)

On Lightspeed Live servers with the bezel shown above, the UID button (which is 
mounted on the front panel immediately to the left of the power button), is hidden by 
the bezel. To utilize the UID button, first remove the bezel. The UID button alternately 
turns on and off the blue front and rear panel UID LED (far left), used to locate a 
particular unit among many units in a rack or server room.

On Lightspeed Live servers utilizing the former bezel, the button is accessible without 
removing the bezel.
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USB Ports

Two USB 3.0 ports for general use are located below the LEDs and buttons.

Drives

The top right-most drive bay houses the SSD/SATA Windows OS drive, and the drive 
beneath it is an available SATA drive bay. These drives have their own controller, 
separate from the storage drives.

To the left of the OS drive are 8 SAS media storage drive slots containing the 4 standard 
and 4 optional media drives. These drives are configured for RAID 5 and have their own 
controller separate from the OS drive.

Rear Panels
These are the rear panel ports and connectors:

• 2 redundant AC power connectors—connect to a 10-amp or greater AC source

• 4 10Base-T Ethernet LAN ports—connect as required to LAN

• 2 USB 3.0 ports—connect as required to keyboard, mouse, or other serial device. 
When used for RS422 VTR control, use of a hub is not permitted.

• 1 IPMI-dedicated Ethernet port that should not used for other purposes

• 1 VGA monitor port

• 1 COM control port (not used)

• 1 3G SDI card with 2 | 4 | 8 ports

OR

1 12G SDI card with 4 ports

OR

• (C4 only) 1 25G Ethernet NIC with 2 Fiber Channel ports

Note: One SDI card or one 25G NIC is permitted—SDI and 25G NIC cards can not be 
installed in the same server.

• 1 analog LTC port

Additional PCIe cards can be optionally factory installed in PCIe expansion slots. For 
details of each backplane component/connector, see Making Connections.

SDI Video Connections
The Lightspeed Live Server includes one of three types of 3G SDI video cards. Two cards 
are supported in both Live Capture and Live Stream. For Live Stream only, an optional 
SDI card with hardware-based HEVC encoding is supported. For a complete list of 
supported video formats, see SDI Video Cards.
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Note: On a C4, you can optionally install a 2-port 25G Ethernet NIC in place of the SDI 
card.

4-port 3G SDI Card

The 4-port 3G SDI card has 5 DIN 1.0/2.3 connectors with 5 DIN 1.0/2.3 to BNC adapter 
cables (shown here right side up):

Note: The 4-port SDI card is inserted upside down into the rear panel at the bottom 
right corner. Refer to imprinted labels (1 2 3 4) and R for proper cable connection. The 
RS-422 port is unused.

• 4 SDI Ports (1-4): SD/HD 3G x 1080 video formats; audio 16-channel, 24-bit SDI 
embedded, 48 kHz synchronous

• Input Reference (R): LTC timecode input

8-port 3G SDI Card

The 8-port 3G SDI card has 9 DIN 1.0/2.3 connectors with 9 DIN 1.0/2.3 to BNC adapter 
cables:

 

Note: Refer to imprinted labels (1 through 8) and R for proper cable connection.
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• 8 SDI Ports (1-8): SD/HD 3G x 1080 video formats; audio 16-Channel, 24-bit SDI 
embedded, 48 kHz synchronous

• Input Reference (R): LTC timecode input.

4-port 12G SDI Card

The 4-port 12G SDI card has 5 BNC connectors:

 

Note: Refer to imprinted labels (1 through 4) and R for proper cable connection.

• 4 SDI Ports (1-4): 12G x UHD1080 video formats; audio 16-Channel, 24-bit SDI 
embedded, 48 kHz synchronous for 2 input and 2 output operation

• Input Reference (R): LTC timecode input.

4-SDI 3G Card with HEVC (Supported by Live Stream only)

The HEVC 4-SDI card is a full-height card. It provides hardware-based HEVC encoding 
for Live Stream, and provides 5 BNC video input connectors: 

• 4 SDI Ports: SD/HD 3G x 1080 video formats; audio 16-Channel, 24-bit SDI embed-
ded, 48 kHz synchronous

• 1 LTC Timecode Input: The BNC connector on the far right.
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25G Ethernet NIC Card

On a C4, the 25G Ethernet NIC card is provided in place of the SDI card. It provides 
support for ST 2110 video, with two Fiber Channel ports: 
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Installing | Updating | 
Managing a Lightspeed 
Live Server
Lightspeed Live Server models include the Gen 1—the first-generation 4 port, C2 (2 
port), C3 (4 port), and C4 (8 port) models for hosting Lightspeed Live Capture and 
Lightspeed Live Stream.

This chapter describes how to install your Lightspeed Live Server into an equipment 
rack, make connections, and configure it for operation. This chapter also describes how 
to update Live Capture and Live Stream to the current version.

Other topics include OS management, maintaining the server, and monitoring a 
Lightspeed Live Server during operation. Topics apply to all servers unless otherwise 
noted.

Note: For Live Capture configuration and management, see Capturing Live Video. For 
Vantage configuration for utilization with Live Capture, see Configuring Vantage for use 
with Live Capture.

Topics
■ Installing the Lightspeed Live Server

■ Renaming a Lightspeed Live Server

■ Managing the Windows Operating System 

■ Maintaining a Lightspeed Live Server

■ Monitoring Lightspeed Live Servers via SNMP
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Installing the Lightspeed Live Server
This topic provides instructions for unpacking a Lightspeed Live server and installing it 
safely and securely in a computer server rack, and making the required connections.

WARNING: Only trained and qualified personnel should be allowed to install, replace, or 
service this equipment.

CAUTION: Except for replaceable power supplies and hard drives which may be 
accessed from the outside, the Lightspeed Live Server is a sealed device, with no user-
serviceable parts or user-accessible expansion slots. You should never open the top 
cover or attempt to upgrade or alter the server. Doing so exposes you to electrical 
hazard, may damage the unit, and may invalidate your warranty. If you have hardware 
or software problems with your Lightspeed Live Server, see Obtaining Support | 
Information | Assistance to obtain service.

Note: Before proceeding, collaborate with your network administrator to determine 
computer and network setting requirements.

■ Unpacking the Server

■ Rack-Mounting Your Lightspeed Live Server

Unpacking the Server
The Lightspeed Live Server arrives packed in a heavy-duty, cardboard box with foam 
padding surrounding the device to protect it. During unpacking, inspect the container 
and the contents for damage. In the event of damage, report it immediately to the 
freight carrier and to Telestream Support.

The server is heavy. Unpack the server on a strong, well-balanced table that can 
support the full weight of the server and shipping container without tipping.

Inside the box are the server, optional components such as rack rails, DIN 1.0/2.3-to-
BNC cables, and printed and flash-drive documentation (a DVD is available by request). 
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Rack-Mounting Your Lightspeed Live Server
The Lightspeed Live Server is designed to fit into a standard 19-inch (483 mm) 
equipment rack with support front and rear, using supplied rack rails and rear support 
extensions.

Assembling the Rails
The inner rail extensions install on each side of the chassis as shown.

Align the extension holes with the hooks on the side rail and slide the extension 
forward to engage the hooks until the quick release bracket snaps into place. For added 
stability, you can secure the extension with a screw.

Assemble the outer rails by sliding the front and rear sections together. 
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Installing Outer Rails into the Rack
Next, install the outer rails into the rack as shown in this figure: 

Proceed to the appropriate topic for your rack—round hole or square hole.

Installation in Round Hole Rack

If your rack has round threaded holes, first remove the aluminum block at the end of 
the rail via the 2 screws, as shown here:

Remove these two screws 
to remove the block.

1. Push the rail into the rack until the quick release bracket snaps into place, securing 
the rail to the rack.

2. Extend the rear of the rail to align it with the holes on the rear of the rack (D). 

3. Push the rail into the rack until the quick release bracket snaps into place, securing 
the rail to the rack. 
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Installation in Square Hole Rack
1. Align the square pegs on the front of the rail with the square holes in the front of 

the rack (C). 

2. Push the rail into the rack until the quick release bracket snaps into place, securing 
the rail to the rack.

3. Extend the rear of the rail to align its square pegs with the square holes on the rear 
of the rack (D). 

4. Push the rail into the rack until the quick release bracket snaps into place, securing 
the rail to the rack. 

CAUTION: To prevent the server from falling and becoming damaged, be sure the 
rails are solidly in position and ready to support the full weight of the chassis. 
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Installing the Server in the Rack
When selecting a position in a rack to place the server, be sure to allow a minimum of 
30 inches clearance at the back of the server for sufficient cooling airflow and servicing.

To install the server, follow these steps:

1. Slide the inner rail extensions forward into the front of the outer rails.

2. Support the chassis and align the back of the chassis with the front of the rails.

3. Push the chassis backward, sliding it into the rack rails, until the chassis clicks into 
the locked position.

CAUTION: To prevent the server from falling and becoming damaged, be sure to 
insert it securely in the rack before you remove support.
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Removing the Server from the Rack
To remove the server from the rack, press the outer rail latch shown in the figure above 
to release the chassis.

Slide the chassis forward off the outer rails and out of the chassis.

Making Connections
This topic describes the Lightspeed Live Server connectors and how to connect to 
them. Follow the order of connections given here: 

■ Data and Signal Connections

■ Power Requirements and Connections

Data and Signal Connections
With the server powered down, make the following data and signal connections at the 
back of the server unit:

• Connect input device (keyboard and mouse) to the USB connectors (optional).

• Connect a monitor to the VGA connector (optional).

• Make built-in Ethernet LAN connections to provide network connectivity.

• If a 2-port 25G Ethernet NIC is installed, connect to your 25G media LAN via SFP28 
connectors.

• Telestream strongly encourages connecting the IPMI interface to your manage-
ment network for out of band management and troubleshooting.

• Connect SDI video sources to the connectors on the SDI card using the supplied 
DIN 1.0/2.3-to-BNC SDI cables.

• Optionally, connect an analog LTC timecode source to the BNC connector marked 
with an R (leftmost) on the SDI card. This port is configured for Longitudinal Time-
code (LTC) encoded with SMPTE 12M timecode data.

Note: This input is for analog LTC only and is not intended for use as a sync reference.

• Optionally, connect the RS422 VTR Interface Kit to a USB port. See Connecting VTR 
Systems. 
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First-generation (Gen 1) Lightspeed Live Server rear panel—4-port card

AC Power Connectors

1 PCIe half-height 3.0x8 expansion slot 
for Telestream approved cards only

4 Onboard 10Gb 
Ethernet LAN ports

IPMI Ethernet port
(dedicated)

2 USB VGACOM
Unused

LTC

SDI 4-port Card

GPU 

4 DIN 1.0/2.3
SDI ports

C2 Lightspeed Live Server rear panel—2-port (2 deactivated) 3G SDI Card

AC Power Connectors

SDI 4 port card - 4 DIN 1.0/2.3 - 2 SDI live & 2 
inactive or loop-through outputs

4 Onboard 10Gb 
Ethernet LAN ports

IPMI Ethernet port
(dedicated)

2 USB VGACOM LTC

C3/C4 Lightspeed Live Server rear panel—8-port 3G SDI card

AC Power Connectors

4 Onboard 10Gb 
Ethernet LAN ports

IPMI Ethernet port
(dedicated)

2 USB VGACOM LTC

SDI 8-port card - 8 DIN 1.0/2.3 SDI ports

C4 Lightspeed Live Server rear panel—4-port 12G SDI card

AC Power Connectors

4 Onboard 10Gb 
Ethernet LAN ports

IPMI Ethernet port
(dedicated)

2 USB VGACOM LTC

SDI 4-port card - 4 DIN 1.0/2.3 SDI ports
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C3 | C4 Lightspeed Live Server rear panel—2-port 25G Ethernet NIC Card

AC Power Connectors

4 Onboard 10Gb 
Ethernet LAN ports

IPMI Ethernet port
(dedicated)

2 USB VGACOM

2 25G Ethernet NIC ports 

Power Requirements and Connections
After the server chassis has been physically installed and all other connections made, 
connect the two redundant AC power cords to the back of the chassis and to an AC 
power source. Be certain to observe the following AC power and connection 
requirements and all applicable electrical codes.

The Lightspeed Live Server is rated at 100-240 VAC, 50-60 Hz, up to 10 amps. Take the 
following precautions to ensure a safe power connection:

• Make certain that the power source circuit can supply voltage within the specified 
range and current of at least 10 amps without becoming overloaded. 

• Counted together, the server and other devices connected to the same power 
source must not exceed the total capacity of the power source circuit. 

When power is connected, press the Power On/Off (0/1) button on the front of the 
chassis to turn the server on. To turn power off at any time, press the Power On/Off 
button again.

Power and General Cautions and Warnings
Observe these precautions when connecting power and operating the server:

CAUTION: Telestream recommends connecting computer equipment to AC power 
through an uninterruptible power supply (UPS) with surge protection. Fluctuations in 
commercial supply voltage can damage unprotected electronic equipment. A high 
quality surge suppressor may be substituted if a UPS is not available, but it may not 
provide adequate electrical spike protection.

WARNING: Only trained and qualified personnel should be allowed to install, replace, or 
service this equipment.

Hazardous high voltage electricity is present on the backplane when the system is 
operating. To prevent possible injury or death, use caution when servicing.

This product relies on the building's installation for short-circuit (over-current) protection. 
Ensure that the protective device is rated not greater than 250 Volts, 20 Amps.
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Ensure a proper earth ground connection to the ground conductor in the AC power plug. 
Failure to do so could present a severe electric shock hazard that could result in injury or 
death.

When installing the product, use the provided or designated connection power cables. 
Using any other cables could cause a malfunction or a fire. 

The fans might still be spinning when you remove the replaceable power supply from the 
chassis. Keep fingers, screwdrivers, and other objects away from openings in the housing.

Power supplies and other components can get very hot. Use caution when touching 
possibly hot components during operation and directly after unplugging.

This unit has two power supply connections. Both connections must be removed to 
completely de-energize the unit.
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Renaming a Lightspeed Live Server
Lightspeed Live Capture includes Vantage, and the Vantage domain is always the same 
as the host name of the server (or that hosts the Vantage domain database as in the 
case of an array).

When Windows is installed, it automatically names the computer with a random name, 
beginning with WIN- and a series of alphanumeric characters. For example: WIN-
S08Kh3N2EHG. To rename your Lightspeed Live Server, complete these tasks to ensure 
that the Vantage database is also updated with the new name:

Note: To complete this procedure, your Windows user must have permission to 
rename the computer, or you must get assistance from your Windows domain 
administrator. 

Be sure to schedule renaming during a maintenance window when no jobs are 
running, as renaming the Vantage domain interrupts all Vantage services in the domain 
(During a rename, Windows services on the server are automatically renamed as well).

Follow these steps to rename a Lightspeed Live server:

1. Start the Vantage Management Console, select the domain to manage, and log on 
as described in Starting the Vantage Management Console in the Vantage Domain 
Management Guide.

2. Select Services in the component panel, on the left.

3. For each service that you have customized (that is, it does not have default 
settings), document the Setup, Storage, Variables, and Qualification Rules settings 
for each service that you have configured.

You should update the Setup, Storage, Variable, and Qualification Rule settings 
after the Vantage domain is renamed.

Note: When you remove Vantage services from the domain, the Storage, Variable, 
and Qualification rule configuration for each service is lost. The rest of the Vantage 
domain configuration is retained. If you are changing the machine name during initial 
server installation, the default configurations are in place, so this step does not apply.

4. Click any service in the Services details panel, then press Ctrl-A to select all services.

5. Click the Remove Service button  in the toolbar to detach all services from the 
domain (this does not delete the service from the server).

6. Now, open the Windows Server Manager—click the Windows Start Menu > 
Administrative Tools > Server Manager.

7. Click Local Server in the left panel then click on the Computer Name.

8. Display the Computer Name tab and click Change.

9. Enter the new computer name in the Computer Name text field and click OK.

This new computer name automatically becomes the new name of the Vantage 
domain. The server name is limited to 15 characters or less.
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10. If prompted to do so, enter a Windows user name and password for an account that 
has permission to rename this computer.

11. Restart the server.

12. Start the Vantage Management Console, select the new domain, and log on.

If you are not prompted to select a new domain, click on File > Change Vantage 
Domain, click Search, select the newly-named domain and click OK. 

13. Select Services in the Component panel.

14. Click the Add Service button  in the toolbar.

Note: If you are not able to log in with the local Administrator account, check the host 
name listed by Windows as it may not have been updated. For example, if the original 
host name was lsl-telestream and the new one is lsl-customer, the user name may still 
be listed as lsl-telestream\Administrator. If so, change the host name to 
lsl-customer\Administrator, and re-enter your password.

15. When the Select Service dialog displays, click Machine to sort the services by 
machine name so t hat you can clearly identify the services for your server.

16. Add each of the Vantage services you previously removed—select the services you 
want and click OK.

17. If any Setup, Storage, Variables, and Qualification Rules settings require 
configuring, update them now.

18. Send the new Vantage domain name to all Vantage users and administrators so 
they can reconnect to the Vantage domain.
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Managing the Windows Operating System 
Windows Server 2016 is pre-installed on C2, C3, and C4 Lightspeed Live Servers. See 
microsoft.com for OS specifications.

■ Activating Windows with the Microsoft Activation Key

■ Applying Microsoft Updates

■ Default Windows User ID and Password

■ Web App Ports and Windows Firewall Settings

Activating Windows with the Microsoft Activation Key
A sticker on the top surface of the Lightspeed Live Server lists license numbers. The 
Physical Key number is the OEM license number for the Microsoft Windows operating 
system. If you reinstall the OS, use this key to activate Windows again. The key typically 
contains five groups of five digits, for example: YFG8H-TDD97-6BR4G-F88PF-XPF45J.

Applying Microsoft Updates
The Lightspeed Live Server ships with the Windows operating system set to check for 
updates, but it does not automatically download or install them. Downloading and 
installation of critical operating system updates is the responsibility of each customer 
(see your system administrator).

Default Windows User ID and Password
When the Lightspeed Live Server starts, log into with this Windows user account:

User Administrator

Password telestream!1

:

Web App Ports and Windows Firewall Settings
The Lightspeed Live web applications use certain ports:

• Live Capture—Port 8083 and 8084.
By default, selects any available TCP port between 1024 and 65534 for the web 
app’s Live Preview display. 

• Source Manager—Port 8090

• Live Stream—Port 8089

• Live Schedule—Port 443 and 6500

If you use Windows Firewall, be sure these ports are open on the Lightspeed Live Server 
and across your network.
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To open the Windows Firewall on the Lightspeed Live Server or other Windows 
computer, go to Start > Control Panel > Windows Firewall > Allow a program or feature 
through Windows Firewall > Allow another program.

Scroll through the list of programs, and click Add for each of these: 

• Lightspeed Live Capture (Live Capture only)

• Lightspeed Live Stream (Live Stream only)

• Source Manager

• Vantage Management Console | Vantage Workflow Designer | Vantage Workflow 
Portal (Capture only) 

Click OK to close the programs list. The added programs display in the firewall list and 
you can check which networks they can use. Then close the Control Panel.
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Maintaining a Lightspeed Live Server
These topics describes common server maintenance tasks that you may need to 
perform from time to time.

■ Performance Tuning a Lightspeed Live Server

■ Setting Your NVIDIA GPU to TCC Mode

■ Backing up a Lightspeed Live Server

■ Managing and Monitoring Lightspeed Live Servers

■ Installing New or Replacement Media Hard Drives

■ Rebuilding the Lightspeed Live Storage RAID

■ Replacing a Power Supply

■ Enabling SNMP Monitoring
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Performance Tuning a Lightspeed Live Server
The following configurations are set at the factory to ensure best performance of your 
Lightspeed Live Server. The settings are supplied here in the event they have been 
changed and you want to restore them to their original factory settings. (For details, 
consult your System Administrator or a Telestream Field Sales Engineer).

1. In Performance Options, set these Windows Performance options:

a. Navigate to Start > Control Panel > System > Advanced system settings > 
Settings button > Visual Effects tab.

b. Check Adjust for best performance.
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c. Select the Advanced tab.
d. Check Background services for Vantage transcoding service nodes and the 

domain’s Microsoft SQL database node. Select Programs for editorial systems and 
Vantage client applications that are not running other Vantage services. 

e. Select the Data Execution Prevention tab:
f. Check Turn on DEP (Data Execution Prevention) for essential Windows programs 

and services only.

g. Click OK in both dialogs to save your changes.
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2. Set User Account Control (UAC):

a.  Navigate to Start > Control Panel > User Accounts > Change User Account 
Control Settings. Set as low as safely possible, considering your exposure to 
Internet viruses and malware. Click OK to save your changes.

3. Set Power Options to High Performance with Sleep disabled:

a. Navigate to Start > Control Panel > Power Options.
b. Check the High Performance plan. 
c. Check Change plan settings, and set Turn off the display to Never. 
d. Check Change advanced power settings, and set all critical functions so that they 

are always ON (this usually means setting them to Never turn OFF). Click OK to 
save your changes and close the dialog.

e. Click Save Changes on the Edit Plan Settings window.

4. Disable (turn OFF) any real-time software applications and processes, such as the 
following, that could adversely affect disk I/O performance or use excessive CPU: 

– Real-time virus scanning of media files as they are being captured.

– Automatic software updates that can pre-empt real-time services.

– Real-time file indexing.

5. Disable all unnecessary Windows services in Start > Control Panel > Administrative 
Tools > Services (consult your System Administrator).

6. Turn OFF all firewalls (including third party firewalls) and packet filtering, which 
may cause unpredictable performance:

a. Navigate to Start > Control Panel > Windows Firewall > Turn Windows Firewall on 
or off, select Turn off Windows Firewall.

If you choose to use firewalls, open them for the applications installed on the Light-
speed Live Server.

7. You may increase network throughput by increasing buffer size in your network 
adapter. Set your Network Adapter’s transmit and receive buffers to 1024:

a. Navigate to Start > Control Panel > Network and Sharing Center > Change 
Adapter Settings > Local Area Connection > Right-click and select Properties.

8. Disable any screen savers:

a. Navigate to Start > Control Panel > Personalization > Screen Saver and select 
(None).

9. Disable disk indexing:

a. Right click on Start and select Disk Management from the pop-up menu. 
b. Right-click each disk and select Properties. 
c. In the General tab uncheck Allow files on this drive to have contents indexed in 

addition to file properties, unless you want some drives to be indexed.
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Setting Your NVIDIA GPU to TCC Mode
The NVIDIA GPU on Lightspeed Live servers must run in TCC mode, as opposed to 
default WDDM mode. NVIDIA GPU’s in TCC mode disable Windows graphics and is used 
in headless configurations, whereas WDDM mode is required for Windows graphics.  

When you update the NVIDIA driver, you must reset it to TCC mode to operate properly.

You can run a script to perform this change. The script is in the current version’s folder. 
For example: C:\V3.4-CP8.0.1-UP4-Live3.4\Installers\Nvidia\P4000 Win 2012.

Alternatively, perform the task manually. Follow these steps: 

1. Run cmd.exe and execute vnvidia-smi:
cd C:\Program Files\NVIDIA Corporation\NVSMI\

nvidia-smi -q

2. nvidia-smi prints the NVSMI Log. 

From the results, verify that the Driver Model indicates WDDM, not TCC. If TCC is 
reported, the mode is correct and you can end this task. 
Provided that WDDM is reported, locate and copy the GPU UUID—for example:
GPU UUID : GPU-4951a582-6b45-cca6-5a1c-a647130d00b1

3. Change the GPU mode to TCC by executing this command:
nvidia-smi -i GPU-4951a582-6b45-cca6-5a1c-a647130d00b1 -dm 1

using the GPU UUID from the previous result.

4. When the driver mode changes to TCC, you’ll be prompted to restart the server.

If you’re not prompted, determine the error and retry.

5. When the server restarts, run cmd.exe and execute this command again to verify 
that the NVIDIA GPU is operating in TCC mode:
cd C:\Program Files\NVIDIA Corporation\NVSMI\

vnvidia-smi -q

TCC mode is set properly, as indicated in the Driver Model section of the log:
Driver Model

     Current : TCC

     Pending : TCC

6. Close CMD and continue return to normal operations.

Backing up a Lightspeed Live Server
In order to protect your Lightspeed Live Server from data loss, Telestream highly 
recommends that you create an image of the Operating System drive (C:\) drive 
immediately upon taking delivery of your server and that you perform periodic back-
ups of all critical data on the server. 

Several third-party disk image products are available for creating a restoration image 
that you can use to restore the Lightspeed Live Server’s operating system drive to its 
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original state. Using programs such as these, along with regular backups, you can 
restore your server back to its original shipping state with all of your critical data:

• Acronis

• Norton Ghost

• Clonezilla

Consult your IT/Systems administrator for details on creating restoration images and 
performing a periodic backup of your Lightspeed server’s critical data.
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Managing and Monitoring Lightspeed Live Servers
IPMI View Management software provides remote network management of your 
Lightspeed Live Servers using IPMI messages over Ethernet LAN or a dedicated IPMI 
LAN. If the Ethernet connectors are used to connect to storage, you can use the IPMI 
LAN connector to create an IPMI network among your servers. 

To download the IPMI View application and User’s Guide, go to this web location: 
https://www.supermicro.com/en/solutions/management-software/ipmi-utilities. 

Tasks you can perform using IPMI View include (see IPMI View User’s Guide for details):

• Discover Lightspeed Live Servers on the IPMI network (requires IPMI LAN)

• View system event logs

• Check current sensors and monitor history of fans, voltages, temperature, and 
power supplies

• View firmware revision levels

• Perform various kinds of shutdowns and resets

• Blink the UID LED to locate a particular unit in the rack or server room

• Set fan speed

• Manage LAN configuration, SNMP configuration, and RS232 modem

• Manage users, passwords, and privileges

• Set up paging of users in the event of malfunctions

• Establish Text Console Redirection or KVM Console Video Redirection for remote 
system control via text display or full graphic display

• Access virtual media 

• Set up server management groups

• Update firmware.

For detailed instructions about using any of these system management features, 
consult the IPMI View User’s Guide.
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Installing New or Replacement Media Hard Drives

Note: This topic does not apply to the 2-port, C2 Server. It uses a software-based RAID 
controller, and its two media drives are SSD drives. 

Follow these steps to replace a hard drive or install a new one. Drives may be removed 
or replaced with power on. See Drives for new or replacement drive specifications.

1. Remove the front bezel from the chassis.

2. Press the release button on the right front of the drive carrier.

3. Use the drive carrier handle to pull the carrier out of the chassis.

4. Remove the drive or dummy drive from the carrier by removing the four M3 screws 
from the underside of the carrier. Retain the screws.

5. Insert the new drive into the carrier with the PCB side down and the connector 
facing the back of the carrier. 

6. Secure the drive to the carrier with the four M3 screws retained from removal. 
Gently tighten but do not over tighten the screws, which could cause damage.

7. Slide the drive carrier into its bay with the drive facing up until it seats firmly in the 
rear connector.

8. Push the handle closed flat against the front of the carrier to secure the drive.

9. Replace the front bezel on the chassis, and go to the next topic to rebuild the RAID.
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Rebuilding the Lightspeed Live Storage RAID

Note: This topic does not apply to the 2-port, C2 Server. It uses a software-based RAID 
controller, and its two media drives are SSD drives. 

The MegaRAID Storage Manager program on the Lightspeed Live Server enables you to 
rebuild the storage RAID if necessary, such as when you add a new drive, or want to 
change drive configurations. The MegaRAID Storage Manager is located at:

C:\Program Files (x86)\MegaRAID Storage Manager

In the MegaRAID Storage Manager folder, use the startupui.bat file to start the program. 
In the initial panel, click on the server you want to work with, then enter your 
credentials to log in. The MegaRAID Storage Manager application opens. 

Replacing a Power Supply
The Lightspeed Live Server includes two user-replaceable, redundant, hot-pluggable 
power supply modules. They automatically sense the input voltage between 100v to 
240v, and operate at that voltage. Power cords plug directly into the power supply units 
at the back of the chassis. A green light indicates that the power supply is operating. 
When a power supply fails or loses power, an amber light on the power supply 
illuminates and an alarm sounds.

If either of the power supply modules fail, the other module supports the full load and 
allows the system to continue operation without interruption. The PWR Fail LED 
illuminates and remains on until the failed unit has been replaced. Replace with the 
same model. Replacement units can be ordered from Telestream. Contact Telestream 
Customer Support (Obtaining Support | Information | Assistance) to order parts.

AC Power Supplies

Replacing the Power Supply
1. Unplug the AC power cord from the failed power supply module.

2. Push in the locking tab at the back of the module to release it.

3. Pull the unit straight out of the chassis. 

CAUTION: The power supply may be very hot when first unplugged and could cause 
burns. Handle carefully by the edges and do not touch hot components.

4. Insert the new unit into the chassis, pushing it in until it clicks firmly in place.

5. Reconnect the power cord.
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Monitoring Lightspeed Live Servers via SNMP
Management Information Base (MIB) files are provided for those organizations wanting 
to manage their Lightspeed Live Servers via SNMP. 

Locate MIB files on the Lightspeed Live Server in this location:

C:\Program Files\Telestream\Live Stream Server

MIB files can also be found on the Lightspeed Live DVD or USB thumb-drive in the 
SNMP folder.

Enabling SNMP Monitoring
You should add three lines (add, target, and logger) to the SourceService.exe.config and 
LiveService.exe.config files in order to enable SNMP traps and configure ports. For more 
information about log files see Managing and Using Log Files.

Note: The ports must be different in each file and port 62 should not be used. 

The following example shows a typical configuration file, with the added lines in red:
<nlog xmlns="http://www.nlog-project.org/schemas/NLog.xsd" 
xmlns:xsi="http://www.w3.org/2001/XMLSchema-instance">
<extensions>
<add assembly="NLog.Targets.Snmp" />

</extensions>
<targets>
<target name="logconsole" xsi:type="Console" 
layout="[${level}] ${message}" />
<target name="logfile" xsi:type="File"
 archiveAboveSize="10000000" maxArchiveFiles="1000"
 fileName="${specialfolder:folder=ApplicationData}/Live/
SNMPLogs/LiveService-${date:format=yyyy-MM-dd}-log.txt"
layout="${longdate} [${level}] ${message}" />
<target name="snmp" xsi:type="Snmp" port="163" />

</targets>
<rules>
<logger name="*" minlevel="Info" writeTo="logconsole" />
<logger name="*" minlevel="Warn" writeTo="logfile" />
<logger name="*" minlevel="Info" writeTo="snmp" />

</rules>
</nlog>
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Managing Lightspeed Live 
Servers
This chapter describes typical tasks associated with configuring and maintaining 
Lightspeed Live Servers.

Topics
■ Creating, Configuring, and Managing Sources

■ Using Sources for Both Live Stream and Capture

■ Re-configuring Lightspeed Live Servers

■ Updating Lightspeed Live Stream Software

■ Using Log Files and Other Support Information
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Creating, Configuring, and Managing Sources
Creating, configuring and managing video sources for Live Stream and Live Capture is 
performed using the Source Manager web app.

Note:  if you need to change the Source Manager web app’s web socket server port 
when running Live Stream and Live Capture concurrently, use the Settings menu in 
the Live Stream web app’s Network Configuration tab. After making this change, the 
Source Manager won’t function and you can only use the Sources panel in the Live 
Stream web app to change source configurations.

Before you can stream, you must have created and configured at least one source. Four 
or eight (depending on the server model) SDI streaming video sources, such as those 
from live cameras, can be connected through the SDI connectors on the back panel of 
the Lightspeed Live Server. You can also add slate, images, and media file loops, as well 
as live IP-based RTMP and Creating and Configuring a Transport Stream SourceCreating 
and Configuring a Transport Stream Sources from your Ethernet connection.

With a Mellanox 25G NIC, you can support ST 2110 video.

In the case of a Lightspeed Live Server group, the list of Sources is separated into a 
panel for each server, and each panel can be expanded and collapsed. 

Topics
■ Accessing the Source Manager Web App

■ Configuring an SDI Source

■ Configuring SDI Loop Through

■ Creating and Configuring a File Loop Source

■ Creating and Configuring a Slate Source

■ Creating and Configuring a Transport Stream Source

■ Creating and Configuring an RTMP Source

■ Managing and Configuring Audio Tracks

■ Managing Text Tracks for 608|708 Captions

Note: Sources can’t be edited when they are being used by an active channel.
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Accessing the Source Manager Web App
To access the Source Manager web app locally on the server, launch Chrome and enter 
http://localhost:8090/. 

From Chrome on another workstation, enter http://[hostname]:8090/ where hostname 
is the host name or IP address of the Lightspeed Live server. 

If requested, enter your user name and password. The default user name is admin and 
the default password is live!. 
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Source Manager Web App Overview
The Source Manager web app has two panels: The left panel is the Sources list, which 
displays the SDI sources, plus IP sources you’ve created. Select a source to display a live 
preview feed of the selected source in the right panel, along with track data.

Source Information 
and Statistics

Audio Levels

Sources Panel Source Toolbar

Audio and Text 
Track Panels

Preview Panel System Settings

Add Sources
menu

 

Sources display the current source input in the Configure Source dialog (or the LOS 
Video Test Pattern if no input is present). You can edit SDI source names but not delete 
them—each presents a hardware port-base signal. They update when you change the 
SDI source. SDI ports can be combined in Live Capture to create a single UHD/4K input. 
For supported formats see Live Stream Source Formats

• Sources Panel—Displays all source thumbnails, and allows you to select a source 
to view or edit. See Source and Channel Indicator Icons.

• Add Source—Click the + icon in the Sources panel to add a new File Loop, Slate, 
Transport Stream or RTMP source. The SDI sources are automatically included and 
you can’t delete them. 

• Source Menu Toolbar—Top-right, above the Sources Preview Panel.
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– Editor Icon—Click the pencil icon to view or update the settings of the selected 
Source. Source configuration panels vary by type.

– Audio Track—Selects which audio track to configure and play. The Source 
Preview panel shows the selected track.

– Text Track—Specifies which caption track to use, 608 or 708. The Source Preview 
panel shows the selected track. 

– Delete Icon—Click the trash icon to delete the selected Source.

• Admin—Log out or log in for the current user. 

• System Settings—Top-right, three-dot icon.

– Settings—Provides these options: 

- Advanced Mode—Turn Advanced mode off or on.

- RTMP Listener Port—Set the RTMP Listener Port. The default port is 1953. 

- Restrict Preview Ports Range—Enable to set a range for restricting the pre-
view ports. The lower and upper range is from 1024 to 65534. 

Port Range Start—Specifies the lower threshold of ports to use for previews.

Port Range End—Specifies the upper threshold of ports to use for previews.

Note: At least two open ports must be available in the configured range. The first is 
used for Live Capture, even when not installed. The second is for Live Stream. 
The Port Range Start must be a lower value than the Port Range End, otherwise 
random ports are used.

– Download System Logs—Gathers the system logs, then opens a Save dialog to 
choose the location to save the file.

– About—Provides the version number of the program, some document links, and 
Telestream contact information. 

• Preview Panel—Displays the currently selected Source and audio meters.

• Source Information Panel—Displays details about the selected source video.

• Audio and Text Track Panels—Add, delete, and configure audio and captioning 
text tracks. 

• Audio Level Meters and Mute Controls—Audio level meters for each channel 
that adjust automatically, based on the track (stereo, 5.1 Surround Sound, etc.), with 
channel-by-channel mute control. If you have multiple audio tracks, you can switch 
among them, using the Audio Track menu. 
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Source and Channel Indicator Icons
Thumbnail preview icons for each source in the Sources panel indicate the type of 
source, whether that source is being used in a live stream or there is a loss of signal.

        SDI source

        File Loop source

        Slate source

        Transport Stream source

        RTMP source

        This source is currently being used in a stream and cannot be 
edited or removed.

        This source has experienced a loss of signal.

        Indicates that an active source needs to be selected for the 
Segment, when configuring Channels components

Indicates that an activation schedule exists on that Channel 
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Configuring an SDI Source
SDI sources on a Lightspeed Live Server are not added manually—they always exist, 
and are automatically displayed in the sources panel. For systems with more than one 
server, you should name each server’s SDI ports with unique names—for example, by 
adding the Lightspeed Live Server name as a prefix: Lightspeed1-SDI-Input-1.

Note: Some Source selections display only when you enable Advanced Mode in the 

Settings menu .

You configure SDI source options in the Configure Source dialog. Select an SDI source 
in the Sources panel and then click the Pencil icon in the toolbar (see Source Manager 
Web App Overview) to display the Configure Source dialog:

 

The Configure Source dialog provides these settings for SDI sources:

Name—Specifies the name of the source. The default name for each SDI port has the 
form: SDI Input [1 through n], where ‘n’ is 4 or 8 depending on the Lightspeed Live Server 
model. You can change source names to meet your operating requirements. 

When you rename a source, observe these requirements:

• Each source must be named uniquely.

• Don’t use these characters in the name—they’re prohibited: ` * | \ : ; " ' < > ? / 
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• Force 10-Bit Video—When enabled, activates full 10-bit sampling of the video on 
the SDI port. Using 10-bit sampling requires additional processing and should not 
be enabled for Standard Definition (SD) sources.

CAUTION: When using an 8-bit leader, filler, or trailer along with the video, do not 
enable the 10-bit sampling mode. Corrupted output can result.

• PsF—Enable PsF when your incoming SDI source signal is formatted as PsF (Pro-
gressive segmented Frame). 

Note: The Live Capture system always treats 23.98 | 24 fps SDI sources as progressive.

• Freeze on LOS—When enabled, a loss of signal (LOS) causes the incoming video 
signal to freeze on the last frame. When disabled, LOS causes the LOS Video Test 
Pattern to be displayed. For LOS details, see Loss of Signal Behavior in the Lightspeed 
Live Capture User Guide.

• Assign Processor (SD/HD sources only)—When enabled, all processing associ-
ated with individual Capture or Tape workflows is assigned to a single multi-core 
CPU socket. If four (4) workflows are capturing concurrently, each workflow process 
runs exclusively on a single CPU socket, with two (2) workflows on socket 1 and two 
(2) workflows on socket 2. This prevents inefficient mapping of processes across 
CPU sockets during heavy loads, such as when all four source inputs are being pro-
cessed. Not enabling this option when capturing multiple workflow channels can 
result in excessive CPU usage.

Note: This option defaults to On (enabled) when capturing non-UHD/4K SDI sources. 
It should be disabled when capturing UHD/4K.

Note: If this control does not display, its because processor balancing on this 
Lightspeed Live Server model is performed automatically, and no end-user 
adjustment is available.
This option defaults to On (enabled) when capturing SD/HD SDI sources. You should 
disable it when capturing UHD/4K.

• LOS Video Test Pattern—Select the test pattern to display during LOS. 

• LOS Audio Test Signal—Select the audio signal to use during LOS.

• Max Time-Shift—Do not use. Applies to Live Capture Only.

• TimeCode Source—Click the drop-down menu to choose one of the following 
timecode source signals for the selected SDI input:

– Source—Uses the timecode provided in VBI or VANC (SMPTE 12M-2/RP188) of 
the selected Lightspeed Live Capture's video input signal. If a valid timecode is 
not available or goes away, see the Free Run TimeCode option below.

– Computer Clock—Uses the time-of-day clock provided by the Lightspeed Live 
Capture Server.
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– Free Run—This timecode starts at 00:00:00:00 and free-runs, after the associated 
Capture workflow is activated. The recorded timecode captured reflects the free 
run timecode at the time capture begins.

– Analog LTC—Uses the timecode provided on the SDI card's LTC input (marked 
with an R on the SDI card). If a valid timecode is not available or goes away, see 
the Free Run TimeCode option below.

– RS-422—Do not use. Applies to Live Capture Only.

Note: When using the Schedule Trigger you should set your TimeCode Source to 
either Computer Clock or Source. When using Source, you must have time-of-day 
timecode in your source that matches the time set in your Lightspeed Live Server. See 
Configuring Trigger Settings. 

• Free Run TimeCode—When enabled and the desired timecode is not detected or 
goes away, the timecode seamlessly free-runs from the last good timecode 
received. When not enabled and the desired timecode is not detected or goes 
away, then the timecode reverts to zero (00:00:00:00) and stays at zero. 

• Raw Ancillary Dump—Do not use. Applies to Live Capture only.

• Use Inverse Telecine—The Stream service de-interlaces interlaced video before 
encoding. When enabled, Telecined video is de-interlaced with Inverse Tele-
cine before it is converted to the output frame rate.

• Line Offset—Do not use. Applies to Live Capture only.

• Cisco ID3—Enable to allow the SCTE-104 information to be converted to ID3 on 
output. This option can also be turned off or on from Live Capture when configur-
ing SDI sources. See Cisco ID3 in the Configuring SDI Source Options topic in the 
Lightspeed Live Capture User Guide. This setting is available only in Advanced Mode.

• Extended RS-422 Status—Do not use. Applies to Live Capture only.

• VDCP—Do not use. Applies to Live Capture only.

• Video Mode—Select the video mode:

– SD/HD Video Input—Sets the source to SD/HD video input.

– SD/HD Video Input with Loop Through—Sets the source to SD/HD video input 
with Loop Through. See Configuring SDI Loop Through for details. 

– 4K/UHD Video Input—Sets the source to 4K/UHD video input. When activated, 
all four SDI inputs are merged into one 4K/UHD input.

– 4K/UHD Video Input with Loop Through—Sets the source to 4K/UHD video 
input with Loop Through. See Configuring SDI Loop Through for details.

Note: Loop Through is not supported for ports on the HEVC SDI card. 

• Ignore Format Match Check—When UHD/4K is chosen as the video mode, 
enabling this option adds a UHD source via SDI inputs even if all four quadrants do 
not have a matching signal. When there is no valid UHD signal from all quadrants, 
the entire output displays the signal as the LOS Video Test Pattern. When disabled, 
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all four quadrants of a UHD source must match for the UHD/4K mode to be acti-
vated. Unmatched quadrants can occur when some UHD sources are not currently 
playing video. 

• Quad-Split Scheme—When 4K/UHD is chosen as the video mode, select from one 
of the following Quad-Split Schemes:

– Square Division Level A—The image is divided into four quadrants, level type A. 

– Square Division Level B—The image is divided into four quadrants, level type B.

– 2SI-A—Two Sample Interleave, type A. 

– 2SI-B—Two Sample Interleave, type B.

Note: To successfully switch between the 2SI-A or the 2SI-B setting, you must first 
select Square Division, save the change, then reopen the dialog and select the A or B 
setting you want. 

Note: The SDI ports on the Lightspeed Live Server cannot differentiate between 4K/
UHD and HD/SD signals. When the server inputs are receiving a 4K/UHD signal, but the 
4K/UHD Video Input option is not selected, the four corners of the source are divided 
into the four SDI inputs. To get one source that uses the full 4K/UHD signal you must 
enable the 4K/UHD Video Input option for one of the SDI inputs. 

When the SDI inputs are receiving HD/SD signals and the 4K/UHD Video Input option is 
selected, there is a single SDI 4K/UHD source that has four segments of duplicate video 
in it. All four inputs must be synchronous, and have the same frame rate and resolution 
in order to be combined into a single source view.

Switching Between HD and 4K/UHD Configurations
The key to enabling and disabling 4K/UHD mode is making sure that a valid and active 
4K/UHD signal is connected to the Lightspeed Live Server during the switching 
process. To switch from an HD to a 4K/UHD input and back again, follow these  steps:

To switch from HD to 4K/UHD input mode:

1. (If Capture is present) Deactivate all Capture workflows actively running on any of 
the server inputs.

2. From a valid 4K/UHD source connect all four UHD input cables to the appropriate 
SDI input BNC connectors.

3. Start your 4K/UHD source to actively provide a signal to the Lightspeed Live Server.

4. Open the Source Manager panel (see Creating, Configuring, and Managing Sources), 
select SDI Input 1 and/or SDI Input 5 (model-dependent), then open the Configure 
Source panel.

5. Disable the Assign Processor option. (This option should be disabled for 4K/UHD.)

6. Set Video Mode to 4K/UHD Video Input, then click Save. The inputs are consolidated 
into one input and renamed to include 4K/UHD in the name.
Lightspeed Live Stream User Guide



Managing Lightspeed Live Servers 
Creating, Configuring, and Managing Sources

75
7. (If Capture is present) In Vantage Workflow Designer, for any workflow that you 
want to use the 4K source, open the Capture action and select the new 4K/UHD 
input as the Source.

8. (If Capture is present) Make any other desired changes action and save it.

9. (If Capture is present) Click Activate to initiate workflow operation.

To switch from 4K/UHD to HD input mode:

1. The 4K/UHD source must be actively providing a signal to the server.

2. (If Capture is present) Deactivate all Capture workflows using the 4K/UHD source.

3. Open the Source Manager panel (see Creating, Configuring, and Managing Sources), 
select the 4K/UHD input, and open the Configure Source panel.

4. Set Video Mode to SD/HD Video Input, then click Save.

5. The 4K/UHD input is now converted back to four individual SDI inputs.

6. Turn off your 4K/UHD signal source and disconnect the cables from the 4K/UHD 
device.

7. Connect HD source cables to one or more of the SDI input BNC connectors.

8. On the Source Manager panel, select each source to configure the options uniquely 
for each input. See Configuring an SDI Source above.

9. (If Capture is present) In Vantage Workflow Designer, configure each Capture action 
to use any one of the SDI inputs that you want for that workflow, and make any 
other desired adjustments and save your changes. See Creating a Live Capture 
Workflow.

10. (If Capture is present) Click Activate for each workflow that you want to place into 
operation.
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Configuring SDI Loop Through
Use the Loop Through feature in the Source Manager to set one or more SDI input 
connections to the Lightspeed Live server as a loop-through output. This can be used, 
for example, as confidence monitoring of the SDI signal into the system.

Important Note: The SDI-1 input is used as the master sync when Loop Through is 
enabled. All source inputs MUST be of the same baseband video type (frame rate, 
frame size) and they MUST share a common video reference that is frame synced and 
gen-locked together. Failure to meet this requirement results in a vertical offset being 
introduced in the sources.

Important Note: If the source video type (such as frame rate or frame size) changes 
on SDI1- when operating in Loop Through, the other inputs fail and go to LOS (loss of 
signal). After SDI-1 is set back to match the other inputs, changing a setting on a 
source and saving it resets the source back into operation. 

When a source is set to be a Loop Through connection, a new source instance is 
created. For example, [host] - SDI Input 1 to SDI input 3 to replace the previous source 
instance of [host] - SDI Input 1. The previous non Loop Through source is unavailable to 
any Tape or Capture action or Stream channel that was set to use that source. See Port 
Pairing Assignments for Loop Through for more information.

Note: Loop through is not supported for the HEVC (H/W) card.

Using both Loop Through and Normal Modes
If a system is used in both Loop Through and straight through modes, workflows 
should be managed using the following criteria:

• Use Vantage Workflow Designer to deactivate all workflows and stream channels 
that use the sources you are reconfiguring.

• Change the source configuration in the Source Manager web app using the Config-
ure Source dialog. See Creating a Loop Through Output below. 

• Use Vantage Workflow Designer to create or activate the workflows that use the 
new configuration.

Note: Actions in Workflow Designer do not signal an invalid connection after 
changing them unless the inspector is opened for reconfiguration.
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Creating a Loop Through Output
Before setting an SDI connection to be a Loop Through output, there should be no 
signal going to that connection. Follow these steps to create a Loop Through output:

1. Disconnect or turn off the SDI source going to the inputs that are going to be 
changed to Loop Through mode.

2. In the Source Manager web app, select the SDI input you want to use for Loop 
Through, then click the pencil icon to open the Configure Source dialog 

3. Change the Video Mode selection in the Configure Source dialog to the Loop 
Through option. Click Save to close the dialog. 

Video Mode control 

4. Reconnect or turn on the SDI source going to the inputs that are set to Loop 
Through mode.

5. Open the Live Capture web app for further configuration and activation of the Loop 
Through outputs.
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Port Pairing Assignments for Loop Through
The following input port pairings apply when creating Loop Through outputs.

    For Servers with 4 3G SDI Ports
• SD/HD:

– SDI-1 is always paired with SDI-3 

– SDI-2 is always paired with SDI-4

• 4K/UHD:

– No Loop Through

    For Servers with 8 3G SDI Ports
• SD/HD:

– SDI-1 is always paired with SDI-5 

– SDI-2 is always paired with SDI-6

– SDI-3 is always paired with SDI-7 

– SDI-4 is always paired with SDI-8

• 4K/UHD:

– 4K/UHD Input 1 Quad Linked using SDI-1, SDI-2, SDI-3, and SDI-4 is paired with 
SDI-5, SDI-6, SDI-7, and SDI-8
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Creating and Configuring a File Loop Source
To create and configure a File Loop Source, select File Loop from the toolbar’s Add Source 
menu (see Source Manager Web App Overview) to display the File Loop Configure Source 
dialog.

Note: File Loops are intended for test purposes only.

 

The File Loop Configure Source dialog provides these options:

Name—Specifies the name of the File Loop.

Path—Specifies the path for the looping file source.

Max Time-Shift—Do not use. Applies to Live Capture only.

Simulate Deck—Do not use. Applies to Live Capture only.

Force 8-Bit Video—Forces the source to be 8 bit instead of 10 bit regardless of original 
source.

Assign Processor—Assign this source and its dependents to a single processor. When 
on, all processing is assigned to a single multi-core CPU socket. This prevents inefficient 
mapping of processes across CPU sockets during heavy loads, such as when all four 
inputs are being processed. Works for SD/HD sources only, not 4K. 

Note: If this control does not display, its because processor balancing on this 
Lightspeed Live Server model is performed automatically, and no end-user 
adjustment is available. This option defaults to On (enabled) when capturing SD/HD 
SDI sources. You should disable it when capturing UHD/4K.
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Use Inverse Telecine—Sets the source to be de-interlaced using Inverse Telecine 
settings. 

Cisco ID3—Enable to allow the SCTE-104 information to be converted to ID3 on 
output. This option can also be turned off or on from Live Capture when configuring 
SDI sources, see Cisco ID3 in the Configuring SDI Source Options topic in the Lightspeed 
Live Capture User Guide. Available only in Advanced Mode.

Decompressor—Specifies which codec to use for source decompression. Default: 
Decompression is performed by the CPU. Lightspeed GPU: Decompression is performed 
by the GPU.
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Creating and Configuring a Slate Source
To create or edit a Slate source, select Slate from the toolbar’s Add Source menu (see 
Source Manager Web App Overview) to display the Slate Configure Source dialog. A Slate 
(test pattern) displays when no signal is present.

   

The Slate Configure Source dialog provides these options:

Name—Specifies the name of the Slate.

Video Test Pattern—Specifies the video test pattern to display.

Audio Test Signal—Specifies the audio test signal to use.

Video Frame Rate—Specifies the video frame rate to use for the Slate. 

Video Resolution—Specifies the video resolution to use for the Slate. 

Force 10-Bit Video—Sets the Slate at 10-bit video rather than 8-bit.

Assign Processor—Assign this source and its dependents to a single processor. When 
on, all processing is assigned to a single multi-core CPU socket. This prevents inefficient 
mapping of processes across CPU sockets during heavy loads, such as when all four 
inputs are being processed. Works for SD/HD sources only, not 4K. 

Note: If this control does not display, its because processor balancing on this 
Lightspeed Live Server model is performed automatically, and no end-user 
adjustment is available. This option defaults to On (enabled) when capturing SD/HD 
SDI sources. You should disable it when capturing UHD/4K.
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Creating and Configuring a Transport Stream Source
To create or edit a Transport Stream source, select Transport Stream from the toolbar’s 
Add Source menu (see Source Manager Web App Overview) to display the Transport 
Stream Configure Source dialog:

   

Note: The settings for Multicast Group IP Address, Local NIC/IP Address, Port Number, 
and Program Number can only be changed when you are adding a new Transport 
Stream source. After the source has been added, only the other settings for the 
Transport Stream source can be edited.

The Transport Stream Configure Source dialog provides these options:

Name—Specifies the name of the stream.

Multicast Group IP Address—The optional Multicast Group IP address to use. 

Local NIC/IP Address—The local NIC (Network Interface Card)/IP address. Select other 
ones from the menu, if they are available.
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Note: When a new network adapter is added, or changed from the disabled to 
enabled state, Live services must be restarted for the service to be available in the 
Local NIC/IP Address menu. See Stopping and Restarting Telestream Live Services. 

Enable SSM—When Source Specific Multicast (SSM) is enabled, you can enter a list of 
accepted source IP addresses for multicast, under Source Filter. 

Source Filter—When you enable SSM, the Source Filter field displays. Enter a list of 
accepted IP addresses for the multicast sources. Separate IP addresses in the list by 
the return character, via the Enter/Return key.

Port Number—Specifies the port number.

Program Number—Set the slide button to the on position to enable, then enter or 
select the program number. When disabled, the first available program is used. 

Max Time-Shift—Do not use. Applies to Live Capture only.

Force 8 Bit Video—Forces the source to be 8 bit instead of 10 bit regardless of original 
source.

Assign Processor—Assign this source and its dependents to a single processor. When 
on, all processing is assigned to a single multi-core CPU socket. This prevents inefficient 
mapping of processes across CPU sockets during heavy loads, such as when all four 
inputs are being processed. Assign processor should be applied only to SD/HD sources, 
not 4K. 

Note: If this control does not display, its because processor balancing on this 
Lightspeed Live Server model is performed automatically, and no end-user 
adjustment is available.
This option defaults to On (enabled) when capturing SD/HD SDI sources. You should 
disable it when capturing UHD/4K.

TimeCode Source—Sets the default timecode source. Choose one of the following 
timecode source signals for the selected Transport Stream Input: 

Source—For H.264 or H.265 the source’s SEI user data is used, and for MPEG2 the 
source’s GOP header timecode is used. If no valid Source timecode is available see 
the Free Run TimeCode option below.

Computer Clock—Uses the time-of-day clock provided by the Lightspeed Live 
Capture Server. 

Two additional settings display when Computer Clock is selected as the TimeCode 
Source that determines how the system processes the time code value:

When Compensate for Computer Clock Drift is enabled (see below) 

Computer Clock Time is monitored and compared to the time code being added to 
the captured file. Since the Computer Clock is not gen-locked with a true time 
source associated with the incoming frames it can drift over time and get out of 
sync with the incoming stream. When a drift of one second is reached the timecode 
being added to the file is re-synced to the system's Computer Clock time. This 
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means there may be a discontinuity in the file’s timecode at the point where the re-
sync occurred. Enabling ‘Free Run Timecode’ when Compensate for Computer 
Clock Drift is enabled has no effect on the process described here.

When Compensate for Computer Clock Drift is Disabled and Free Run Timecode is 
Enabled

The source process uses the Computer Clock time without compensating for drift. 
Over time the timecode may drift several seconds compared to the ‘real’ time. For 
example—if a recording is 6 hours long the Computer Clock drift might be many 
seconds by the end of the 6 hour recording. If no frames were dropped the time-
code in the output file is contiguous from start to finish.

Regardless of how Compensate for Computer Clock Drift is set, if packets are lost 
and frames are dropped the Live Source process adds frames using the last good 
timecode in order to compensate for the lost frames. This may cause timecode val-
ues to be repeated where a frame was lost. If your Transport Stream signal is strong, 
this problem should not occur.

Free Run—This timecode starts at 00:00:00:00 and free-runs after the associated 
Capture workflow is activated. The recorded timecode captured reflects the free 
run timecode at the time capture begins.

Free Run TimeCode—When enabled, and the desired timecode is not detected or 
goes away, the timecode seamlessly free-runs from the last good timecode received. 
When Free Run TimeCode is not enabled and the desired timecode isn’t detected or 
goes away, the timecode reverts to zero (00:00:00:00) and stay at zero.

Compensate for Computer Clock Drift—When enabled, compensates for Computer 
Time Code drift when Computer Clock is the chosen TimeCode Source. 

Freeze on LOS—Causes the source to hold the last good frame the signal is lost.

LOS Video Test Pattern—Select the test pattern to display during LOS.

Note: The LOS Audio Test Signal is not available for Transport Stream sources.

Use Inverse Telecine—Sets the source to be de-interlaced using Inverse Telecine 
settings. 

TS Over RTP—When enabled, wraps the Transport Stream in an RTP packet. 

Cisco ID3—Enable to allow the SCTE-104 information to be converted to ID3 on 
output. This option can also be turned off or on from Live Capture when configuring 
SDI sources, see Cisco ID3 in the Configuring SDI Source Options topic in the Lightspeed 
Live Capture User Guide. Available only in Advanced Mode.

Stream dump—Available when Advanced mode is enabled. When enabled, captures 
the Transport Stream source to the location and file you specify, until you turn the 
Stream dump option off. Type the path, folder, and file name into the Stream dump 
field. Specify the file extension as ts (for example, MyStreamDump.ts.) If the folder you 
specify does not exist, the new folder and file are automatically created. 
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Log Timecode—When enabled, the timecode is added to the log. Available only in 
Advanced Mode. (To be used only as directed by Telestream Customer Service for 
debugging purposes.)

SCTE-35 Information and ID3 Tag Pass Through or Insertion
When a Transport Stream source contains SCTE-35 information or ID3 tags, this data is 
passed through to the output. SCTE-35 and ID3 data can also be inserted via the 
Sources API.

Note: Lightspeed Live Capture requires that an IP source is formated using standard 
frame sizes and frame rates. See the Technical Specifications in the Lightspeed Live 
Capture product sheet on the Telestream web site for the supported formats. 

Decompressor—Specifies which codec to use for source decompression. Default: 
Decompression is performed by the CPU. Lightspeed GPU: Decompression is performed 
by the GPU.
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Creating and Configuring an RTMP Source
To create or edit an RTMP source, select RTMP Source from the toolbar’s Add Source 
menu (see Source Manager Web App Overview) to display the RTMP Configure Source 
dialog. 

Telestream recommends limiting RTMP/Transport Stream sources to eight, unless 
testing in your environment indicates you can enable more.

Note: The options for an RTMP source can only be changed when you are adding it. 
After the source has been added, only the name can be changed. When an RTMP 
source is connected, the name can’t be changed either. When you require an RTMP 
source with different settings, add a new RTMP source and configure it accordingly.

   

The RTMP Configure Source dialog provides these options:

Name—Specifies the name to use in Live Stream.

Stream Name—Specifies the name of this RTMP stream source. The Stream Name can 
be changed multiple times until an RTMP stream source is connected. After an RTMP 
stream has connected, the Stream Name can’t be changed. 

Max Time-Shift—In Live Capture, specifies the size of the internal Time-Shift buffer 
that is used to delay the source. In Live Stream, applies to the Retroactive Channel Start 
feature. 

Assign Processor—When enabled, assigns this source and its dependents to a single, 
multi-core CPU socket. This prevents inefficient mapping of processes across CPU 
sockets during heavy loads, such as when all four inputs are being processed. Applies 
to SD/HD sources only, not 4K.
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Note: If this control does not display, its because processor balancing on this 
Lightspeed Live Server model is performed automatically, and no end-user 
adjustment is available.
This option defaults to On (enabled) when capturing SD/HD SDI sources. You should 
disable it when capturing UHD/4K.

TimeCode Source—Sets the default timecode source. Choose one of the following 
timecode source signals for the selected RTMP Input: 

Source—For H.264 or H.265 the source’s SEI user data is used, and for MPEG2 the 
source’s GOP header timecode is used. If no valid Source timecode is available see 
the Free Run TimeCode option below.

Computer Clock—Uses the time-of-day clock provided by the Lightspeed Live 
Capture Server. 

Two additional settings display when Computer Clock is selected as the Time-
Code Source that determines how the system processes the time code value:

When ‘Compensate for Computer Clock Drift’ is enabled (see below) the Com-
puter Clock Time is monitored and compared to the time code being added to 
the captured file. Since the Computer Clock is not gen-locked with a true time 
source associated with the incoming frames it can drift over time and get out of 
sync with the incoming stream. When a drift of one second is reached the time-
code being added to the file is re-synced to the system’s Computer Clock time. 
This means there may be a discontinuity in the file's timecode at the point where 
the re-sync occurred. Enabling Free Run Timecode when Compensate for Com-
puter Clock Drift is enabled has no effect on the process described here.

When Compensate for Computer Clock Drift is disabled and Free Run Time-
code is enabled, the source process uses the Computer Clock time without com-
pensating for drift. Over time the timecode may drift several seconds compared 
to the ‘real’ time. For example—if a recording is 6 hours long the Computer Clock 
drift might be many seconds by the end of the 6 hour recording. If no frames 
were dropped the timecode in the output file is contiguous from start to finish.

Regardless of how Compensate for Computer Clock Drift  is set, if packets are lost 
and frames are dropped the Live Source process adds frames using the last good 
timecode in order to compensate for the lost frames. This may cause timecode 
values to be repeated where a frame was lost. If your RTMP signal is strong you 
should never see this happen.

Free Run—This timecode starts at 00:00:00:00 and free-runs, after the associated 
Capture workflow is activated. The recorded timecode captured reflects the free 
run timecode at the time capture begins.

Free Run TimeCode—When enabled, and the desired timecode is not detected or 
goes away, the timecode seamlessly free-runs from the last good timecode received. 
When Free Run TimeCode is not enabled and the desired timecode is not detected or 
goes away, the timecode reverts to zero (00:00:00:00) and stays at zero.

Compensate for Computer Clock Drift—When enabled, compensates for Computer 
Time Code drift when Computer Clock is the chosen TimeCode Source. 
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Freeze on LOS—When enabled, causes the source to hold the last good frame if the 
signal is lost.

LOS Video Test Pattern—Select the test pattern to display during LOS.

Note: The LOS Audio Test Signal is not available for RTMP sources.

Log Timecode—When enabled, the timecode is added to the log. Available only in 
Advanced Mode. 

Decompressor—Specifies which codec to use for source decompression. Default: 
Decompression is performed by the CPU. Lightspeed GPU: Decompression is performed 
by the GPU.
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Managing and Configuring Audio Tracks
Audio Tracks are managed in the Preview panel of the Source Manager. The selected 
track is displayed when you click Audio Tracks below the video display and includes 
configuration tools.

 

An Audio Track is added, by default, when you create a source and it usually is 
automatically configured to match the source. 

Adding an Audio Track
Click the musical note + icon  in the toolbar to add a new audio track. Select Mono | 
Stereo | 5.1 Surround. You can add multiple tracks to provide for different languages, 
various services, or other variations. The channel assignments can be changed if you 
want specific different configurations. 

Click the Trash icon in the toolbar to delete the selected track. 

Previewing the Audio Tracks
When more than one Audio Track is present, you can select the track that you want to 
hear in the Source Preview panel by selecting it from the audio track list. Audio tracks 
display in the list only after you add them as explained above. The track configured as 
Default track is the one that you hear if you do not manually select a track.

 

Configuring an Audio Track
To open the audio track configuration dialog, click the Edit This Track pencil icon  for 
the track you want to configure. You can change configuration dialog settings to 
configure the track as described below. 
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• Name—Specifies the name of the audio track.

• Language—Specifies the language to use for this track. (Does not affect final output).

• Audio Service—Specifies the audio service label to use for this track: Primary | Sec-
ondary | Commentary | Music. (Does not affect final output).

• Description—Select a description to use for the Audio Track. The descriptions are 
created and edited in the Settings dialog > Audio Descriptions tab of Live Stream. 
See Audio Descriptions. 

• Default—Enable to set the audio track as the default. When enabled, this track is 
the one used first when you select the source to preview. You can select a different 
Audio Track to use for the preview from the menu in the upper right of the Sources 
panel. Setting a track to Default also marks it as the settings to use for the Channel 
Assignment of the output. However, the audio encoder setting determines the 
actual channel type of Mono, Stereo, or 5.1 to use for the output. See the AAC Audio 
Streams, AAC Channel Layout setting. 

• Channel Assignment—Specifies which source channel is assigned to the output 
channel. The default for Mono is Center=1; for Stereo is Left=1, Right=2; for Sur-
round (5.1) is Left=1, Right=2, Center=3, LFE=4, Left Surround=5, and Right Sur-
round=6.

• AC3 Decompressor—When enabled, AC3 audio embedded in PCM is decoded at 
the source level and passed on as PCM, for use directly in the primary or secondary 
outputs and the Preview panel of a Live system. The AC3 Decompressor setting 
appears in the audio Edit Track panel, where you can enable it. After the AC3 Decom-
pressor is enabled, the affected source’s Live Source process restarts automatically. 
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Managing Text Tracks for 608|708 Captions
The Text Tracks panel directly below the Source Details panel, enables you to manage and 
configure your 608/708 captioning text tracks.

Note: Captions in your source are preserved and passed through even if you don’t 
add a Text Track. Text Tracks allow you to select either a C608 or C708 option. 

 

Adding a Text Track
Add Text Tracks so you can select either C608 or C708 caption tracks that are provided 
with the source. Click the + icon in Text Tracks to add a caption track, and select C608 or 
C708. The specified text track is included with the captured output when used with 
compatible delivery methods and destinations. 

Click the Trash icon in the toolbar to delete the selected track. 

Configuring a Text Track
Click the Configure (pencil) icon in the toolbar to view and edit the selected track.

 

The Configure Text Track panel provides these options:

Name—Specifies the name of the text track.

Language—Specifies the language of the caption text track. When HLS or DASH is 
streamed, the language title is displayed to the end-user in caption-compatible players 
so they can select the language and enable the caption text track.

CC Index—Specifies the CC index (or Service) to use for this caption track. Default: 1.
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Using Sources for Both Live Stream and Capture
This information applies only when Live Stream and Live Capture are used on the same 
Lightspeed Live Server:

Note: Changing sources in any way on the Source Manager panel affects which 
sources are available to the Live Capture and Live Stream web applications. 
Conversely, changing source configurations in the Live Stream web application 
changes what is shown on the Source Manager panel.

WARNING: When Live Stream and Live Capture are used on a server concurrently, any File 
Loop or Slate sources that display in the Source Manager panel are NOT supported for 
Capture workflows. Do not make any changes to the options for these sources; they are 
created by and used by the Stream web app. 
Configuration changes for these sources are made in the Lightspeed Live Stream web 
application. The actual name of the sources created in Live Stream can be any name they 
have been given, and may not be called File Loop, RTMP, and so on.

Clear Browsing Data after Updating Software
After a ComponentPac update is installed in Vantage, you should clear the browsing 
data in your Chrome browser in order for the web applications to operate properly. 
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Re-configuring Lightspeed Live Servers
The following topics explain how to make common configuration changes to a 
Lightspeed Live Server.

■ Configuring Non-Capture Workflow Actions in Lightspeed Live Server Groups

■ Joining Multiple Capture Servers

■ Uniquely Named Multiple Capture Servers

■ Best Practices for Multiple Live Capture Server System Design

■ Connecting Web Applications for Multiple Servers

■ Correcting Thumbnail Appearance on Non-Local Systems

Lightspeed Live servers with only Live Stream installed do not include Vantage as part 
of the product. 

Note: However, Lightspeed Live Capture includes Vantage pre-installed as part of the 
product, and the associated Vantage domain uses the name assigned to the Windows 
server that hosts the Vantage domain database as its domain name. Consequently, 
renaming a Lightspeed Live server that includes Live Capture includes steps to 
rename the Vantage domain that do not apply to renaming a Live server.

Renaming a Stream/Capture Server—Follow all of these steps for a Capture server, 
but for a Stream server, skip all steps pertaining to Vantage. 

Renaming a Live Stream-Only Server—Follow steps 6 through 12 only (ignore all 
Vantage steps). An easier method to change the Stream server name is via the Systems 
options in the Group Portal web app. See Changing a Server’s Name. 

Note: If you change the server name and Live Stream doesn’t auto-update, you can 
change the server name via the Systems options in the Group Portal web app 
(Configuring Lightspeed Live Server Groups and Users). 

If you want to rename your Lightspeed Live Server and keep the pre-installed Vantage 
database, you should complete these tasks to ensure that your database is updated 
with the new name (detailed steps following):

• Remove all Vantage services from the Vantage domain.

• Rename the Windows server that hosts the Vantage domain database.

• Restart the renamed server and add all Vantage services to the renamed domain.

CAUTION: The server name must be limited to 15 characters or less.

Note: To complete this procedure, your Windows user must have permission to 
rename the computer, or you must get assistance from your Windows domain 
administrator. Be sure to schedule the rename during a maintenance window, as 
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renaming the Vantage domain interrupts all Vantage services in the domain and all 
Windows services on the server are renamed.
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Use these steps to rename a Vantage server and domain.

1. Start the Vantage Management Console, select the domain, and log on (see 
Vantage Domain Management Guide > Starting the Vantage Management Console).

2. Select Services in the component panel.

3. Take note of Storage, Variables, and/or Qualification Rules settings for each service 
that you have configured. Write down any Storage, Variable, and/or Qualification 
Rule settings that you want to reconfigure after the Vantage domain is renamed.

Note: When you remove Vantage services from the domain, the Storage, Variable, 
and Qualification rule configuration for each service is lost. The rest of the Vantage 
domain configuration is retained. If you are changing the machine name during initial 
server installation, no custom rules have been configured, so this does not apply.

4. Click a service in the Services details panel, then press Ctrl-A to select all services.

5. Click the Remove Service button  in the toolbar.

6. Open the Windows Server Manager—click the Windows Start Menu > 
Administrative Tools > Server Manager.

7. Click Local Server in the left pane then click the Computer Name link.

8. Select the Computer Name tab and click Change.

9. Enter the new computer name in the Computer Name text field and click OK. This 
new computer name becomes your new Vantage domain name.

10. If prompted to do so, enter a Windows user name and password for an account that 
has permission to rename this computer in the Windows domain.

11. Restart the server.

12. Start the Vantage Management Console, select the new domain, and log on.

– If you are not prompted to select the new domain, click on File > Change 
Vantage Domain, click Search, select the new domain and click OK. 

13. Select Services in the Component panel.

14. Click the Add Service button  in the toolbar.

Note: If you are not able to log in with the local Administrator account, check the 
hostname listed by Windows as it may not have been updated. For example, if the 
original hostname was lsl-telestream and the new one is lsl-customer, the User Name 
may still be listed as: lsl-telestream\Administrator. If so, change the hostname to: 
lsl-customer\Administrator, and re-enter your password.

15. In the Select Service dialog, click Machine to sort the services by machine name.

16. To add Vantage services for, select the services you want and click OK.

17. If any Storage, Variables, and/or Qualification Rules settings were configured for 
services, add them now.

18. Send the new Vantage domain name to all Vantage users and administrators so 
they can reconnect to the Vantage domain.
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Stopping and Restarting Telestream Live Services
If you have changed server settings to join a group, or changed port numbers, some 
services must be stopped and restarted on the server(s). 

Note: There are also other changes that require stopping and restarting the live 
services, such as changing the materials Resource Location in the Stream Edit Settings 
dialog or changing port numbers. In these cases, if you have just one Lightspeed Live 
Server you only need to perform the portion of this procedure that affects that server. 

Follow these steps to stop and restart the Live services:

1. Open the Services control panel by typing services.msc in the search field of the 
Start menu, then press Enter. The Services window opens.

2. On each new server, stop the following services, in this order:

a. Telestream Live Stream Service
b. Telestream Live Source Service

Note: Insure that the services stop process has completed before continuing.

3. On each new server, restart the following services, in this order:

a. Telestream Live Source Service
b. Telestream Live Stream Service

4. Close the Services window.

5. On the Primary server, stop the following services, in this order:

a. Telestream Live Stream Service
b. Telestream Live Source Service

Note: Insure that the services stop process has completed before continuing.
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6. On the Primary server, restart the following services, in this order:

a. Telestream Live Source Service
b. Telestream Live Stream Service

7. Close the Services window.

The sources from all Lightspeed Live Servers should now display in the Lightspeed Live 
Stream web application Sources panel and Source Manager. 

Firewalls and Blocked Ports Limit Functionality
If you have firewalls and/or blocked ports you may not be able to fully access joined 
Lightspeed Live Servers. The servers display, but you may not be able to configure 
settings for Channels or see the Sources.

Telestream recommends that you disable the Windows Firewall on all computers that 
must communicate with or support Vantage services. The default Windows Firewall 
configuration blocks access to a Vantage server from other Vantage components, such 
as other Vantage servers or workstations running Vantage client software.

For more information, see Firewall Guidelines in the Telestream Vantage Domain 
Management Guide. 

When Lightspeed Live Servers are joined together in a group, you manage all of the 
joined servers from a single Lightspeed Live Stream web application, but all servers 
work independently.

The list of Sources in the Live Stream and Source Manager web apps are separated into 
a panel for each server. 

Create a UNC Path for Resource Locations
When using a Lightspeed Live Server group (multiple servers are joined together), you 
should specify the Resource Location for Materials assets as a UNC path. This allows 
different servers to access the image or video assets used for Segment Materials. See 
Managing General Settings to set the Resource Location path.

A typical UNC path looks like this: \\hostname\Stream\Materials.

A UNC path uses two backslashes to precede the name of the host server, followed by 
the set of folders to the file, and optionally, the file itself. In this case, only supply the 
folder path.
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Configuring Non-Capture Workflow Actions in Lightspeed 
Live Server Groups

Live Capture server licenses include an array license. When Live Capture workflows are 
created and executed, all Capture origin action processes run on their respective Live 
Capture servers automatically. However, other services such as the Transport or Deploy 
service, can run on any server with available resources for the desired service's action. 
The following describes the best practices for configuring storage settings when using 
non-Capture actions.

Best Practice When Capturing to a Live Capture Local Media Drive:

When you are capturing directly to a Local Live Store that is set to a local drive letter's 
folder, any workflow action immediately following the Capture Action are processed 
locally. For actions that do not immediately follow the Capture Action, best practice is 
to set Run On Rules that instruct the non-Capture action processes to run on the Live 
Capture server where the media resides. This insures that the non-Capture action 
process runs directly on the server where the media resides. See Configuring an 
Action's Run On Rules in the Vantage User Guide for more information. 

Best Practice When Capturing to Shared External Storage: 

When you are capturing to a shared external storage location, such as a NAS or SAN, 
you can allow other non-Capture action processes to run on any server with available 
resources. In this case “Run On Rules” are not required. Your system automatically 
chooses an available resource on any server that can run the required action's process. 

Note: Running Lightspeed Live Capture and Vantage together without array licenses 
is not recommended and may result in reduced functionality.

See Joining Multiple Capture Servers below for information about setting up an array. 
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Joining Multiple Capture Servers
Your Lightspeed Live Capture server is factory-configured as a standalone live Capture 
system. This configuration includes a Vantage database running on the Lightspeed Live 
Server. If you plan to manage a Lightspeed Live Server group from a common interface, 
or add Lightspeed Live Servers to a Vantage array, you can do this in two ways: 

• For Capture-only systems, join all Lightspeed Live Servers together by creating a 
system that utilizes a single domain database. 

• For Capture systems that utilize other Vantage services and actions, such as 
Transcoding and Analysis, you can add your Lightspeed Live Servers to an existing 
Vantage array.

Best Practices for Joining Lightspeed Live Servers
Vantage database and Live Capture web app traffic can affect the performance of a 
Lightspeed Live Server in a domain containing multiple Capture servers. Therefore, 
when joining two or more Lightspeed Live Servers together into a single domain—
either as a Capture-only solution or into an existing Vantage server domain—
Telestream recommends that the Vantage database and IIS software hosting the Live 
Capture/Vantage web applications run on dedicated Vantage server. See images below 
and Best Practices for Multiple Live Capture Server System Design.

Further information regarding hosting the database and IIS on a dedicated server is in 
the Vantage Domain Management Guide on the Telestream web site. 

It is also highly recommended that the process of creating a Lightspeed Live Server 
group be done as part of the installation and commissioning phase.

Important Note: When standalone Lightspeed Live servers are combined together 
using a single database, only those ComponentPacs installed on the master domain 
database are utilized. When joining Lightspeed Live servers together into a Live 
Capture-only system or into an existing Vantage array, always verify that all of the 
required ComponentPacs are installed on the combined system’s master domain 
database.
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Joining Capture-Only Systems
Two or more Lightspeed Live Capture servers can be joined together to form a multiple 
server Live Capture-only system. This allows for common configuration, management, 
and capture control.

  

To join Lightspeed Live servers together, follow these steps:

1. Select one of your Lightspeed Live servers to act as the master domain. The master 
domain server system contains the common database and has all the services 
running on other Lightspeed Live servers added to it via the Vantage Management 
Console. 

2. Add all services running on your Lightspeed Live servers to the Lightspeed Live 
Capture master domain server. See the Vantage Domain Management Guide for 
details on adding services.

3. Apply the appropriate multiple-server Vantage license onto the system running the 
master domain database. See the Vantage Domain Management Guide for details 
on licensing.

To configure, manage, and control your Lightspeed Live Capture system, run the 
Vantage Management Console, Vantage Workflow Designer, and Lightspeed Live 
Capture web applications pointing to the domain contained on the Lightspeed Live 
Capture master domain server selected in Step 1, above.

Also see, Configuring Non-Capture Workflow Actions in Lightspeed Live Server Groups. 
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Existing Vantage Array - Adding Live Capture Servers
Joining Lightspeed Live Capture servers to an existing Vantage Array allows Vantage 
workflows to begin with a Capture origin action that is connected to other Vantage 
actions and services, such as general transcoding, IPTV/VOD transcoding, analysis, third 
party application control, delivery options, or other service/action types.

   

Adding Services

The Lightspeed Live Capture server includes Vantage services, so adding these services 
to an existing Vantage Array is no different than adding any other Vantage service 
running on a separate server to a Vantage Array. 

Important Note: Joining Live Capture services to an existing Vantage Array requires 
the appropriate Vantage Array licensing. See the Vantage Domain Management 
Guide for details.

To add Lightspeed Live Capture services to a Vantage array, follow these steps:

1. Verify that the Lightspeed Live Capture services are running, all Vantage Services 
are running on the server, and no jobs are being processed in the local, factory-
installed All-In-One domain.
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2. Verify that you have configured the other (non-Lightspeed) Vantage domain server 
with array, and it is running. Refer to the Vantage Domain Management Guide > 
Installing a Vantage Distributed Domain, for more details.

3. Verify that the Lightspeed Live Capture server is on the same network as the 
existing Vantage array, with sufficient network permissions and access. Refer to the 
Vantage Domain Management Guide > Network Requirements, to configure your 
network.

4. Start the Vantage Management Console, and select the new Vantage array domain.

5. Add the services on the Lightspeed Live Capture server to the new Vantage array, 
just as you would do with any Vantage Services running on any Vantage server.

6. Apply the appropriate multiple-server Vantage license onto the system running the 
master domain database. See the Vantage Domain Management Guide for details 
on licensing.

Also see Configuring Non-Capture Workflow Actions in Lightspeed Live Server Groups. 

Uniquely Named Multiple Capture Servers
To ensure each capture source has a unique name when multiple Live Capture servers 
are part of a multi-server, Capture-only system, or part of an existing Vantage array, you 
must change the default source names to make them unique and identifiable. 

Source names default to SDI Input [1 through n], where n is 4 or 8 depending on the 
Lightspeed Live Server model.

For example, by default, source names for a 4 channel Live Capture server are:

SDI Input 1 | SDI Input 2 | SDI Input 3 | SDI Input 4

If you change source names by using the Source Manager, keep in mind that all sources 
in an array must be uniquely named so you can easily distinguish sources on one server 
from sources on another.
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Best Practices for Multiple Live Capture Server System 
Design

The best practice for using multiple Live Capture server systems is to install and run the 
Vantage master domain database and IIS Web Server on a server(s) that is separate 
from the Live Capture servers. See the Vantage Domain Management Guide for details 
on how to install a Vantage Database and Microsoft's IIS Web Server.

When clustering two or more Live Capture and Vantage servers together, best practice 
is to use a separate server designated as the IIS Web Server to host the Live Capture 
Web application. Ideally, the web host should be separate from the Vantage master 
domain database system since both IIS and SQL can consume a considerable amount 
of system resources. 

The following are two example systems utilizing a separate Database and IIS Web 
Server.

Capture-only System

 

For this Capture-only system example, the Vantage master domain database and IIS 
Web server are installed together on a separate server. This prevents database or Web 
server resources consumption from affecting the Live Capture servers.
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Live Capture/Vantage Array—with Separate Vantage Domain Database and IIS 
Web Host Servers

 

For this example the Vantage master domain database and IIS Web server are installed 
on two completely separate servers. Since this is a large system array containing six (6) 
Vantage system and three (3) Live Capture servers, separating the database and Web 
Server is recommended to prevent the database and IIS Web server resource 
consumption from affecting the Live Capture and Vantage servers.

For additional information on best practices for Vantage and Vantage Databases, refer 
to the Vantage Domain Management Guide and the publication Planning and Setting 
Up a Vantage Database on the Telestream.net web site.
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Connecting Web Applications for Multiple Servers
When you have multiple Capture server systems where the database and web server 
reside on specific server(s) in the multiple server configuration, the Vantage client 
applications and/or the Live Capture web application must be configured to connect to 
the appropriate server. 

Configuring Vantage Client Applications for Multiple Servers 
Since the database in a multiple server system is located on a separate server, the 
Vantage client applications must point to that database. Do this by selecting the 
database server in the Select Vantage Domain dialog in each Vantage client application.

Using the Vantage Desktop Client Applications 

First, install the Vantage Management Console and Vantage Workflow Designer client 
applications on any Windows system on your network. To use these client applications, 
you must change the Vantage Domain so they connect to the server that is running the 
Vantage master domain database. 

Select Change Vantage Domains from the File menu of each client application to open 
the Select Vantage Domain dialog.

Note: To learn more about the Vantage Management Console or Vantage Workflow 
Designer, click the ? icon to display the topic for the feature that you are using. Or, use 
the Help menu to open the searchable Vantage User Guide for general help.
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Using the Live Capture Web App with Multiple Servers 
To use the Lightspeed Live Capture web application in a Lightspeed Live Server group, 
first install the Vantage web applications on the server running the IIS Web service. To 
open the Lightspeed Live Capture web application, use the following URL:

http://[IIS Web server Name|IP Address]/CapturePortal/

When prompted to select a Vantage domain, choose the server hosting the Vantage 
domain database.
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Using NetBIOS Hostnames Instead of External Name Server
A multi-node Live Capture system can be used without an external name server, when 
NetBIOS is enabled in the database server and all nodes.

Configure the following settings in all servers to enable NetBIOS:

1. Open the Control Panel and select Network and Sharing Center.

2. Select Change Adapter Settings to open Network Connections.

3. Right-click the network connection to change and select Properties to display its 
dialog:

4. Select TCP/IPv4 and click the Properties button to display its dialog:
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5. Configure the IP Address for each server. 

6. Configure the Subnet Mask, Default Gateway, and the DNS server addresses. Use 
the same addresses for each server. 

7. Click Advanced to display the dialog:

8. Select the WINS tab and select Enable NetBIOS over TCP/IP. 

9. Click OK in all dialogs to save the configuration.

10.  Reboot the server, then configure all other servers. 
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Correcting Thumbnail Appearance on Non-Local Systems
When using the Live Capture web application over the network, you may see a No Event 
message instead of the video thumbnails. To resolve this problem, update the hosts file 
with the server IP address an  host name on the computer you are using to access the 
Web Applications.

The following procedures describe how to correct this for Mac OS and Windows 
workstations.

MacOS Procedure to Correct Thumbnail Appearance
On a Mac OS computer, update the hosts file and save it:

1. Open the Terminal application by going to Application > Utilities and double-
clicking Terminal.app.

2. Type the following command and press Return: sudo nano/etc/hosts

3. Enter the administrator password for the computer and press Return.

4. Move the cursor using the arrow keys and position it after all of the text in the 
window. Then type the IP address of your Lightspeed Live Capture server.

For example: 102.54.94.97

5. Press the Tab key, then type the host name of the Lightspeed Live Capture server.

For example: CaptureServer1

6. Hold down the Control and 0 keys and press Return. 

7. Press Control-X to exit.

8. Flush your DNS by executing the following command in the Terminal:

sudo killall -HUP mDNSResponder

9. Quit the Terminal application. 

Windows Procedure to Correct Thumbnail Appearance
On a Windows computer, update the hosts file and save it:

1. Open File Explorer and navigate to: C:\Windows\System32\drivers\etc. 

2. Right-click the hosts file and open it in Notepad.

3. On a new line, enter the IP address of your Lightspeed Live Capture server.

For example: 102.54.94.97

4. Press the Tab key. 

5. Enter the hostname of your Lightspeed Live Capture server.

For example: CaptureServer1

6. Save the file and close Notepad.
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Updating Lightspeed Live Stream Software
Lightspeed Live Servers ship with Lightspeed Live Stream software pre-installed. If 
some time has elapsed since Telestream manufactured and shipped the product, 
software updates may be available. 

To check for updates and get help with installing them, contact Telestream Customer 
Support. See Obtaining Support | Information | Assistance for contact details. 

Obtain the Live Stream installer, then proceed to single server or server group 
installation, as appropriate.

Updating a Single Server
To update Live Stream software on one Lightspeed server, follow these steps:

1. Run the Telestream Live Stream installer and follow the directions.

Updating a Server Group
To update Live Stream software on a group of Lightspeed servers, follow these steps:

For each Lightspeed Live Server in the group, follow these steps: 

1. In Windows, uninstall the Telestream Live Stream program. 

2. Open the Group Portal web app (see Configuring Lightspeed Live Server Groups and 
Users) and place the server in maintenance mode (see Maintenance Mode for 
details). 

3. Run the Telestream Live Stream installer and follow the directions.

4. Back in Group Portal, remove the server from maintenance mode.

Using Log Files and Other Support Information
The following topics explain log files and provide other troubleshooting and service 
information.

 Log Files for Live Stream
Log files can provide valuable information about the operation of Lightspeed Live 
Stream. The following describes how to download the log files and how to change the 
information they contain.

Downloading the Stream Log Files
The Lightspeed Live Stream log files can be downloaded using a browser. The contents 
of the log files may be helpful to Telestream Customer Support to troubleshoot system 
problems. You may want to access and save the log files before making a support call so 
you can email them to Telestream as part of the support process.
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Download the Live Services log files by selecting the General Settings Menu  and 
choosing Download System Logs. A zip file will download to your default download 
folder. You can open the zip file and examine the logs, or forward the file to Telestream 
Support with a request for assistance.

These log files are included in the download:

• Devices.csv

• EventLog-Application.evtx

• EventLog-System.evtx

• export.xml

• Processes.cvs

• Registry.cvs

• Services.cvs

• SNMPLogs

• Stats.txt

The SNMPLogs folder contains the following additional items:

• LiveSourceService-[build number]-[date].log—The Source service log records any 
activity with the sources. This includes various activities, such as loss of signal, 
change of format, sources being added, or sources being removed.

• LiveStreamService-[build number]-[date].log—The Stream service log records any 
encoder failures and the service starting.

• packagingLog

• traceLog

Changing Log Content Settings
The information created in the log files can be changed by editing settings in the 
configuration files that control logging file generation. The log files are located in 

C:\Program Files\Telestream\Live Stream Server\ and C:\Program 
Files\Telestream\Live Source Server\ folders.

CAUTION: Before making changes to the configuration files, make backups by 
copying the existing files and saving them to a safe location. 

The configuration files are:

• ChannelEncode.exe.config

• ChannelProgram.exe.config

• LivePreview.exe.config

• LiveService.exe.config

• SourceService.exe.config
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Note: The default Warn Log level should not be changed unless directed by Customer 
Service or you are tracking a specific issue as an advanced user.

The following fields in the configuration files can be edited to change logging results:

• logconsole

• logfile

• email

• elastic

The above fields can be edited to use any of these logging levels: 

• Off

• Fatal

• Error

• Warn

• Info

• Debug

• Trace

For details about using NLog to modify log file outputs, refer to the NLog tutorial: 
https://github.com/NLog/NLog/wiki/Tutorial#log-levels.

Locating the Live Stream Service Tag
When contacting Telestream support about Lightspeed Live Stream always include 
your system’s Service Tag number. The Service Tag is displayed in the Live Stream web 
application’s About dialog and is unique to each Lightspeed Live Stream server.

To display the About dialog, click the General Stream Settings icon  in the upper 
right of the Live Stream interface and select About.

Note: The Service Tag is only present after a Lightspeed Live Server has been 
licensed. The Service Tag will continue to appear after the server license has expired. 
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Service Tag
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Configuring Lightspeed 
Live Server Groups and 
Users
This chapter describes the Group Portal web app, which enables you to create and 
manage Lightspeed Live Server groups, configure server redundancy within groups to 
help reduce downtime, and create and assign multiple users and roles.

Topics
■ Group Portal Overview

■ Launching and Logging Into the Group Portal

■ Redundancy Clustering

■ Using Virtual Machines (VMs) in Groups

■ Groups Quick Start

■ Creating and Configuring Groups

■ Using the Group Details Panel
Lightspeed Live Stream User Guide



Configuring Lightspeed Live Server Groups and Users
Group Portal Overview

116 
Group Portal Overview
The Group Portal allows you to group Lightspeed Live servers together for redundancy 
and management. Up to seven Lightspeed Live servers can be grouped together for 
operational performance and management. 

Groups can be enabled for n+1 and n+m redundancy to help reduce the impact of 
server outages. If a server goes offline, another server in the group resumes operating 
on the same specification. Even when redundancy is not used, groups are easier to 
manage because they share configurations including Programs, Encoders and 
Packages, and linked user interfaces. 

This figure depicts the main Group Portal window, where groups are added, and the 
Group Details window where a single group is managed:

Groups

Add
Groups

Group Management MenusSystems List & MenusGroup Status

Unused 
Servers &
Groups

You can also create users with specific privileges for managing or monitoring servers in 
that group according to typical roles. For example, you can assign roles for Administrators, 
Operators, Schedulers, Monitors, and API Users. 
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Launching and Logging Into the Group Portal
Here’s how to open and log into the Group Portal web application:

Launch Chrome and enter the following URL in the address field:

http://<servername>:8090/system

where <servername> is the host name or IP address of the Lightspeed Live server. If you 
changed the default port, be sure to use the new one.

When running Chrome locally on the Lightspeed server, you can use this URL:

http://localhost:8090/system

These URLs displays the Groups configuration and access panel of the Group Portal. 

The default username is admin, and the default password is live!. 

Note: Only system administrators can log into the Group Portal.

Redundancy Clustering
Note: Live Stream Only: Redundancy Mode shouldn't be enabled when servers are 
running both Live Capture and Live Stream. Redundancy Mode is used when only 
running Live Stream.

You can enable servers within a group to implement operational redundancy. Other 
configuration options are possible; they require assistance from Customer Service or 
Field Services.

When redundancy is enabled, all servers in the group participate in redundancy. 
Redundancy allows one or more specified servers to take over if a server that is 
currently running channels fails or is switched into Maintenance Mode.

Before you can enable redundancy, the following conditions should be met:

• All servers in any existing group must first be removed from the group

• All servers in the group must be running the same Source/Stream software on all 
servers in the group.

To enable or disable redundancy, see the Redundancy topic under Status Indicators.
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Using Virtual Machines (VMs) in Groups
Groups require at least three Lightspeed Live Servers for a stable group. If you plan to 
implement redundancy, (see Redundancy Clustering) it requires at least one in hot spare 
mode.

One method to create a group with redundancy using only two Lightspeed Live Serv-
ers is with a VM that has Live Stream installed:

1. Use the first Lightspeed Live server as the active Live Stream server. 

2. Add the VM-based server to the group as an active server, along with the first 
Lightspeed Live server.

The VM is typically not able to run most jobs (except jobs with Transport Stream or 
RTMP sources that the VM has access to). The primary purpose of the VM is to keep 
the group from becoming unusable due to having only one server in the group.

3. Add the second Lightspeed Live server to the group in hot spare mode.

Now, if the active Lightspeed Live Server fails, the second Lightspeed server will take its 
place. This enables you to bring your failed Lightspeed Live Server back online. 

Groups Quick Start
To create a group, add users, and—for Stream only—enable redundancy (see Creating 
and Configuring Groups for details), follow these steps:

1. Log into the Group Portal and click the large plus icon (+) to create a group, and 
then assign a group name and a host using the Group Configuration panel.

2. Log into the group initially using the admin user account and password (live!). After 
log-in, the group heading displays green.

3. In the group header, click the More menu ( ) and click Details.

4. Click the Systems plus (+) menu and configure the Peer (IP) Address of a server to 
manage group communication, which may be the same as the group host.

After configuring the Peer Address, the etcd.exe process ends. The Telestream Live 
Source and Vantage Live services must be manually stopped and restarted (first 
Source, then Live). When the services are stopped, make sure the associated pro-
cesses are no longer present before attempting to restart them.

5. Click the Systems plus (+) menu to add a server, and repeat as necessary until all 
servers you want in the group are added. Servers are displayed in the Systems list.

6. Select the Users menu  in the upper right corner to open the new users dialog. 
Click the plus (+) to add a new user, and select a role describing that user’s access 
level. Then click Save. Repeat as needed to create additional users.

7. For Live Stream groups only—to enable redundancy, click the Systems Menu ( ) 
and select Enable Redundancy—the Redundant status indicator on the left 
changes from gray to green when redundancy is enabled.

Users can now log into the group using the accounts you created. Repeat this process 
to create other groups as required.
Lightspeed Live Stream User Guide



Configuring Lightspeed Live Server Groups and Users 
Creating and Configuring Groups

119
Creating and Configuring Groups
Use the Group Configuration panel to create a group and edit group parameters.

Click the large box with the plus sign to display the Group Configuration dialog.

The Group Configuration dialog displays when you add a group.

 

Use this dialog to name the group and assign a group host. 

• Group Name—Specifies the name of the group. 

• Address—Specifies the IP address or Host Name of the group server.

• Port Number—Specifies the web socket server port.
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Group Menu and Selections
Group icons display in the main Group Portal window, with one icon per group. Each 
group has a header color to indicate whether the web app is logged into the group— 
green is logged in, red is not logged in. Amber indicates a group in an ambiguous state, 
such as when you are in the process of logging in.

Groups include selections on the front of the group to open the Sources or Live Stream 
web apps, and a More menu with options specifically for that group:

• Sources—Opens the Live Stream Source Manager web app.

• Live Streaming—Opens the Lightspeed Live Stream web app.

• Details—Displays the Group Details panel (see Using the Group Details Panel).

• Sign In/Out—Logs the current user in or out. Only system administrators can log 
into the Group Portal. See Groups and Users Management Menus for details.

• Edit—Opens the Group Configuration dialog to edit the group (described previously).

• Remove—Deletes the group.
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Using the Group Details Panel
When you click on a group, a panel displays showing the features of the group:

Group Management MenusStatus Indicators Systems

Extra Servers Inactive Specifications
m

From the Group Details panel, you can access these functions:

• Group Management Menus—Allow group editing: Configuration, Users, Delete, 
and Settings.

• Status Indicators—Shows group connection, user, and redundancy status.

• Systems—Lists the Live servers that belong to the group.

• Extra Servers—Lists Live servers that are available but not running a specification.

Inactive Specifications—Lists specifications that currently have no server to run them.

Groups and Users Management Menus
The Group Management Menus provide general functions for groups and users.

• Configuration—Allows changing the group name, address, and port number (see 
Creating and Configuring Groups).

• Delete—Deletes the group (see Adding Users).

• Users—Adds users and their roles to the group (see Adding Users). Each group has 
separate users configured specifically and exclusively for that group.
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• Settings—Allows changing group settings, such as Network Configuration (port 
assignments) and Notification settings (see Editing Group Settings).

Adding Users
To add or edit users, click the Users icon  in the toolbar (or select Admin > Manage 
Users) to display the Users panel: 

To add a user, click Add (+). To edit a user configuration, click its pencil. To delete a user, 
select its trash icon.

When adding a user, assign a Username, Password, select a Role, and click Save. 
Available roles and their privileges include:

• Administrator—Modify Users, View, Create/Modify, Start/Stop/Schedule, API

• Operator—View, Create/Modify, Start/Stop/Schedule

• Scheduler—View, Start/Stop/Schedule

• Monitor—View

• API User—View, API

Editing Group Settings
Group settings includes network configuration and notifications.

Network Configuration (port assignments) includes fields for port assignments. Update 
port numbers as appropriate and click Save.

Click the Settings  icon in the toolbar to display the Group Settings panel. 
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Note: If you change ports, you must restart the services on each server in the group.

In the Notification settings, enter thresholds for high memory and CPU usage, above 
which you want to receive notifications. 

Status Indicators
The status bars on the left side of the window show the group’s current status:

• Connected—Shows whether the group is currently connected to the group server. 

• User—Shows the current logged in user. Click the three-dot menu to manage users 
or sign out of the group. See Adding Users under Groups and Users Management 
Menus for details.

• Redundancy—Shows the current redundancy state for the group. Click the three-
dot menu to alternately select Enable Redundancy or Disable Redundancy. See Join 
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and Manage Multiple Servers in a Group > Systems Menu (Redundancy On/Off) for 
additional details.
Lightspeed Live Stream User Guide



Configuring Lightspeed Live Server Groups and Users 
Using the Group Details Panel

125
Join and Manage Multiple Servers in a Group
Systems options provide the ability to add and manage multiple servers in a group.

Note: Even if you have joined servers together to use Live Capture or the servers you 
are joining are part of a Vantage array, you need to also perform the process described 
here to use multiple servers for Live Stream. 

Note: Redundancy Mode shouldn’t be used when servers are running both Live 
Capture and Live Stream. Redundancy Mode is used when only running Live Stream.

The Systems list shows which systems have been assigned to the group. The left 
column shows running systems in the group, and the right column shows which 
specifications those systems are running. 

Icons on the right provide these functions:

• Add (+)—Opens a dialog to allow adding a peer and other systems to the group.

• Systems Menu ( )—Opens a menu with the Enable/Disable Redundancy selec-
tion to turn redundancy on or off for the group.

Add (+)
The first time you use this menu, enter the Peer Address (IP address) of the physical 
server that will manage group communication; you can use the group host for this. 
After first use, the Connect System dialog opens to add a system to the group (by IP 
address). Click to Save. 

Note: After configuring the Peer Address, the etcd.exe process will end, leaving the 
Source and Stream services running. These must be manually stopped and restarted 
(Source then Stream). When the services are stopped, make sure the associated 
processes are no longer present before attempting to restart services.
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Systems Menu (Redundancy On/Off)
Click the Systems Menu three-dot icon in the Systems bar and select Enable/Disable 
Redundancy to turn redundancy on or off for the group. 

Additionally to configure redundancy, you need to add a new server, put it into 
Maintenance Mode, delete the extra specification for the new server, and then take that 
server out of Maintenance Mode. This causes an extra physical server to be available, 
but not tied to a specification so that it can serve as a backup. Also see Redundancy 
Clustering on the first page of this chapter.

Maintenance Mode
You can select individual servers in the Systems list, select their three-dot menu, and 
select Enter Maintenance Mode. Maintenance Mode makes a server unavailable for 
running specifications while maintenance is performed, such as a software upgrade or 
server maintenance. If the server is currently running a specification when it enters 
Maintenance Mode, that work fails over to another available server or is relegated to 
inactive specifications if a server is not available.

Note: After taking a server out of Maintenance Mode, refresh the Live Stream web 
app panel before you attempt to check the current state of Channels or interact with 
the Live Stream web app. 

Changing a Server’s Name
To change the name of a server, first put the server into Maintenance Mode, then take it 
out of Maintenance Mode and the Server Configuration dialog displays. Enter the new 
name for the server and click Save. 

Updating Lightspeed Live Software for Servers in a Group
When Lightspeed Live servers are in a group, each server should be put into 
Maintenance Mode one-by-one, software updated, then taken out of Maintenance 
Mode to update the next one.
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Extra Servers
This list shows physical servers that are standing by to take over in case an active 
physical server becomes unavailable (if redundancy is enabled).

Inactive Specifications
A specification is a Live configuration of sources and channels. The Inactive 
Specifications list shows the existing specifications for which there are no physical 
servers available to run them. 
Lightspeed Live Stream User Guide



Configuring Lightspeed Live Server Groups and Users
Using the Group Details Panel

128 
Lightspeed Live Stream User Guide



129
Using the Live Stream 
Web Application
This chapter provides an overview of the Lightspeed Live Stream web application and 
how to use it. It also describes utilitarian topics, plus a list of supported input formats.

Before setting up and broadcasting your first live stream, Telestream recommends that 
you review Lightspeed Live Stream Web App Overview and Live Stream Components, 
Configuration Order, and Media Flow in this chapter. Sample workflows for streaming to 
social media platforms are described in Streaming to Social Media Platforms.

Topics
■ Lightspeed Live Stream Web App Overview

■ Launching / Logging In / Out / Changing your Password

■ Multi-User Access to the Live Stream Web App

■ Accessing Help in Lightspeed Live Stream

■ Activating Your License

■ Muting Audio Globally

■ Live Stream Components, Configuration Order, and Media Flow

■ Managing General Settings

■ Exporting and Importing Configurations

■ Using Live Captioning Input via IP

■ Lightspeed Live Server CPU/GPU Usage Guidelines

■ Live Stream Source Formats

■ Warnings and Error Messages
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Lightspeed Live Stream Web App Overview
The Lightspeed Live Stream web application provides all of the features and options 
you need to create and configure each of the components that you use as building 
blocks to construct live streams and stream your media.

Component Menu General MenuComponents Panel Component Details Panel

Login Icon

The Lightspeed Live Stream interface (shown here with Sources selected and the 
Sources panel displaying) provides these key features:

• Component Menu—Select the type of component you want to add, review, or 
work with. Press ? on your keyboard to display the hot key menu for this compo-
nent type, providing an easy way to add, edit or remove any Source, Encoder, Pro-
gram, Package, and Channel, with simple keyboard shortcut commands.

• Components Panel—The component you select displays the components of this 
type to the right of the menu. For example, when you select Sources, all of the 
Sources in the system are displayed. You select a component to work with it.

• Component Details Panel—Displays details of the selected component. Continu-
ing the example—when you select a specific Source, its Source Details panel dis-
plays, with all of its tools, settings, and controls. Details panels vary by component.

• General Menu—The menu with this icon  in the upper right-corner of the web 
app. Use to access Settings | Export Configurations | Import Configurations | Upload 
Assets | Download System Logs | About.

• Login Icon—Click  to log in / log out, and change your password.
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Using Hot Keys
You can press the ? (question mark key) on your keyboard at any time to display a hot 
key menu for the selected component type. Continue pressing the appropriate keys as 
the hot key menu changes to perform your task. Hot keys vary by component type.

Sources Hot Keys
The Sources hot keys enable you to add, edit, and remove Sources, and add audio or 
text tracks.

Programs Hot Keys
The Programs hot keys enable you to add Programs, edit Segments and conditions, 
delete Segments, and add Materials.
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Encoders Hot Keys
The Encoders hot keys enable you to add, edit, copy, and delete Encoders, and add 
custom and preset Streams.

Packages Hot Keys
The Packages hot keys enable you to add, edit, and delete Packages, and add Variants.
Lightspeed Live Stream User Guide



Using the Live Stream Web Application 
Launching / Logging In / Out / Changing your Password

133
Channels Hot Keys
The Channels hot keys enable you to add, edit, and delete Channels. You can also edit 
schedules and activate Channels.

Launching / Logging In / Out / Changing your 
Password

Here’s how to start and log into the Live Stream web app:

Note: Only the Chrome browser (version 76.0.3809.100 or greater) is supported for 
the Lightspeed Live Stream web application.
The default app server port is 8089. You can change it in General > Settings > Network 
Configuration Panel. If you change port numbers, you must restart the Telestream Live 
services. See Stopping and Restarting Telestream Live Services.

Launch Chrome and enter the following URL in the address field:

http://<servername>live/

Servername can be the DNS name or IP address of the Lightspeed Live server. If you 
changed the default port, be sure to use the new one.

When running Chrome locally on the Lightspeed server, you can use this URL:

http://localhost:8089/live/

Enter the user name and password, if requested. The default username is admin, and 
the default password is live!. The username cannot be changed. 
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Changing Your Password
Select Login icon  > Change Password to display the Change Password dialog. 
Enter your user name, and your current and new password. The default user name is 
admin, and the default password is live!. Click Change to update the password.

Logging Out
Select Login  > Logout to log out of Live Stream. The Sign In panel displays, so you 
can log back in again conveniently.

Changing Passwords and Roles for Multiple Users
Multiple users can be added, roles assigned, and passwords set or changed by using 
the Group Portal UI web application. See the Groups and Users Management Menus in 
the Configuring Lightspeed Live Server Groups and Users chapter for details. 

Multi-User Access to the Live Stream Web App
Multiple users can access the Live Stream web application at the same time.

Note: When different users makes changes to the same component concurrently, the 
last user to save the changes is what is saved. When multiple users plan to use Live 
Stream concurrently, Telestream recommends task coordination to avoid conflicting 
with each other. For example, one person may be operating Live stream—previewing 
channels, managing streaming, and so on, while another is making configuration 
changes.

Close the Live Stream Web App when Not in Use
It is important for each user to close their instance of the Live Stream web application 
when it is not being used. Keeping multiple instances open may cause performance 
issues for other users of the Live server.
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Accessing Help in Lightspeed Live Stream
You can open the Lightspeed Live Stream User Guide (this document) and the 
Lightspeed Live Stream Web API Reference from the About menu (General > About). 

  

The documents are also available on the Telestream web site and on the Lightspeed 
Live installation disk.

Lightspeed Live Web API Reference
The Lightspeed Live Stream Web API Reference is a PDF document that provides API 
commands and instructions to use the Web API operations to control and monitor 
streaming on the Lightspeed Live Server. Programs that users write to control and 
monitor Lightspeed Live Stream are a supplement to the general-purpose Lightspeed 
Live Stream web application. 

To open the Lightspeed Live Stream Web API Reference, select General > About and 
click on Web API Reference.

Activating Your License
Note: When a license is not activated in Lightspeed Live Stream, the output is 
watermarked with the Telestream logo. 

Follow these steps to add a license to a Lightspeed Live Stream server:

1. Click the General icon  in the upper right corner and select About to open the 
About dialog.
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2. Click the Key icon to open the License Key Activation dialog. 

Open the License Key 
Activation dialog

Deactivate the 
License   

3. Enter your license in the License Key Activation dialog, check to accept the license 
agreement, and then click Activate.

 

When your license has been successfully activated, a confirmation displays, which 
indicates the successful activation of the license.

Click away from the About dialog to close it.

Offline License Activation
When the Lightspeed Server that is running Lightspeed Live Stream is not connected to 
the Internet, you can use the Offline Activation system to activate your license. 

Follow these steps to use the Offline Activation method:

1. Click the General icon  in the upper right corner of the web app and select 
About to open the About dialog.
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2. Click the Key icon to open the License Key Activation dialog. 

3. Enter the license you purchased into the License Key field.

4. Check I want to activate this license off-line, and an Activation Code is provided.

Copy the Activation Code

5. Click the Copy button to copy the Activation Code to your clipboard. 

6. Open a text editor and paste the Activation Code into the field, and save that file to 
a convenient location.

7. Transfer that text file to a portable device, such as a thumb drive. 

8. Take the thumb drive to a computer that has Internet access.

9. Open a browser on the Internet access computer and go to https://
cws.telestream.net/offlineactivation.aspx. (You may want to copy this link into the 
same text file, or take a copy of this guide to the Internet computer.)

10. Open the text file and copy the Activation Code to the clipboard of the Internet 
computer, paste it into the Offline Activation Code entry field in the Telestream web 
app, then click Submit to generate the Server Key file. 

11. Depending on your browser settings, you may be provided with a dialog giving you 
the option to save or open the Server Key file. Select Save. Or, the browser may 
automatically save it to a default location.

12. Locate the Server Key file and copy it to the thumb drive and take it back to the 
computer that is running Lightspeed Live Stream. 
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13. In the Server Key field on the License Key Activation dialog click the Select License 
File button, then navigate to the location of the Server Key file and select it. 

Select License File

 

14. When the Server Key file is loaded into Live Stream, check to accept the license 
agreement, then click Activate.

When your license has been successfully activated, a confirmation will appear which 
indicates the successful activation of the license. 

Deactivating a License
To deactivate your license, select the Deactivate (trash can) icon in the About dialog. 
When the dialog displays, click Yes to deactivate or No to cancel the dialog and keep 
the license active. 

 

Note: This deactivation process only works when the computer that is running 
Lightspeed Live Stream is connected to the Internet. For offline deactivation, contact 
Telestream Customer Support (Obtaining Support | Information | Assistance).

Muting Audio Globally
When viewing Sources, you can mute the audio in the preview player. When you click 
on a different panel, such as Programs or Encoders, then come back to the Sources 
panel, the audio is turned back on again.

You can use the mute option in the Chrome browser to mute the audio for the Live 
Stream browser tab and thus disable the audio regardless of which panels you select. 
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Follow these steps to globally mute the audio for the Live Stream web application:

1. Right-click on the Lightspeed Live Stream tab to display the context menu.

2. Select Mute site in the menu.

The audio is now muted for the entire Lightspeed Live Stream application. To turn the 
audio back on, simply right-click again on the tab to open the context menu and select 
Unmute site. 

Live Stream Components, Configuration Order, 
and Media Flow

Live Stream components create the flexibility you need to stream exactly the media 
you want at the right time, to the right audience. While they provide all the options you 
need to meet these complex requirements, they also add complexity. Components 
have both a hierarchical and associative relationship with each other. Understanding 
each component—the role it plays in streaming media and its association with other 
types of components—is critical to your success in effectively building streams.

These topics can help you gain a better understanding of Live Stream:

■ Live Stream Component Relationships

■ Configuration Order for Setting Up a Live Stream

■ Media Flow Through Live Stream Components
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Live Stream Component Relationships
The diagram below illustrates the relationships and connections that Live Stream 
components have with other components. The arrows in the diagram indicate the 
items you select in each component to complete that stage of stream development.

For example, in each Variant of a Package you select the Rendition, Video Stream, and 
Audio Stream to use; in each Channel you select Packages and the source for each 
Segment. 

 

RTMP
Transport Stream
File Loop
Slate
SDI [1...4]

Sources

Programs Renditions Segments Material

Video Stream 1
Video Stream 2
Audio Stream 1
Audio Stream 2
...

Encoders
Package 1
     Variant
          Rendition
          Video Stream
          Audio Stream

Packages Channel 1
     Primary Package

Channels

Package 2
     Variant
          Rendition
          Video Stream
          Audio Stream

Program 1
Program 2
...

Rendition 1
Rendition 2
Rendition 3
...

Material 1
Material 2
Material 3
...

Segment 1
Segment 2
Segment 3
...

Segment 1
Segment 2
Segment 3
...

     Secondary Package
Segment 1
Segment 2
Segment 3
...

Sources
Sources define specific media that may be encoded and streamed. Default sources 
include the SDI streams connected to the SDI Input connectors on the Lightspeed Live 
Server back panel. You can also add slates, images, and other media files, as well as live, 
IP-based RTMP and Transport Streams from your Ethernet connection. 

When there are multiple Lightspeed Live servers, the list of Sources in the Live Stream 
web app is separated by server, and each panel can be expanded and collapsed. 

The Sources view provides a thumbnail preview of each source content, a larger 
preview of the selected source, controls to add and configure sources, and controls to 
add and configure audio and text tracks for each source. When a video signal is active 
there is a thumbnail preview for each input. If there is no active signal, color bars are 
displayed.

Source Types:
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• SDI—The default source, from the four Lightspeed Live server SDI inputs.

• File Loop—A media file, that can repeat continuously.

• Slate—A test pattern image to display when there is no signal.

• Transport Stream—From any of the four Ethernet ports of the server. 

• RTMP—From any of the server’s four Ethernet ports, connected to systems such as 
Telestream’s Wirecast product.

Multiple RTMP or Transport Stream sources can be connected to Live Stream. 
Telestream suggests limiting the number of RTMP/Transport Stream sources to eight 
until you have tested the system with more than four sources, and find performance 
adequate.

Programs
Each Program includes a specific set of Renditions. Programs that you create define the 
visual characteristics of the media that will ultimately be encoded and streamed. This 
includes the output frame resolution, captioning and de-interlacing. Programs are 
comprised of specific Renditions of media segments. You can create multiple programs 
to meet your streaming requirements.

These components must be configured for proper Program operation:

• Every Program needs at least one Rendition.

• Every Rendition needs at least one Segment.

• In Materials for a Segment, a Source Placeholder is added when you want to con-
nect an input feed to an output during later Channel configuration.

• Multiple Segments utilize Trigger Conditions to declare which Segment is to be 
encoded at any given time. 

Renditions
Renditions are the building blocks of a Program and include a set of associated 
Segments. Renditions specify the audio format (stereo, for example), audio service, and 
the language of the segments for this rendition.

Segments
A Segment is a set of media (Materials); Segments are included in a Rendition to specify 
exactly what is played out when it is activated. The Trigger Conditions determine when 
the Segment is active.

Materials
Materials are the media assets, such as graphics and video or audio materials, which 
you will ultimately play out. Materials are the building blocks of Segments. A Source 
Placeholder type of Material is required when you want to use a live source for the 
output when later configuring a Channel. 
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Trigger Conditions

Trigger Conditions in Materials help you create resilient, complex streaming, whose 
content varies by dynamic, unforeseen events or regular, planned events. For example, 
Loss of Signal might trigger a secondary input source or a static image; you might also 
trigger certain sources at a given time—an advertisement, for example.

Trigger conditions define when each Segment is active, and a Segment with no Trigger 
Conditions is always active. The priority of Segments (by stack order, top to bottom) 
and Trigger Conditions defines which segment will be streamed at any given time. The 
highest priority segment is the one that is streamed.

Triggers are only useful in a channel with multiple segments. See Setting up Trigger 
Conditions for more details. 

Encoders
Each Encoder contains one or more streams, providing specifications on how media 
will be encoded for playout, by format: AAC or AC3 audio, and AVC or HEVC video. You 
can create audio encoders and video encoders. To meet complex streaming 
requirements, you may create multiple Encoders with a wide variety of Variants in your 
packages.

Streams
A Stream is a profile for encoding video or audio. Here, you specify the codec, which 
CPU/GPU to use, plus a profile or codec settings: bitrate, frame rate, size, and so on. 
Streams you create are used later to create Variants in your Packages.

Packages
Packages specify the type of package/format to stream or deliver (such as Apple HLS, 
DASH, RTMP, Facebook Live, or YouTube Live) your media, and includes a collection of 
variants, each of which defines the Program content by Rendition, and the Streams to 
use. Create multiple packages so that you can create different Channels to meet your 
streaming requirements.

Variants
A Variant is a specific rendition of a given video and/or audio stream. It associates a 
Program's Rendition with your video/audio Encoder Streams. A Package must include 
one or more Variants. 

Channels
A Channel identifies the Program and Packages you want to play out. You create as 
many Channels as you need, to identify which Packages to use for each Channel, select 
output locations, and select an input source for each Segment. 
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When you start the Channel, the active Source is encoded to the Package Variant 
definitions and delivered to the locations you have specified. 

When a Stream is active, an updating thumbnail preview is displayed for each Variant, 
as well as statistics for the resources being used. 
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Configuration Order for Setting Up a Live Stream
The order in which Lightspeed Live Stream components should be created and 
configured is described here. This order insures that items are ready to use when 
configuring a component that uses aspects of other components.

Add and Configure Sources
1. Start by adding any Sources you want (in addition to the SDI inputs, which are 

permanent). 

2. Adjust the settings as required (see Adding and Configuring Sources).

3. One Audio Track is automatically added when you create a source. Configure audio 
settings as needed and add any optional Audio and Text Tracks.

Add and Configure Programs
1. Add a Program and configure it (see Adding and Configuring Programs). Create 

additional Programs if you need them.

2. Add a Rendition to each Program (see Managing and Configuring Renditions). Every 
Program needs at least one Rendition.

3. Add a Segment to each Rendition (see Managing and Configuring Segments). Every 
Rendition needs at least one Segment.

4. Within each Segment you add Materials (see Managing and Configuring Materials). 

5. In the Segment’s preview window you can adjust the size and location of any 
images or video assets, in order to obtain the look you want.

6. Create Trigger Conditions, if needed, that define when each Segment is active. (See 
Setting up Trigger Conditions). A Segment with no Trigger Conditions is assumed to 
always be active. 

Add and Configure Encoders
1. Add an audio encoder.

2. Next, add and configure at least one audio Stream.

3. Add the video encoder group(s) you want, then create and configure at least one 
Stream for each encoder. 

See Adding and Configuring Encoders, generally. See Adding and Configuring Streams 
for details about configuring audio and video streams.

Add and Configure Packages
1. Add the Packages you want to use, and configure them to select the Program to 

use with each one. See Adding and Configuring Packages. 

2. Add at least one Variant to each Package. In each Variant you select a Rendition and 
the audio and video Encoder to use. 
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Add and Configure Channels
1. Add at least one Channel, selecting the appropriate Packages to use for the 

Channel.

2. Select the Output Locations, adding any specific destination criteria.

3. In the Segments column, select the Input source to use for each Segment.

4. Click the Start button to activate the Stream in the selected Channel. 

See Adding and Configuring Channels. 

Media Flow Through Live Stream Components
The following diagram shows how media typically flows through the Lightspeed Live 
Stream components.

In this example there are two Renditions in the Program. The Alternate Rendition 
provides time-aligned alternate versions of content, such as an alternate angle of an 
in-car view of a race that a user can view, instead of the normal line program feed. 

The Variants in this example are part of a package with a master playlist, to provide ABR 
(Adaptive Bit Rate) content of different formats for use on various devices and 
bandwidths. The ABR package, in DASH or HLS format, allows a video player app or 
device to determine what renditions and what variants of each rendition are available 
to play.
Lightspeed Live Stream User Guide



Using the Live Stream Web Application
Managing General Settings

146 
Managing General Settings
The Settings panel is comprised of several categories of settings, as described here. 

Click the General menu icon  in the upper right corner of the window and select 
Settings to display the Settings dialog.

  

Click the tab to display its settings panel. There are more categories than are displayed 
at one time in the panel—use the arrows to step through all of them. 

If you make changes to any settings, click Save to update them.

The Settings panel has tabs for these categories:

■ Network Configuration

■ External Resources

■ Notifications

■ Thumbnails

■ Social Media Accounts

■ Audio Descriptions

■ Advanced
Lightspeed Live Stream User Guide



Using the Live Stream Web Application 
Managing General Settings

147
Network Configuration
Use this panel to specify all of the ports utilized by Live Stream.

Note: These ports are not displayed—they are automatically configured initially. To 
change port settings, services must be restarted See Stopping and Restarting 
Telestream Live Services.

18000—The port for the Authorization API for the Live Stream Service.

17000—If this is both a Capture and Stream server, 17000 shouldn't be used either; it is 
used for the Capture web API.

These values should not be used for other user-configurable ports. 

To display the Network Configuration panel, select General > Settings and click on 
Network Configuration.

  

RTMP Listener Port—The port that the RTMP service listens on (default: 1935), and 
should only be changed if this port is used by another application.

Note: If you change any of the port settings, Live Stream services must be restarted to 
use the new port number. See Stopping and Restarting Telestream Live Services. The 
affected settings are the RTMP Listener Port, App Server Port, Source WebSocket Server 
Port, and the Live WebSocket Server Port.

Live REST API Server Port—Specifies the port number of the Live Stream service. The 
default is 18000.

Source REST API Server Port—Specifies the port number of the Live Source service. 
The default is 15000.
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App Server Port—Specifies the port number of the web application server. The default 
is 8089.

Source Web Socket Server Port—Specifies the Web Socket Server port number for 
the Source manager. The default is 8084.

Live Web Socket Server Port—Specifies the Web Socket Server port number for the 
Live manager. The default is 8083.

Restrict Preview Ports Range—Enable to set a range for restricting the preview ports. 
The lower and upper range is from 1024 to 65534. 

Port Range Start—Specifies the lower threshold of ports to use for previews.

Port Range End—Specifies the upper threshold of ports to use for previews.

Note: At least two open ports need to be available in the configured range. The first 
one is used for Live Capture, even when not installed, and the next one is for Live 
Stream. 

The Port Range Start must be a lower value than the Port Range End, otherwise random 
ports are used. 

External Resources
Use this panel to identify the location where your file-based resources are stored for 
access, and provide authentication requirements.

To display the External Resources panel, select General > Settings and click on External 
Resources.

 

Lightspeed Live Stream User Guide



Using the Live Stream Web Application 
Managing General Settings

149
Resource Location—Specifies the directory where you store graphics, animations, 
video, and audio files, specified as the Materials of a Program Segment. The default 
location is D:\Stream\Materials\ on the primary Lightspeed Live Server.

You must upload the files to this location before they can be used in a stream. To 
upload these resource files, see Uploading Assets for Materials.

Note: You must restart services for a change to the Resource Location to take effect. 
See Stopping and Restarting Telestream Live Services for instructions. 

Note: When multiple Lightspeed Live servers are joined together, the Resource 
Location for Materials assets must be a UNC path. This enables all of the servers in the 
group to access the assets used for Materials. Typical UNC path:
\\hostname\d\Stream\Materials.

Resource Username—The user name required to access the resource location, if 
needed. If the resource is on a domain, the domain name should be added to the user 
name. For example, <domain>\username.

Resource Password—The password for the resource location, if required.

Notifications
Use this panel to specify when to be notified of changes in hardware resource usage 
and loss/gain of Source signal.

To display the Notifications panel, select General > Settings and click on Notifications.
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High Disk Usage Threshold—Specifies the threshold that generates a High Disk 
Usage warning. The default is 90%. 

Critical Disk Usage Threshold—Specifies the threshold that generates a Critical Disk 
Usage warning. The default is 98%. 

High CPU Usage Threshold—Specifies the threshold that generates a High CPU Usage 
warning. The maximum is 112 percent. The default is 95%. 

Critical CPU Usage Threshold—Specifies the threshold that generates a Critical CPU 
Usage warning. The maximum is 112 percent. The default is 105%. 

High GPU Usage Threshold—Specifies the threshold that generates a High GPU 
Usage warning. The default is 90%. 

Critical GPU Usage Threshold—Specifies the threshold that generates a Critical GPU 
Usage warning. The default is 98%. 

High Memory Usage Threshold—Specifies the threshold that generates a High 
Memory Usage warning. The default is 90%. 

Critical Memory Usage Threshold—Specifies the threshold that generates a Critical 
Memory Usage warning. The default is 98%. 

High Source CPU Usage Threshold—Specifies the threshold that generates a High 
Source CPU Usage warning. The default is 20%. 

Critical Source CPU Usage Threshold—Specifies the threshold that generates a 
Critical CPU Usage warning. The default is 50%. 

Loss of Signal—Enables or disables the visual notification upon loss or gain of the SDI 
Source signal, for immediate operator awareness. (This information may also 
independently be logged in the LiveSourceService log file.) When this setting is 
changed, you must restart the services for this change to take effect. 

Thumbnails
Use this panel to specify enable or disable thumbnail generation for active channels, 
and specify where to store the thumbnails, and configure it.
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To display the Thumbnail panel, select General > Settings and click on Thumbnails.

 

Thumbnail Frame Interval—The number of frames between each thumbnail refresh. 
Default: 25.

Enable Thumbnail Generation—Enables or disables the generation of thumbnails for 
active Channels.

Directory—Specifies the location for generated thumbnails. The default location is 
D:\Stream\Thumbnails\ on the primary server. Sub-folders are automatically created 
using the Channel name and Variant name. Do not supply a UNC path. 

Limit—Sets the maximum number of thumbnails to keep in the specified directory. 
The default is 25 and the available range is 5 to 250.

Publishing Point—Enables or disables publication of the thumbnails to a Web server 
location, so that they can be viewed in a browser. When enabled, enter a URL that 
specifies the storage location.

Custom Width and Height—When enabled, allows you to set a custom width and 
height of the thumbnails in pixels. Both must be enabled for settings to take effect. The 
default width is 128 and the default height is 96. The width range is 128 to 4096 and the 
height range is 96 to 2160 pixels. 
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Social Media Accounts
Use this panel to authenticate your social media accounts in Live Stream for each 
platform that you plan to use for streaming. Each account record maintains 
authentication data for accessing the platform. These accounts are used when you 
configure channels for streaming to these platforms. When you add a social media 
platform package to a channel, you can specify the account that you want to use. 

To display the Social Media Accounts panel, select General > Settings and click on 
Social Media Accounts.

 

Operations

Add—Click the + icon and use your authentication code to register with the social 
media platform. Proceed to the topic for your platform, below.

Refresh—Click the Refresh icon if you need to re-authenticate your tokens. Each 
platform authorizes tokens for a different length of time, before you need to re-
authorize and obtain a new token. You can manually revoke the token/authentication 
directly in the platform. When you revoke a token, Live Stream indicates that you need 
to re-authenticate (the refresh symbol is enabled) and then you can re-authenticate the 
account in the same manner you added it.

Delete—Click the Trash icon to delete the social media account record from Live 
Stream. If the social media account is in use in a Channel it can not be deleted. You 
must remove references in all Channels (active or not) before you can remove a social 
media account record that is used in a Stream.

Supported social media platforms include:

■ Facebook Live

■ YouTube Live
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Facebook Live
To authenticate your account with Facebook Live in Live Stream, follow these steps:

1. Add a new Facebook Live Social Media account—click the + sign (on the right) and 
select Facebook Live. 

2. An authentication code is generated and displayed. 

3. Select the Authentication Code and copy it for use later.

4. Click Register Authentication Code to connect to Facebook. 

5. When Facebook displays in your browser, log in if you aren’t already logged in. (You 
can create a new account if you don’t have one. Then continue.)

Facebook displays this Enter the Code panel:

6. Paste the authentication code into the field and click Continue.

7. Click Continue as <User> on the first notification panel.

8. Click OK (or edit your settings) on the second notification panel.

9. Click OK (or edit your settings) on the third notification panel.

10. A Success message displays when the connection succeeds:

11. Return to Live Stream and click Save in the Register with Facebook Live dialog.
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Note: When you authenticate your account in Live Stream, this account is available in 
the Configure Channel dialog User Name control when you create a Channel for 
Facebook Live.

YouTube Live
To authenticate your account with YouTube in Live Stream, follow these steps:

1. Add a new YouTube Live Social Media account—click the + sign (on the right) and 
select YouTube Live. 

2. Live Stream displays the authentication code dialog:

 

3. Click Generate Authentication Code to connect to YouTube, where a code will be 
generated. 

4. When YouTube displays in your browser, log in if you aren’t already logged in. (You 
can create a new account if you don’t have one. Then continue.)

YouTube displays the Sign In panel with the code:

5. Copy the authentication code.
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6. Return to Live Stream and paste the code into the Authentication Code field:

7. Click Save in the Register with YouTube Live dialog.

Note: When you authenticate your account in Live Stream, this account is available 
under User Name in the Configure Channel dialog when you create a Channel for 
YouTube Live.
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Audio Descriptions
Use this panel to create and edit descriptions that you can use to identify different 
types of audio sources or usage. These descriptions appear in the Audio Tracks 
configuration dialog in the Sources panel and in the Configure Rendition dialog in the 
Programs panel. For example, you could create an audio descriptor that simply 
references audio as Source1, Source2, Source3, and so on—so that it’s easier to select 
the audio input track that you want to use.

To display the Audio Descriptions panel, select General > Settings and click on Audio 
Descriptions. Click the + sign to add a new description. 

 

Operations

Edit—Click the Pencil icon to edit an existing audio description.

Duplicate—Click Duplicate icon to duplicate this audio description, making changes 
as appropriate.

Delete—Click the Trash icon to delete the audio description from Live Stream. Audio 
descriptions can only be deleted when the Source(s) they are assign to are not in use.
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Advanced
Use the Advanced panel to enable and disable various features in Live Stream. To 
display the Advanced panel, select General > Settings, scroll to the right and click on 
Advanced.

 

Advanced Mode—Enables/disables additional real-time feedback including SDI video 
format changes, and enables additional settings in some dialogs throughout the Web 
app.

Enable Channel Restart—When enabled, active channels always restart if streaming is 
interrupted. When disabled, the restart feature is immediately turned off for active 
channels.

Time Window for Allowing 10 Restarts—Specifies the amount of time in which, if 10 
channel restarts occur, the channel shuts down. The default is 10 minutes. 

Show Encoder Stream Presets—Enables/disables lists of presets to select from, when 
creating new Encoder streams. 

Require API Tokens—When enabled, API tokens are required to access and utilize 
Lightspeed Live Stream via the API in a custom program. When disabled, API tokens are 
not required to use Lightspeed Live Stream via the API. Generally, you should 
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determine if you do or do not require API token usage, and design the program 
accordingly.

When Require API Tokens is enabled, Administrator and API users can view their 
unique and permanent API token in the General > About panel:

API tokens are generated for two types of users: Administrators and API users. 
Administrator and API users both have complete access to the API. In the context of 
API utilization, there is no distinction—you could either use a token from an API 
user or an Administrator user.

The token does not display entirely in the column. You can triple-click the token 
and copy it and then paste it into your program or some other file for delivery to a 
programmer, for example.

Exporting and Importing Configurations
The Live Stream configuration settings for Sources, Programs, Encoders, Packages, 
Channels, and General Settings can all be exported or imported as a single XML file. 
When you import configuration settings they are added to your existing settings, so 
your existing settings are retained. 

Note: When importing settings, SDI sources will have an additional audio track added 
to the original one. 

The XML configuration settings file is exported to the folder that you have set in your 
web browser for downloads, or a Save As dialog may appear if you have your browser 
set for that option. The default file name is export.xml. If a file of the same name already 
exists from a previous export, an incremental number is added starting with 
export(1).xml. 
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To perform an export or import of the configuration settings click the General Settings 
icon  in the upper right of the interface and select Export Configuration or Import 
Configuration from the menu.

To import a configuration, click the folder icon in the Import Configuration dialog, as 
shown in the following image, to browse and select the file to import. 

Using Live Captioning Input via IP
Lightspeed Live Stream supports a 1200 baud TCP live captioning stenographer input 
over IP (IPv4), with parameters similar to those used with typical caption encoders, such 
as the Evertz HD9084.

Accessing the Captioning Preview
A preview is available of an active Channel, which a stenographer can view to create 
the live caption input. This preview is synchronized to the source input timing, and 
occurs before the time delay set in the Channel Delay option.

To preview an active Channel, click the Closed Captioning icon  in the upper right 
to access a URL to view the stream preview. In the dialog, click the clipboard icon to 
copy the URL or click the arrow icon to open the link in a new browser window. 
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Channel Time Delay and IP Port Settings
The Channel Delay option, which is available in the Channel Configuration dialog, 
applies a delay, in seconds, to the program output before encoding. This delay occurs 
after the Captioning Preview in order to provide the time needed to create and add the 
captions to the input feed. 

The IP Port used for the captioning input is set in the Channel Configuration dialog. The 
Port setting must be enabled to activate the live captioning input feature. 

See Channel Configuration to set the Captioning IP Port number and Channel Delay.

Frame Rates for Live Captioning
The following frame rates are supported for the live captioning input and the output 
that contains the captions:

• 23.976, 24, 29.970, 30, 59.94, and 60 fps

The frame rates of 25 and 50 fps are not supported.

Using CaptionMaker for Live Caption Input
The Telestream CaptionMaker application can be used as a source for live caption input 
into Lightspeed Live Stream. For detailed instructions, see the Sending Live Captions to a 
Telestream Lightspeed Live Stream Server topic in the CaptionMaker User Guide.

Lightspeed Live Server CPU/GPU Usage Guidelines
A Lightspeed Live server contains dual multi-core CPUs, a single GPU, and 64GB (or 
more) of RAM that are used to ingest, process, encode, and stream multiple channels of 
live real-time content. Each channel can contain multiple encoded variants with up to 
16 channels of audio.

Note: When Live Capture and Live Stream are being used on the same server, also 
review the Lightspeed Live Capture Resource Calculator topic in the Lightspeed Live 
Capture User Guide, to determine how Capture and Stream can best share a Lightspeed 
Live server’s resources.

Care must be taken not to exceed the limits of the Lightspeed Live server's available 
resources. The factors that consume the Lightspeed Live server's resources are 
described in the following topics.

Video Encoders
The following video compressor and processor options are available in the Lightspeed 
Live Stream encoders.
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Video Compressors
There are two video compression types that you can select, AVC (Advanced Video 
Coding) and HEVC (High Efficiency Video Coding). 

AVC
• x264—H.264 encoding using an x264 compression library. This compressor uses 

CPU resources only.

• Lightspeed GPU—H.264 encoding using the on-board GPU to accelerate the com-
pression process. This compressor primarily uses GPU resources and very little CPU 
resources.

• PERSEUS Plus—Enables a significant bitrate reduction without sacrificing quality. 
PERSEUS Plus decoder software is required to display this optimized video. Contact 
Telestream support for further information. 

HEVC
• x265—HEVC/H. 265 encoding using CPU resources only.

• Lightspeed GPU—GPU accelerated H.265 encoding using less CPU.

• Lightspeed HW—HEVC hardware compression. Uses only the (optional) HEVC 
video card hardware resources. 

Video Processor 
You can process the incoming video signal using the CPU (by default) or the use the 
GPU to accelerate processing.

• Default—All video processing is performed on the CPU. The default video proces-
sor creates high quality video and consumes only CPU resources. 

• Lightspeed—Video processing is accelerated on the GPU, using very little CPU 
resources. In general, the Lightspeed video processor creates a high quality picture 
at the expense of using a greater amount of GPU resources.

• Tachyon Live—Video processing is accelerated on the RTX-A4000 GPU, which is 
required. Tachyon Live provides a true, faster than real time and fully motion-com-
pensated processing option for live streams running through Microsoft Azure.

Note: You should only stream one channel using the Tachyon Live video processor at 
a time. Live Stream reports a Channel Health Warning message, advising that the 
HEVC Tachyon queue is full, when you attempt to run two channels using Tachyon 
Live. Streaming may fail when streaming 2 or more Tachyon Live streams 
simultaneously.

Image Overlay
You can apply a Video Overlay Asset or Image Asset (see Managing and Configuring 
Materials in Configuring Programs) as an overlay onto your main video image. Overlays 
can consume considerable GPU and/or CPU resources. Use caution when applying 
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overlays, and restrict the total combined image area for overlays applied within active 
Channels to 1920x1080.

How Settings Affect Resources
Here are some signal processing parameters to keep in mind that affect overall 
resources:

• Encoded Frame Size—The larger the frame size the more resources are consumed.

• Encoded Frame Rate—The higher the frame rate the more resources are con-
sumed.

• Encoded Bit Rate—The higher the bit rate the more resources are consumed.

Create Package Variants that have Efficient Resource Usage
Every channel has one or more Variants, which are created in the Packages panel. For 
each Variant you choose a Video Stream, which contains the video compressor and 
video processing you selected in the Encoder panel for that Stream. 

In order to maximize quality, while minimizing resources, you can create a combination 
of Variants using compressors and video processor selections that result in your 
required outputs while limiting the total resources used.

The recommended maximum resources that should be consumed for all active 
Channels and Machines is:

• 70% for CPU Usage while streaming.

• 85% for GPU Usage while streaming.

The percent of CPU Usage and GPU usage is provided in the Output Information panel 
when Channels are actively streaming. The Channel panel provides information for the 
currently selected Channel that is active. The Machine panel provides usage 
information for all Lightspeed Live Servers currently operating in the system. 

Live Stream Source Formats
These formats are supported in Lightspeed Live Stream for SDI and IP sources:
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SDI Source Formats
• 4 HD inputs, up to 1080p and 50/60fps 

or 1 UHD/4k input, up to 2160p and 50/60fps

• AES Embedded Audio, up to 16 channels

IP Source Formats
• MPEG-2 Transport Stream (SPTS, MPTS)

• MPEG-2 and AVC (H.264) Video

• SMPTE 302M, MPEG Layer2, AAC, AC-3, EAC3 Audio

• RTMP TCP protocol support for source input, including Wirecast RTMP input

Content File Sources
The following formats are supported for file sources:

• Stills and Slate—TIFF, PNG, JPEG, GIF, Animated GIF, and BMP

• Logos with Alpha—TIFF, PNG, GIF, and BMP

• Animations with Alpha—ProRes and Animation Lossless MOV 

• Local Movie Clips—ProRes/MOV, MP4, MPEG-2, and MXF

• Audio—AIFF, WAV, MP3

• Playlists—SMIL (.smil)

Warnings and Error Messages
This topic describes some of the warning and error messages that may display from 
time to time.

Warnings for Full Queue and Dropping Frames
When a Channel in Live Stream is actively producing output, a warning message is 
displayed when full queue or dropped frame conditions reach certain parameters. The 
message provides some information about the source of the error and a time-stamp of 
when the error occurred. The message will continue to be displayed until closed by the 
user. A warning icon  is also displayed in the Channels panel on the Package 
thumbnail and Packages tab of the Channel that triggered the warning. 
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Full Queue Messages
A Full Queue warning is displayed when any queue in the internal processing chain 
reaches the 100% full state. A queue holds up to 10 seconds of samples (frames), so for 
a 30 fps stream, a queue will hold 300 samples. 

If a component is able to catch up and reduce it’s input queue below 50% (5 seconds), 
an Input Queue < 50% message is displayed, which indicates a return to normal 
operation.

Once Full Queue warning is displayed, no additional messages are displayed for that 
queue until it falls below 50%. So, if it drops to 80% and then goes back up to 100%, 
that does not trigger another Full Queue message.

The full queue behavior can also be affected by a shortage of CPU and GPU resources, 
which typically occurs when several channels are being streamed with multiple 
variants. Any Full Queue messages could be interpreted as a suggestion to stop one of 
the channels and allow the remaining queues to recover. Subsequent messages about 
Input Queue < 50% are an indication of recovery.

Dropping Frames Messages
Frames are dropped if the compressor falls behind real-time processing. The Dropping 
Frames warning displays when the video compressor can’t compress the frames fast 
enough to keep its input queue from filling up. The frames are dropped from the 
streaming output, but the duration of subsequent frames is extended to compensate 
for the dropped frame(s), so the audio and video will stay in sync on the output.

The Dropping Frames message displays when the compressor queue is over 10% full. 
Subsequent messages stating that the stream is no longer dropping frames indicates a 
return to normal operation.
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■ Adding and Configuring Sources

■ Adding and Configuring Programs

■ Adding and Configuring Encoders

■ Adding and Configuring Packages

■ Adding and Configuring Channels
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Using Live Stream 
Components

This chapter describes how to create, configure and manage each Live Stream 
component—the building blocks of a streaming workflow. 

Sources, Programs, Encoders, Packages, and Channels are the primary components. All 
primary components except Sources also have sub-components.

Note: To learn about each component and its relationship with the other 
components, see Live Stream Components, Configuration Order, and Media Flow.

Topics
■ Adding and Configuring Sources

■ Adding and Configuring Programs

■ Adding and Configuring Encoders

■ Adding and Configuring Packages

■ Adding and Configuring Channels
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Adding and Configuring Sources
Default sources include the 3G or 12G SDI streams connected to the SDI connectors on 
the back panel of the Lightspeed Live Server. You can also add slates, images, and other 
media files, as well as live, IP-based RTMP and Transport Streams from your Ethernet 
connection.

SDI sources display the current input or color bars if there is no input. You can combine 
four 3G SDI inputs to create a single UHD input. You can edit SDI sources but not delete 
them. They update when you change the SDI source. For supported formats see SDI 
Source Video Formats.

When there are multiple Lightspeed Live servers, the list of Sources in the Live Stream 
web app is separated into a panel for each server, and you can expand/collapse each 
panel. 

■ Sources Panel Overview

■ Configuring Sources 

Note: You can not edit Sources while they are used by an active Channel.
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Sources Panel Overview
The Sources panel displays when you click on Sources in the Component menu. The 
Sources panel is organized into two panels: The left panel is the Sources list, which 
displays the SDI sources, plus sources you’ve created. The right panel displays a live 
feed of the selected source, along with track information.

Press ? on your keyboard to display the hot key menu for this component.

Source Information & 
Statistics

Audio Level Meters 
and Mute Controls

Sources Panel Source Toolbar

Audio and Text 
Track Panels

Source Preview Panel

• Sources Panel—Displays all source thumbnails, and allows you to select a source 
to view or edit. See Source and Channel Indicator Icons.

• Add Source—Click the + icon in the Sources panel to add a new File Loop, Slate, 
Transport Stream, or RTMP source. The SDI sources are automatically defined. 

• Source Toolbar—Top-right, above the Sources Preview Panel.

– Editor Icon—Click the pencil icon  to view or update the settings of the 
selected Source. Source configuration panels vary by type.

– Delete Icon—Click the trash icon  to delete the selected Source.

– Source Statistics—Click the Source Statistics icon  to open a dialog that 
provides statistics of the Source. 

– Audio Track Selector—Use the Audio menu to the right of the toolbar to select 
which audio track to play in the preview player. 
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• Source Preview Panel—Displays the currently selected Source and audio meters.

• Source Information Panel—Displays details about the selected source video.

• Audio and Text Track Panels—Add, delete, and configure audio and captioning 
text tracks. 

• Audio Level Meters and Mute Controls—Audio level meters for each channel 
that adjust automatically, based on the track (stereo, 5.1 Surround Sound, etc.), with 
channel-by-channel mute control. If you have multiple audio tracks, you can switch 
among them, using the Audio Track menu. 

Source and Channel Indicator Icons
Icons in the upper-right of the thumbnail previews for each source in the Sources panel 
indicate the type of source and whether that source is being used in a live stream, or if 
there is a loss of signal.

 

The following icons are provided in the Sources and Channels panels to indicate the 
type of source or a current state:

        SDI source

        File Loop source

        Slate source

        Transport Stream source

        RTMP source

        This source is currently being used in a stream and cannot be 
edited or removed
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Configuring Sources 
All source management and configuration should be performed from the Source 
Manager web app panel. For complete details of accessing and configuring sources, see 
Creating, Configuring, and Managing Sources. 

Adding and Configuring Programs
You create and configure programs to specify frame resolution, captioning and de-
interlacing, and so on. You can create multiple programs to meet your streaming 
requirements. You can create one or more Renditions in each Program. 

■ Programs Panels Overview

■ Configuring Programs

Programs Panels Overview
The Programs panel displays when you click on Programs in the Component menu. The 
Programs panel is organized into two panels: The left panel is the Programs list, which 
displays all of the Programs you’ve created. The right panel displays segments in the 
selected Program.

Press ? on your keyboard to display the hot key menu for this component.

        This source has experienced a loss of signal

        Indicates that an active source needs to be selected for the 
Segment, when configuring Channels components

Indicates that an activation schedule exists on that Channel 
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Click to add a new ProgramPrograms Panel
Programs ToolbarPrograms Menu Segments Panel

In the Program panel you can add and edit Programs, Renditions (Managing and 
Configuring Renditions), Segments (Managing and Configuring Segments), and Materials 
(Managing and Configuring Materials). 

You set the name and select the resolution for each Program you want to create. Within 
a Program you add Renditions and specify their settings, add Segments to a Rendition, 
add Materials to each Segment, and then (in each Segment) specify the Trigger 
Conditions that define when each Segment is active.

These components must be configured for proper Program operation:

• Every Program requires at least one Rendition.

• Every Rendition requires at least one Segment.

• Every Segment requires a Source Placeholder Material when you want to connect 
an input feed to an output in a Channel. If a Program is only used to provide a Seg-
ment with an Image Asset or Video Base or Video Overlay Asset, a Source Place-
holder is not needed. 

• Multiple Segments require Trigger Conditions to declare which Segment is to be 
encoded at any given time. 

A single Rendition and a single Segment can be used when you are only encoding a 
source. 

Multiple Segments are typically used for ad insertion, local blackouts, and trouble 
messages (such as, Experiencing technical difficulties). Multiple Renditions, for example, 
can be used for multi-language delivery (different graphics and/or audio), different 
cameras, or feeds from a live event.

Click the + icon to add a Program and click the More icon to edit or delete the selected 
Program.

The Programs panel provides these features:

• Programs Panel—Displays all of your programs. Open them to display their rendi-
tions and segments. Select a program to view or edit it.
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• Add Program—Click the + icon in the Programs panel to add a new Standard or 
Custom program. 

A Standard program is pre-built (including one Rendition, Segment, and Materials 
component) for quick-start: it creates a 1920 x 1080 program with one video rendi-
tion and stereo audio rendition, and a single segment with source placeholder 
material. You can edit it to suit your requirements. 

A Custom program is empty: you must add and configure all components.

• Programs Menu  —to the right of each program.

– Edit Program—Click the pencil icon to configure or update settings of the 
selected program. Configuration panels vary by type.

– Copy Program—Click the Duplicate icon to duplicate the selected Program, 
when it is similar to the new one you want to create.

– Delete Program—Click the trash icon to delete the Program.
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Configuring Programs
Use the Edit Program dialog to configure a new Program or update an existing one. 

• Name (required)—Specifies the name of the Program.

• Program Resolution—Specifies the resolution to use for the Program. Default: 
1920 x 1080. 

• Compositing Bypass—Enable to bypass compositing. Saves time when the pro-
gram is very simple, such a pass-through with no added graphics or audio remap-
ping. Only available when Advanced mode is enabled. 

Note: The Low Latency option in Encoders must also be enabled when Compositing 
Bypass is enabled.

• Caption Burn-in—Enable this option to burn in 708 captions if they are present in 
the source. AVC/HEVC is supported. If you are using overlays and the overlay is 
placed in the same region where the captions are rendered, the overlay will 
obscure the captions.
608/708 captions in the source (if any) are always passed through for playing by the 
player. Only 708 captions are used for burn-in captions. All output frame rates are 
supported. Supported input frame rates for captions are 23.976, 24, 25, 29.970, 30, 
59.94, and 60.

• Deinterlacer—Enable this option and select a de-interlacer to improve the quality 
of the output. The Motion Adaptive de-interlacer internally doubles the frame rate. 
The Motion Adaptive de-interlacer enables output at higher frame rates to have all 
unique frames instead of doubling frames. Without Motion Adaptive de-interlac-
ing, some or all frames are used twice (depending on the new rate) to achieve 
higher frame rates (for example, when 29.970 is up-converted to 59.94). 
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Managing and Configuring Renditions
You create Renditions to add media to a program. When you create a program, one 
Rendition is added automatically—you can add others as required. 

Renditions contain Segments—the media—that comprises the rendition. Renditions 
specify the audio format (stereo, for example), audio service, and the language of the 
segments in the rendition.

To add a rendition to the selected program, click the + icon and select either Video and 
Audio, Audio Only, or Video Only.

Components Panel

Click the + icon to add a 
new Rendition to this 
Program.

Programs Panel

When you want to use a specific Audio Track channel assignment from Sources, you 
should select the exact same settings for Channel Configuration, Audio Service, and 
Language in the rendition. When all of these settings match, the Channel Assignments 
specified in the Sources Audio Track is used for the Mono, Stereo, or 5.1 output. 

Note: The final output channel type of Mono, Stereo, or 5.1 is determined by the 
audio encoder AAC or AC3 Channel Layout setting. 

• Renditions Menu  —at the right of the Rendition title bar.

– Edit Rendition—Click the pencil icon to configure the selected Rendition. See 
Configuring a Rendition.

– Copy Rendition—Click the Copy icon to duplicate the selected Rendition, when 
it is similar to the new one you want to create.

– Remove Rendition—Click the trash icon to delete the Rendition.
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Configuring a Rendition
Use the Configure Rendition dialog to configure a rendition. Options vary for Video, 
Audio, Audio Only, or Video Only:

• Name (required)—Specifies the name of the Rendition.

• Audio Tracks—Click the + icon to add audio tracks. 

• Channel Configuration—Specifies the audio configuration to use: Mono | Stereo | 
5.1 Surround Sound. 

• Audio Service—Specifies the audio service label to use in Live Stream: Primary | 
Secondary | Commentary | Music. 

• Language—Specifies the language to use for the audio track. For multi-language 
output, select a different language for each channel. 

• Description—Select the description for the Audio Track. The descriptions are cre-
ated and edited in the Settings dialog > Audio Descriptions tab. See Audio Descrip-
tions. 

Creating Multiple Audio Track Output

The audio tracks added to a Rendition can all be included in the output, thus creating 
multiple audio track output. To create multiple audio track output, you must first create 
the additional tracks in the Sources panel. Then, any audio track you add in Renditions 
must have the exact same settings for Channel Configuration, Audio Service, and 
Language as the track in the Sources panel. If the settings don’t match, the output uses 
the first audio track from the input.
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Late Binding Audio for Multiple Languages

To generate a package with a single video rendition and multiple audio languages 
(generally user/player selected), use a single rendition with multiple language tracks to 
generate what is sometimes called a "late binding" output. This is useful for efficient 
delivery of multi-language packages since the same video need not be combined with 
each audio language to be delivered. 

Managing and Configuring Segments
You create Segment to identify a set of media (Materials) and the Trigger Conditions 
that determine when the Segment is active. Segments are included in Renditions. (See 
Managing and Configuring Materials). 

Click the + icon in a Rendition to add a Segment. Then select a Segment to add 
Materials to it. If you have multiple Segments, you can add Trigger Conditions to specify 
which Segment is to be encoded at any given time.

Note: When you add a program, it is automatically completed with one Segment, 
Rendition, and Material Source Placeholder. When a Source Placeholder is in a 
Segment, you can’t add a Source Placeholder, Source Playlist, or Video Base Asset. You 
must first delete the Source Placeholder to replace it with another type of video 
material.

Components Panel Programs Panel

Click the + icon 
to add a new 
Segment to this 
Rendition.
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The Segments panel displays when you click on Programs in the Component menu.

Segments Toolbar—at the right of the Segment title bar.

– Edit Segment—Click the pencil icon to edit the selected Segment’s name.

– Delete Segment—Click the trash icon to delete the Segment.

– Manage Triggers—Click the calendar icon to manage this Segment’s start and 
end conditions. See Setting up Trigger Conditions.
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Managing and Configuring Materials
You create Materials to add to Segments. A Source Placeholder type of Material is used 
when you want to use a live source for the output when later configuring a Channel. 

Click the + icon in the Materials list of a Segment to display its Configure Material dialog 
and add Materials and select the material type. 

Components Panel Programs Panel

Click the + icon to add 
Material to this Segment.

Note: For each segment: You can add a maximum of five Materials assets. One of each 
of these may be added: Source Placeholder | Source Playlist | Video Base Asset. 
Several Video Overlay Assets | Image Assets may be added, up to the total allowed.

Many assets specify media files stored in a folder on the server. These files must be 
manually loaded into the Asset Location folder before you can use them. The Location 
Folder path is specified in External Resources. You can visually re-size and arrange the 
assets on the screen, as well.

Note: When you are running joined servers that have the same location for materials, 
if a materials file on each server has the same name, but the image is actually different, 
you could end up with the wrong image in your output. It is best to name files 
differently if their images are different. 

■ Configuring Materials

■ Uploading Assets for Materials

■ Adjusting and Editing Materials

Materials Toolbar

At the right of each Material.

– Edit Material—Click the pencil icon to configure the selected Material. See 
Configuring Materials.

– Duplicate Material—Click the Duplicate icon to duplicate the selected Material, 
when it is similar to the new one you want to create.

– Delete Material—Click the trash icon to delete the Material.
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Configuring Materials
Use the Configure Material dialog to configure a Material you are adding. Options vary 
by type of Material:

■ Configuring Source Placeholders

■ Configuring Source Playlists

■ Configuring Video Overlay Assets

■ Configuring Image Assets

Configuring Source Placeholders

Adds a gray-bar Source Placeholder (one allowed per Segment), which is used in the 
Channel panel to enable selection of an input source. 

Note: When a Source Placeholder is in a Segment, you can’t add another Source 
Placeholder, Source Playlist, or Video Base Asset. You must first delete the Source 
Placeholder to replace it with another type of video material.

A Source Placeholder enables you to select a live input source in Channels for that 
Segment. The specific Source that populates the placeholder is selected during 
Channel configuration to allow Program configurations to be made once and used 
repeatedly for multiple sources, when appropriate.

When a Program is only used to provide an image or video file that you have placed in a 
Segment and doesn’t use a live source input, a Source Placeholder isn’t needed. For 
example, you could create a Segment whose only purpose is to present an image or 
video asset upon Loss of Signal (LOS). 

 

• Name—Specifies the name of the source.

• Left—The offset from the left of the screen, in pixels.

• Width—The display width, in pixels.

• Top—The offset from the top of the screen, in pixels.

• Height—The display height, in pixels.
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• Lock in Visual Editor—Enable this to lock the material in the Visual Editor so that it 
cannot be resized or moved. Disable it to allow manual resizing or arrangement. 
When enabled, the cursor changes to a not-allowed version. If you edit the source 
material in another program it can still be resized or changed there. 

Configuring Source Playlists

You can use a Source Playlist when the media for this segment is comprised of multiple 
video files that you want treated as a single video file.

In a <par>-based playlist, the video files in the playlist are treated as a single segment of 
media; each file is played out in sequence when the Segment is triggered.

You can also group video files in a <seq> element instead of a <par> element, so that 
each time the playlist is streamed, a different sequence (starting at the top) is played. In 
this type of playlist, the current sequence plays until an EOM trigger occurs on the 
playlist Segment and then the Channel switches back to the higher priority Segment. 
On the next trigger, the next sequence in the playlist is streamed.

If Play Once is set with EOM, then all files in the sequence are played once. If Loop is set, 
all of the sequences are played. The next time the Playlist segment is triggered, the first 
sequence in the playlist is played.

In addition to specifying files that play in their entirety, you can clip any file by adding 
<begin> and <dur> elements.

See the Media requirements and examples following.

Note: When a Source Playlist is in a Segment, you can’t add a Source Placeholder, 
Source Playlist, or Video Base Asset. You must first delete the Source Playlist to replace 
it with another type of video material.

 

• Name—Specifies the name of the source.
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• Playback—Specifies Play Once or Loop.

• Left—The offset from the left of the screen, in pixels.

• Width—The display width, in pixels.

• Top—The offset from the top of the screen, in pixels.

• Height—The display height, in pixels.

• Lock in Visual Editor—Enable this to lock the material in the Visual Editor so that 
you cannot manually resize or re-arrange the material on the screen. Disable it to 
allow resizing or moving. When enabled, the cursor changes to a not-allowed ver-
sion. If you edit the source material in another program it can still be resized or 
changed there. 

• Resource—Click Browse to select the file to use for this Material. The Asset Loca-
tion location is specified in the External Resources dialog. 

Playlist and Media Requirements

When using playlists, the following applies:

• All sources in the playlist must have matching frame rates, resolution size, and for-
mat type. For example, you can’t include both H.264 and MPEG-2.

•  The <head> element that is commonly present must not be included or it must be 
commented out. You can also comment out any video file that you don’t want to 
play.

• When using the same triggered playlist multiple times in a stream, there should be 
a minimum of 15 seconds between the start triggers. If there is less than 15 seconds 
between start triggers the playlist does not restart from the beginning and will 
instead continue from the point where it was stopped.

This is especially important when using the Play Once option in the Configure 
Material dialog, because if triggered too soon, the playlist does not have time to 
restart and there will only be black frames in the output (assuming that the playlist 
played to completion the last time it was triggered). 

Single Media Playlist Example

In this playlist, each video file is defined in a <video> element (one permitted), which is 
in a <par> element. Multiple <par> elements are permitted. All of the video in the 
playlist is treated as a single file, when it is in fact comprised of several files.

When the Segment is triggered, all media files are played in sequence, beginning at the 
top of the list. When stopped and triggered again, play begins where it stopped 
previously.

Loop | Play Once options apply.
<?xml version="1.0" encoding="utf-8"?>
<smil xmlns="http://www.w3.org/TR/REC-smil">
<body>
<par>
<video src="\\MediaSvr\SMIL_Playlists\TotalRecall.mov"/>

</par>
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<par>
<video src="\\MediaSvr\SMIL_Playlists\Elysium.mov"/>

</par>
<par>
<video src="\\MediaSvr\SMIL_Playlists\MenInBlack.mov"/>

</par>
</body>

</smil>

Multiple Media Playlist Example

In this playlist, each video file is defined in a <video> element (multiple permitted), 
which is in a <seq> element. Unlike the <par>-based playlist, the video files in each 
sequence are treated as a single file, and you can have multiple, independent 
sequences in the playlist; each treated independently.

When the Segment is triggered, all media files are played in sequence, beginning at the 
top of the list, until an EOM trigger stops the stream, in which case play stops when the 
last <video> in a <seq> completes. When triggered again, play begins where it stopped 
previously, with the video in the next <seq>. 

Loop | Play Once options apply.
<?xml version="1.0" encoding="utf-8"?>
<smil xmlns="http://www.w3.org/TR/REC-smil">
<body>
<seq>
<video src="\\MediaSvr\SMIL_Playlists\Acme_1.mov"/>
<video src="\\MediaSvr\SMIL_Playlists\Acme_2.mov"/>
<video src="\\MediaSvr\SMIL_Playlists\Acme_3.mov"/>

</seq>
<seq>
<video src="\\MediaSvr\SMIL_Playlists\BobsCars.mov"/>

</seq>
<seq>
<video src="\\MediaSvr\SMIL_Playlists\Diner_1.mov"/>
<video src="\\MediaSvr\SMIL_Playlists\Diner_2.mov"/>
<video src="\\MediaSvr\SMIL_Playlists\Diner_3.mov"/>

</seq>
</body>

</smil>

Playlist with Start and Stop Times Example

In this playlist, video files are specified in a <seq> element, with one or more <video> 
element. Multiple <seq> elements are permitted. All of the video in the playlist is 
treated as a single file, when it is in fact comprised of individual clips in (potentially) 
several files.

When the Segment is triggered, all clips in each media file are played in sequence, 
beginning at the top of the list. When stopped and triggered again, play begins where 
it stopped previously.

Loop | Play Once options apply.
<?xml version="1.0" encoding="utf-8"?>
<smil xmlns="http://www.w3.org/TR/REC-smil">
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<body>
<seq>
<video src="D:\Prairie-Flt.mov" begin="10s" dur="30s"/>
<video src="D:\Prairie-Flt.mov" begin="40s" dur="30s"/>

</seq>
<seq>
<video src="D:\Dirt_Runways.mov" begin="30s" dur="30s"/>
<video src="D:\Dirt_Runways_mov" begin="70s" dur="30s"/>

</seq>
<seq>
<video src="D:\Sq_Butte_Buzz.mov" begin="5s" dur="30s"/>
<video src="D:\Sq_Butte_Buzz.mov" begin="40s" dur="30s"/>

</seq>
</body>

</smil>

Configuring Video Base Assets
Add one Video Base Asset (multiple Video Base Assets are not permitted) to play out 
both video and audio (which must be stereo) in the segment. The video file must be in 
a MOV | MPG | MP4 | MXF container. The video asset should either match the rendition 
audio language/configuration or existing channels will be mixed down into the 
rendition audio.

Note: When a Source Placeholder is in a Segment, you can’t add a Source Placeholder, 
Source Playlist, or Video Base Asset. You must first delete the Source Placeholder to 
replace it with another type of video material.

 

• Name (required)—Specifies the name of the source.

• Playback (required)—Specifies Play Once | Loop.

• Left (required)—Specifies the offset from the left of the screen, in pixels.
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• Width (required)—Specifies the display width, in pixels.

• Top (required)—Specifies the offset from the top of the screen, in pixels.

• Height (required)—Specifies the display height, in pixels.

• Lock in Visual Editor—Enable to lock the material in the Visual Editor so that it 
cannot be resized or moved. Disable it to allow resizing or moving. When enabled, 
the cursor changes to a not-allowed version. If you edit the source material in 
another program it can still be resized or changed there. 

• Resource—Click Browse to select the file to use for this Material. The Asset Loca-
tion location is specified in the External Resources dialog. 

Configuring Video Overlay Assets
Add one or more Video Overlay Assets to use in the Segment. Audio may be included 
with the video, but it will not be heard or used in any way.

You can apply a Video Overlay Asset or Image Asset as an overlay on your main video. 
Overlays can consume considerable GPU and/or CPU resources. Use caution when 
applying overlays, and restrict the total combined image area for overlays applied 
within active Channels to 1920x1080.

It is a better fit when the images and video clips match the source resolution and 
program size. When they don’t match, the images may be improperly scaled and will 
require significant adjustment. The appearance could also be unacceptable if the 
image or video resolution is lower than the source. 

 

• Name (required)—Specifies the name of the source.

• Playback (required)—Specifies Play Once | Loop.

• Left (required)—The offset from the left of the screen, in pixels.

• Width (required)—The display width, in pixels.
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• Top (required)—The offset from the top of the screen, in pixels.

• Height (required)—The display height, in pixels.

• Lock in Visual Editor—Enable this to lock the material in the Visual Editor so that it 
cannot be resized or moved. Disable it to allow resizing or moving. When enabled, 
the cursor changes to a not-allowed version. If you edit the source material in 
another program it can still be resized or changed there. 

• Resource—Click Browse to select the file to use for this Material. The Asset Loca-
tion location is specified in the External Resources dialog. 

Configuring Image Assets
Add one or more Image Assets to use in the Segment. Animated GIFs can be used.

You can apply a Video Overlay Asset or Image Asset as an overlay on your main video. 
Overlays can consume considerable GPU and/or CPU resources. Use caution when 
applying overlays, and restrict the total combined image area for overlays applied 
within active Channels to 1920x1080.

It is a better fit when the images and video clips match the source resolution and 
program size. When they don’t match, the images may be improperly scaled and will 
require significant adjustment. The appearance could also be unacceptable if the 
image or video resolution is lower than the source. 

 

• Name—Specifies the name of the source.

• Playback—Specifies Play Once | Loop.

• Left—The offset from the left of the screen, in pixels.

• Width—The display width, in pixels.

• Top—The offset from the top of the screen, in pixels.

• Height—The display height, in pixels.
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• Lock in Visual Editor—Enable this to lock the material in the Visual Editor so that it 
cannot be resized or moved. Disable it to allow resizing or moving. When enabled, 
the cursor changes to a not-allowed version. If you edit the source material in 
another program it can still be resized or changed there. 

• Resource—Click Browse to select the file to use for this Material. The Asset Loca-
tion location is specified in the External Resources dialog. 
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Uploading Assets for Materials
Assets that are used for Materials must be uploaded into the Asset Location folder that 
is specified in the External Resources dialog. To open the Upload Assets dialog click the 
General Stream Settings icon  in the upper right of the window and select Upload 
Assets. 

In the Upload Assets dialog you can drop your assets into it or click in the dialog to 
browse and select the asset. Only supported file types can be uploaded. 

 

A progress bar shows the level of upload completion, and you can click the X to stop 
the upload. You can click outside of the Upload Assets dialog to close it and the upload 
will continue in the background. You can re-open the Upload Assets dialog to check the 
status of the upload. The supported file types are:

• SMIL (playlists) • GIF

• PNG • Animated GIF

• TIFF • JPEG
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Adjusting and Editing Materials
The audio-visual assets you add are displayed in the Visual Editor to the right of the 
Materials menu. When you hover over an image, blue handles appear, which you can 
grab to adjust dimensions. Use a corner handle to resize and maintain the aspect ratio. 
To move an asset, grab it in a place other than a blue handle. If you don’t see the 
adjustment handles, that asset has the Lock in Visual Editor setting enabled. 

When Snap is active, the sides of an image snap to the edges and center of the frame. 
Click the Snap button to toggle Snap on and off. 

Click the Material Name button to toggle the name of the materials on and off in 
the Visual Editor. Names displayed in the Visual Editor do not appear in the output, only 
in the web interface. 

The most-recently added asset is placed at the top of the stack but can be moved 
further down. To change the stacking order of assets, from front to back, use the small 
white arrows to change the place of a material description in the stacking order, or 
simply grab one of the asset descriptions to move it up or down in the list. The asset at 
the top of the list is the farthest in front. 

Adjustment Handles

Snap On/Off Show Material Name

 

Setting up Trigger Conditions
Triggers define when a Segment is active, in relation to other Segments. Triggers do not 
interact with operation or functions in Renditions or Channels; only in relation to other 
Segments. Thus, Triggers are only useful when there is more than one Segment in a 
Rendition.

• BMP • TS

• MOV • MPG

• MP4 • MXF
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Note: If no Triggers are set for the Segment (set to None), the Segment is always 
active. The default is None.

Triggers in a channel with a single Segment are inoperative, because there isn’t another 
Segment to interact with. Triggers in the top Segment should only use End conditions, 
because the top Segment is by default active—thus, a Start trigger has no effect.

Triggers in all other Segments can be configured with Start and/or End conditions.

Click the Trigger Conditions icon, shown below in the red circle, to display the Trigger 
Conditions dialog.

Open Trigger 
Conditions dialog

 

Segment Stacking Order Determines which Segment is Primary

Segments, in the context of Triggers, are hierarchical—with the top Segment in the 
Programs panel (and the left-most in the Program tab) having the highest priority (and 
considered the primary Segment), down through the stack or to the right, in the 
Program tab) to the lowest priority Segment at the bottom. 

Although many segments may be active at any given time, the streaming segment is 
always the highest priority, active segment. Trigger settings and conditions may cause 
another Segment to become active first, or determine which is active next.

To change the stack order (and thus, the priority) of Segments, use the white arrows at 
the right to move them up or down, or simply grab a Segment and drag it up or down 
in the list.

Top Segment is Primary, 
or has First Priority
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The primary Segment in the stack also displays at the left of the Program tab in the 
Channels panel, as shown here: 

Types of Trigger Conditions
• None (Default)—No Trigger Conditions are set; the Segment is always active. 

• End of Material—For End Conditions, indicates that this segment has ended, 
which deactivates this Segment and activates the next highest segment. End of 
Material triggers can only be used with a base asset or playlist. Play Once must also 
be enabled; otherwise this trigger is ignored.

• LOS—Loss of Signal in the active higher Segment, which triggers this Segment to 
become active.

• GOS—Gain of Signal in the inactive higher Segment, which triggers the higher-pri-
ority Segment to become active. 

• Time of Day—The clock time to start, end, or repeat the Segment. When you want 
to have Triggers for more than one time of day, create an additional Segment for 
each time. 

– Time—Sets the start and/or end time of the Trigger.

– Repeat Interval—Sets the amount of time for the Trigger start to repeat. You 
must set a Duration for the End condition that stops the Trigger before the 
Repeat Interval is set to occur. 

For example, if a Trigger starts at 10:30 and has a Duration of 10 minutes then it 
ends at 10:40. If you want it to repeat again 5 minutes later, then the Repeat 
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Interval is set to 15 minutes so it includes the duration of the Trigger and the 
additional time to elapse for the Trigger to repeat, as shown here:

 

• Duration—For End conditions only; sets the duration of the Segment. When there 
is a Repeat Interval the Duration should be shorter than the Repeat Interval so that 
the Repeat Interval starts the trigger again after the duration has elapsed.

• SCTE-104/35—Specifies the SCTE-104/35 Segmentation type ID and SCTE-104/35 
Source selections (corresponding to the SCTE-104/35 Insert Segmentation Descrip-
tor command shown) on which to Start or End the Segment:

– Program Start (0x10)

– Program End (0x11)

– Provider Ad Start (0x30)

– Provider Ad End (0x31)

– Distributor Ad Start (0x32)

– Distributor Ad End (0x33)

– Ad Break Start (0x34)

– Ad Break End (0x35).

These selections ensure that the correct SCTE source is used. 
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Adding and Configuring Encoders
You create Encoders to identify how your streams will be encoded for playout. You can 
create audio Encoders and video Encoders, which are organized by format: AAC, AC3, or 
MP3 audio, and AVC or HEVC video. You often create multiple Encoders to enable you 
to provide a wide variety of Variants in your packages, to meet your streaming 
requirements.

At least one Stream (video or audio) must be created and configured for each Encoder. 
For each Encoder you can add as many Streams as you need to provide all of the 
different encoding profiles that you want, such as unique bit rates, frame rates, etc. 

Note: For information about how encoder settings affect server resources, see 
Lightspeed Live Server CPU/GPU Usage Guidelines. 

Encoders Panel Overview
Use the Encoders panel to add and edit Encoder group. Select the Encoder to display 
the Streams panel, which provides options to add and configure the audio and video 
Stream encoding parameters. You can select the Streams in Package Variants.

The Encoders panel displays when you click on Encoders in the Component menu. The 
Encoders panel displays two panels: The left panel is the Encoders list, which displays 
all of the Encoders you’ve created. The right panel displays the selected Encoder and its 
Streams.

Press ? on your keyboard to display the hot key menu for this component.

Click to add a new Encoder Streams List
Encoders Panel

Encoder ToolbarSelected Encoder Add Streams

The Encoders panel provides these features:

• Encoders Panel—Displays all of your Encoders. Select an Encoder to display its 
streams and manage it using icons in the toolbar.

• Add Encoder—Click the + icon in the Encoders panel to add a new encoder. See 
Adding an Encoder.

• Streams—Displays the list of Streams you’ve added to this encoder. 
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Encoders Toolbar
The Encoders toolbar is displayed top-right, above the streams list:

– Editor Icon—Click the pencil icon to view or update settings of the selected 
Encoder. 

– Copy—Click to copy the selected Encoder and create a new one with identical or 
similar settings, by editing it before you save it with a new name.

– Delete Icon—Click the trash icon to delete the selected Encoder.

Adding an Encoder
Click the + icon to add a new encoder group. Select the audio or video format you want 
to produce using this encoder. Live Stream displays the Configure Encoder dialog 
(video shown):

• Name—Specifies the name for this Encoder.

• GOP Duration (video only)—For video Encoders, specify the GOP duration, in sec-
onds. Maximum duration: 30 seconds. This setting does not apply to audio Encod-
ers.

Adding and Configuring Streams
You create Streams to specify a format and profile for encoding video or audio during 
playout. Streams are added to Encoders.

When you create a stream, you can specify the codec, which CPU/GPU to use, plus a 
profile or codec settings: bitrate, frame rate, size, etc. Streams are created and 
configured in Encoders and the Streams you create are specified in the Variants you add 
to your Packages.

■ Configuring Streams

■ YouTube Live Encoder Stream Settings

■ Facebook Live Encoder Stream Settings

■ Adjusting GOP Settings

■ AAC Audio Streams

■ AC3 Audio Streams
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■ MP3 Audio Streams

■ AVC Video Streams

■ HEVC Video Streams

■ HDR Metadata Configuration

■ x264 Compressor Settings

■ x265 Compressor Settings

■ Lightspeed GPU Compressor Settings

■ Lightspeed HW Compressor Settings

■ Perseus Plus Compressor Settings

Note: When a stream has been activated by clicking the Start button in Channels, 
configuration settings cannot be changed for that stream, and a red lock icon  
displays in the upper right corner of the components and settings that are used in the 
stream. When Stop is pressed, components can again be edited.
When components are locked, some components can still be duplicated. 

Configuring Streams
Click the + icon in the Streams list to add a new stream.

When Show Encoder Stream Presets is disabled (in the General menu’s Advanced dialog), 
the Configure Stream dialog displays so that you can configure it manually.

When Show Encoder Stream Presets is enabled, you can select a pre-configured Stream 
from the Add Streams menu that meets your requirements.

Configuration dialogs vary by encoder.

 

• Custom Stream—Displays the Configure Stream dialog so you can create streams 
with specific settings. 

• All Presets—Adds all listed presets in Streams for that encoder. If some presets 
already exist, duplicates are added. 

•  Select a Preset—Specifies a specific preset to add as an available stream. 
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Note: If you modify preset settings, consider changing the name to match changes. 

YouTube Live Encoder Stream Settings
For YouTube Live, only 30 or 60 frames per second (fps) are allowed and only specific 
resolution sizes and bitrate ranges can be used. When you choose the quality of your 
stream, YouTube automatically creates all of the lower quality versions. The following 
table lists the encoder configurations allowed for YouTube Live.

Type Resolution fps Bitrate Range (kbps)

2160p @30fps 3840x2160 30 13,000 - 34,000

2160p @60fps 3840x2160 60 20,000 - 51,000

1440p @30fps 2560x1440 30 6,000 - 13,000

1440p @60fps 2560x1440 60 9,000 - 18,000

1080p @30fps 1920x1080 30 3,000 - 6,000

1080p @60fps 1920x1080 60 4,500 - 9,000

720p @30fps 1280x720 30 1,500 - 4,000

720p @60fps 1280x720 60 2,250 - 6,000

480p @30fps 854x480 30 500 - 2,000

360p @30fps 640x360 30 400 - 1,000

240P @30FPS 426X240 30 300 - 700

• Audio for YouTube Live—The recommended audio sample rate is 44.1kHz and 
audio bitrate is 128 kbps stereo. 

Facebook Live Encoder Stream Settings
These settings are accepted or recommended by Facebook Live:

• Maximum resolution 1280 x 720 (720p) at 30 frames per second (fps), H264.

• Maximum video bit rate 4000 kbps.

• AAC audio with these settings: 

– 44.1kHz sample rate.

– 128 kbps bit rate. 

– Mono channel layout. 

When you have the preset encoders option enabled you can choose the Facebook Live 
presets which provide the recommended settings. See Managing General Settings. 
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Adjusting GOP Settings
For both AVC and HEVC video encoder groups, the following applies to GOP settings:

• If the GOP Length is longer than the segment duration, the segment duration 
becomes the GOP length.

• If a value of zero is used for the GOP Length, then the global GOP length is used, 
which is Segment time multiplied by the frame rate. 

• Ideally, Segment duration will be a multiple of GOP duration. For example, a Seg-
ment duration of 9 seconds makes sense with a GOP duration of 3 seconds. 

• GOP Length values are limited to a maximum of 255 frames for the HEVC Light-
speed HW Compressor and 1,000 frames for other compressors. Note that the 
frame rate and GOP Duration in seconds have an interaction.

Note: When you create an AVC or HEVC encoder, there is a GOP Length setting 
specified in seconds. This setting is used by default unless you turn on the GOP Length 
override within a Stream you create for an encoder. GOP Length units are specified in 
frames within the Stream settings due to the possibility that various streams could 
have different frame rates within the encoder. 

AAC Audio Streams
Use the AAC Stream dialog to configure an AAC Stream.

 

• Name—Specifies the name of the stream.

• Bitrate—Specifies the audio bit rate (8-512kbps). Default: 64kbps.

• Sample Rate—Specifies the audio sample rate (22.05-48kHz.). Default: 48kHz.
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• AAC Profile—Specifies profile of the codec: LC (AAC-LC - Low Complexity) | HEv1 
(HE-AAC - High Complexity version 1) | HEv2 (HE-AAC v2 - High Complexity version 
2).

• Channel Layout—Specifies the audio layout to use for the output: Mono | Stereo | 
5.1 surround sound. This is the setting that makes the final determination of the 
output configuration. 

AC3 Audio Streams
Use the AC3 Stream dialog to configure an AC3 Stream.

 

• Name—Specifies the name of the stream. 

• Bitrate—Specifies the audio bit rate. Use the following settings for proper encod-
ing operation:

– Mono must be 56 kbps or higher.

– Stereo must be 96 kbps or higher.

– 5.1 must be 224 kbps or higher.

• Sample Rate—Specifies the audio sample rate. The only option is 48kHz. 

• Channel Layout—Specifies the audio layout to use for the output: Mono | Stereo | 
5.1 surround sound. This is the setting that makes the final determination of the 
output configuration.
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MP3 Audio Streams
Use the MP3 Stream configuration dialog to configure an MP3 Stream.

 

• Name—Specifies the name of the stream. 

• Bitrate—Specifies the audio bit rate. Permitted bitrate range: 56 kbps to 512 kbps. 
For 32 | 44.1 | 48 kHz sample rate, audio bitrates up to 320 kbps are usable (select-
ing higher bit rates causes the bit rate to be set at 320 kbps). When using 22.05 kHz 
sample rate, the maximum bitrate is 160 kbps for both mono and stereo. 

• Sample Rate—Specifies the audio sample rate: 22.05 | 32 | 44.1 | 48 kHz.

• Channel Layout—Specifies the audio layout to use for the output: Mono | Stereo. 
This is the setting that makes the final determination of the output configuration.
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AVC Video Streams
Use the AVC Streams dialog to configure an AVC Stream.

• Name—Specifies the name of the AVC stream.

• Width—Specifies the frame width. The default is 1920, the minimum is 160, and 
maximum width is 4096 pixels.

• Height—Specifies the frame height. The default is 1080, the minimum is 120, and 
the maximum height is 2160 pixels. 

• Bitrate—Specifies the stream bit rate. The default is 9000, the minimum is 100, and 
the maximum bitrate is 50,000kbps. 

• Framerate—Specifies the stream output frame rate. 

• Profile—Specifies the profile to use: Baseline | Main | High.

• GOP Length—Specifies the GOP length in frames. When enabled, this setting over-
rides the GOP duration set in the Edit Encoder dialog for this Encoder group. 

• Display Aspect Ratio—Specifies the aspect ratio of the encoded stream: 4:3, 16:9, 
1.85:1, 2.35:1, 2:1, 1:1, or 1.9:1.

• Burn-in Timecode—Composites a text representation of the timecode onto the 
encoded image.

• CBR Mode—When enabled, specifies Constant Bit Rate Mode; otherwise, VBR.
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• Low Latency—Enables low latency encoding. 

• IDR Splices—Enable for splice frames to be IDR frames. 

• TIQ Metadata—Enable to add TIQ metadata to SEI user data in AVC/HEVC video.

• Suppress Captions—(Advanced Mode only) When enabled, no captions are added 
to the output video stream. When disabled, captions are added to the output if 
present in the input, and even if captions are not present, players may detect the 
presence of captions, even though there are none.

• Compressor—Specifies the compressor to use for the stream: x264 | Lightspeed 
GPU | Perseus. The x264 compressor executes only on the CPU. The Lightspeed GPU 
is available in Advanced mode only. When you use Perseus encoding, unless the 
player uses the Perseus decoder, the output will be half-resolution.

Options vary, based on the compressor you choose. Proceed to the appropriate 
compressor and configure the options.

– x264 Compressor Settings

– Lightspeed GPU Compressor Settings

– Perseus Plus Compressor Settings
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HEVC Video Streams
Use the HEVC Streams dialog to configure an HEVC Stream.

  

Name—Specifies the name of the HEVC stream.

Width—Specifies the frame width. The default is 1920, the minimum is 160, and 
maximum width is 4096 pixels.

Height—Specifies the frame height. The default is 1080, the minimum is 120, and the 
maximum height is 2160 pixels. 

Bitrate—Specifies the stream bit rate. The default is 9000, the minimum is 100, and the 
maximum bitrate is 50,000kbps. 

Framerate—Specifies the stream output frame rate. Default: 30fps. The frame rate is 
limited when using the Lightspeed HW compressor, see SDI Source Video Formats.

Profile—Specifies Main for 8-bit and Main 10 for 10-bit output. When using Main 10, 
the Video Processor selected must be Lightspeed. When Main (8-bit) is selected you can 
use either the Default or the Lightspeed Video Processor.

GOP Length—Specifies the GOP length in frames. When enabled, this setting 
overrides the GOP duration set in the Edit Encoder dialog for this Encoder group.
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Display Aspect Ratio—Specifies the aspect ratio of the encoded stream: 4:3, 16:9, 
1.85:1, 2.35:1, 2:1, 1:1, or 1.9:1.

Burn-in Timecode—Composites a text representation of the timecode onto the 
encoded image.

CBR Mode—When enabled, specifies Constant Bit Rate Mode; otherwise, VBR.

IDR Splices—Enable for splice frames to be IDR frames. 

TIQ Metadata—When enabled, adds TIQ metadata to SEI user data.

Suppress Captions—(Advanced Mode only) When enabled, no captions are added to 
the output video stream. When disabled, captions are added to the output if present in 
the input, and even if captions are not present, players may detect the presence of 
captions, even though there are none.

Compressor—Specifies the platform resource to use for encoding the stream, 
depending on the speed and quality you require:

x265 Compressor Settings—Utilizes the Lightspeed Live Server CPU to encode 
media using an x265 codec. See x265 Compressor Settings for details. 

Lightspeed GPU Compressor Settings—Utilizes the Lightspeed Live Server GPU 
card to encode media using H.264/H.265 codecs. See Lightspeed GPU Compressor 
Settings for details.

Lightspeed HW Compressor Settings—Utilizes the optional Lightspeed HW card 
to encode media using the HEVC codec. See Lightspeed HW Compressor Settings for 
details.

Enable HDR Metadata—When enabled, provides the ability to set specific manual 
HDR signaling parameters. See HDR Metadata Configuration below for details. 
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HDR Metadata Configuration 
The Enable HDR Metadata option provides the ability to set specific manual signaling 
of HDR color space, mastering display characteristics, and content light level 
parameters. 

Example HDR Metadata Parameters
The following are examples of typical settings for HDR10 and HLG output:

HDR10—BT2020 Color Primaries input, SMPTE-ST-2084 Transfer Characteristics, and 
BT2020NC Color Matrix. Master Display and Content Light Level values should be set 
based on production and content. 

HLG—BT2020 Color Primaries input, ARIB-STD-B67 Transfer Characteristics, and 
BT2020NC Color Matrix. Master Display and Content Light Level values should be set 
based on production and content. (Note: The Master Display and Content Light Level 
metadata is technically not required for this HLG example.)

Settings for HDR Metadata
Color Space—Manually sets the signaling of the expected source color space. 

Color Primaries—Choose the color primaries to use. Specifies the location (in XYZ 
space) of the RGB color primaries and reference white point (W) associated with the 
color space.

Transfer Characteristics—Choose the Transfer Characteristics. Specifies the trans-
fer function used to convert between linear light levels and nonlinear component 
values.

Color Matrix—Choose the Color Matrix to apply. Specifies the matrix coefficients 
used to convert between RGB color primary values and YUV color difference values.
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SMPTE 2086 Master Display—Manually specifies mastering display characteristics. 
Values should be set based on production and content. 

X Coordinates—Sets the X chromaticity coordinate of each color component and 
white point of the mastering display. 

Y Coordinates—Sets the Y chromaticity coordinate of each color component and 
white point of the mastering display.

Maximum Luminance—Sets the maximum display luminance of the mastering 
display in units of candelas per square meter. 

Minimum Luminance—Sets the minimum display luminance of the mastering dis-
play in units of candelas per square meter. 

CTA-861.3 Content Light Level—Manually specifies the content light level 
parameters. Values should be set based on production and content. If these values are 
unknown you can set them to 0, which delegates HDR10 settings to the display that 
will likely make reasonable choices.

MaxCLL—Sets the Maximum Content Light Level in units of candelas per square 
meter.

MaxFALL—Sets the Maximum Frame Average Light Level in units of candelas per 
square meter.
Lightspeed Live Stream User Guide



Using Live Stream Components 
Adding and Configuring Encoders

205
x264 Compressor Settings
Use the x264 Compressor options to configure the specified software-based x264 
codec which executes on the CPU.

Command Line Options—Command Line parameters for x264. Only available when 
Advanced Mode is enabled.

To set specific parameters, you can enter CLI commands (with multiple commands 
separated by spaces) to execute them. For best results, be sure to use long form: --
bframe 5, for example. Use of short form (-b 5) is not recommended.

These command line parameters are not supported:

 --fake-interlaced

 --profile 

 --video-format

 --bitrate 

Preset—Specifies the speed preset to use for the x264 compressor. Only available 
when Advanced mode is enabled.

Video Processor—Specifies the video processor to use: 

Default—uses the CPU and GPU

Lightspeed—accelerates processing; primarily uses GPU. The Lightspeed video 
processor can more efficiently process video at higher quality and higher bit depth 
(for example, HDR).
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x265 Compressor Settings
Use the x265 Compressor options to configure the specified software-based x265 
codec which executes on the CPU.

Command Line Options—Command Line parameters for configuring the compressor 
using x265 command line syntax. Only available when Advanced mode is enabled.

To set specific parameters, you can enter CLI commands (with multiple commands 
separated by spaces) to execute them. For best results, be sure to use long form: --
bframe 5, for example. Use of short form (-b 5) is not recommended.

These command line parameters are not supported:

 --fake-interlaced

 --profile 

 --video-format

 --bitrate 

Preset—The speed preset to use for the x265 compressor. Only available when 
Advanced mode is enabled. When used for 4K output, the recommended Preset is 
Ultrafast or Superfast.

Video Processor—Specifies the video processor to use: 

Default—uses the CPU and GPU

Lightspeed—accelerates processing; primarily uses GPU. The Lightspeed video 
processor can more efficiently process video at higher quality and higher bit depth 
(for example, HDR).
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Enable HDR Metadata—Enables the ability to set the following HDR metadata 
options:

Color Space—Set options for Color Primaries, Transfer Characteristics, and Color 
Matrix. 

SMPTE 2086 Master Display—Set values for X and Y Chromaticity Coordinates for 
Red, Green, Blue, and White Point, as well as Maximum and Minimum Luminance in 
units of candelas per square meter. 

CTA-861.3 Content Light Level—Set Maximum Content Light Level (MaxCLL) in 
units of candelas per square meter and Maximum Content Light Level (MaxFALL) in 
units of candelas per square meter. 

Lightspeed GPU Compressor Settings
Use the Lightspeed GPU Compressor options to configure the GPU-based H.264 codec.

When Advanced is enabled (see Advanced settings), you can select Lightspeed GPU.

Note: To use the Lightspeed GPU compressor for 10-bit HEVC output (Profile: Main 
10), the Lightspeed Live server must have an NVIDIA Pascal Generation GPU, such as a 
Tesla P4 or P4000 installed. When a Tesla M4 GPU is installed, streaming will fail when 
using the Lightspeed GPU. To determine which GPU is installed, go to Device Manager 
> Display Adapters > NVIDIA Tesla (M4, P4 or P4000). 

Preset—The speed preset to use for the Lightspeed GPU compressor. Presets include 
Default | High Performance| High Quality | Low Latency Default | Low Latency High 
Performance | Low Latency High Quality. Only available when Advanced mode is 
enabled.

Video Processor—Specifies the video processor to use:

Default—uses the CPU and GPU

Lightspeed—accelerates processing; primarily uses GPU. The Lightspeed video 
processor can more efficiently process video at higher quality and higher bit depth 
(for example, HDR).
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Enable HDR Metadata—Enables the ability to set the following HDR metadata 
options:

Color Space—Set options for Color Primaries, Transfer Characteristics, and Color 
Matrix. 

SMPTE 2086 Master Display—Set values for X and Y Chromaticity Coordinates for 
Red, Green, Blue, and White Point, as well as Maximum and Minimum Luminance in 
units of candelas per square meter. 

CTA-861.3 Content Light Level—Set Maximum Content Light Level (MaxCLL) in 
units of candelas per square meter and Maximum Content Light Level (MaxFALL) in 
units of candelas per square meter. 

Lightspeed HW Compressor Settings
Use the Lightspeed HW Compressor options to configure the HEVC codec 
implemented in the optional Lightspeed HW card.

Formats are limited for Lightspeed HW—see SDI Source Video Formats.

Note: When Lightspeed HW is selected, the optional Lightspeed HW card is used to 
encode the output. Lightspeed HW mode is only available when the HEVC card is 
installed in the Lightspeed server.

 

Constrained Level—When enabled, specify the constrained Lightspeed HW level to use 
for better player compatibility. When not enabled, the level is automatically 
determined by the HEVC HW codec. These level constraints help for playback of HLS 
fMP4 output with HEVC content. (Advanced mode must be enabled to access this 
setting.) 

Important Note: Enabling Constrained Level is intended to be used only by advanced 
users who understand the results and attributes of each option. 

The options are: Level 3.0 | Level 4.0 | Level 5.0.
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Video Processor—Specifies the video processor to use: 

Default—Uses the CPU and GPU

Lightspeed—Accelerates processing; primarily uses GPU. The Lightspeed video pro-
cessor can more efficiently process video at higher quality and higher bit depth (for 
example, HDR).

Enable HDR Metadata—Enables the ability to set the following HDR metadata 
options:

Color Space—Set options for Color Primaries, Transfer Characteristics, and Color 
Matrix. 

SMPTE 2086 Master Display—Set values for X and Y Chromaticity Coordinates for 
Red, Green, Blue, and White Point, as well as Maximum and Minimum Luminance in 
units of candelas per square meter. 

CTA-861.3 Content Light Level—Set Maximum Content Light Level (MaxCLL) in 
units of candelas per square meter and Maximum Content Light Level (MaxFALL) in 
units of candelas per square meter. 

Perseus Plus Compressor Settings
Perseus Plus enables a significant bitrate reduction without sacrificing quality. Perseus 
Plus decoder software is required to display this optimized video. Contact Telestream 
support for further information. 

Use the Perseus Plus Compressor options to configure the Perseus Plus codec.

Downsampling—Specifies the down-sampling mode applied to the base stream: Anti-
alias | Sharp.

Output Filler Enabled—When enabled, inserts filler into the stream as necessary to 
maintain CBR.
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Upsample—Specifies which method to use to up-sample the base stream: Nearest | 
Linear | Cubic.

Transform—The transform matrix used for encoding: dd | dds.

Temporal—When enabled, applies temporal prediction for encoding. Generally, 
Temporal should always be enabled for best video quality. Disable to reduce 
complexity, improving performance.

Double Upsampling—When enabled, causes the Perseus compressor to double the 
display resolution on the decoding side. Depending on the player-based decoder 
selected, it will be restricted up to input resolution of 360p, 540p or ignored.

Bitrate Base Proportion—Specifies the proportion or percentage of the total stream 
bit rate reserved for the base bit rate, expresses as a decimal value 0-0.99 (default: 0.72).

Bitrate Max Base Proportion—Specifies the proportion or percentage of the total 
stream bit rate reserved for the base bit rate, expresses as a decimal value 0-0.99 
(default: 0.86). When Bitrate Base Proportion and Bitrate Max Proportion are set to the 
same value, you are encoding in CBR mode. When Max Base Proportion is higher, you 
are encoding in VBR mode, when CBR is disabled.

• Dither—When enabled, the encoder dithers the output as appropriate.

• Dither Strength—When Dither is enabled, sets the strength of the dithering algo-
rithm.

• Preset—The speed preset to use for the Lightspeed GPU compressor. Only avail-
able when Advanced Mode is enabled.

• Video Processor—Specifies the video processor to use: 

Default—uses the CPU and GPU

Lightspeed—accelerates processing; primarily uses GPU. The Lightspeed video pro-
cessor can more efficiently process video at higher quality and higher bit depth (for 
example, HDR).

Adding and Configuring Packages
Use the Packages panel to create and configure Packages. The Packages panel allows 
you to choose the type of packages you want to use (such as Apple HLS, DASH, and so 
on) and configure package settings, and select a Program to use with the Package.

Variants are added, in which you select which Renditions and Encoder Streams to use 
for each Variant of the Package. At least one Variant must be included for each Package. 

■ Packages Panel Overview

■ Apple HLS Packages

■ ATS (Adaptive Transport Stream) Packages

■ DASH Packages

■ CMAF (Common Media Application Format) Packages

■ RTMP Packages
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■ RTMP Azure Packages

■ MP4 Packages

■ YouTube Live Packages

■ Facebook Live Packages

Packages Panel Overview
The Packages panel displays when you click on Packages in the Component menu. The 
Packages panel is organized into two panels: The left panel is the Packages list, which 
displays all of the Packages you’ve created. The right panel displays the Variants in the 
selected package.

Press ? on your keyboard to display the hot key menu for this component.

Click to add a new Package Variants List

Packages Panel
Packages Toolbar

Selected Package Add Variant

• Packages Panel—Displays all of your Packages. Select a Package to view or edit it 
or manage its Variants.

• Add Package—Click the + icon in the Packages panel to add a new Package. Select 
the type of Package from the list.

Packages Toolbar

The Encoders toolbar is displayed top-right, above the streams list:

– Editor Icon—Click the pencil icon to configure or update settings of the selected 
Package. Source configuration panels vary by type.

– Duplicate—Click to duplicate the selected Package to create a new one with 
identical or similar settings, by editing it before you save it with a new name.

– Delete Icon—Click the trash icon to delete the selected Package.

• Variants—Displays the list of Variants you’ve added to this Package. For details on 
adding and configuring variants, see Adding and Configuring Variants.
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Apple HLS Packages
Use the Apple HLS Configure Package dialog to configure an Apple HLS package.

  

• Name—Specifies the name of the Apple HLS package.

• Program—Specifies the program to use for this package from the list you created 
in the Programs panel.

• Segment Duration—Specifies the seconds of segment duration. Segment dura-
tion should be a multiple of GOP duration and will determine the frequency at 
which players may switch Variants. Lower segment durations can reduce latency.

• Playlist Name—Specifies the name to use for the playlist.

• Directory Rollover—When enabled, segments in the Package are rolled over to a 
new folder at 5-hour intervals. 

• TIQ Metadata—Enable to add Telestream metadata to the package for usage by 
quality analysis systems. Timestamps for use by IneoQuest products are included. 
When enabled, the output HLS is forced to HLS version 7.0, even when you have 
selected 3.0 or 4.0 as the HLS version in the Package.
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• Program Date Time—When enabled, the start timestamp is added to the playlist, 
for all HLS versions. An updated timestamp is inserted for each segment created in 
each variant-level playlist.

The timestamp is in the form 
#EXT-X-PROGRAM-DATE-TIME:2018-06-04T11:29:46.8690000-07:00.

• Coordinated Segments—Only valid for Akamai or CDN dual redundant contribu-
tion. When enabled, coordinates segment creation (assuming that there is a pri-
mary and secondary live stream with identical timecode (for example, LTC), and all 
Packages in the Channel have the same segment length), causing segments to start 
at a fixed offset from the start frame.

The primary application is for redundant streams simultaneously delivered to the 
CDN server, which discards the second one as long as the first is posting success-
fully. Since both Live Stream servers are publishing the same segments, the CDN 
server can start using the backup server’s segments if anything happens to posts 
from the primary. When a stream goes down—the primary Live Stream server loses 
network connectivity, for example—the CDN server begins broadcasting the 
backup stream from the same point that the primary stream was at when it failed—
thus, the viewer won't see a significant jump in the video. 

To function properly, you must use the same Dash Package settings on both Live 
Stream systems (matching resolutions/frame rates/bit rates etc. The easiest way to 
accomplish this is to set up your Package in one system and then export the set-
tings to the second system). Now, create a Channel on the first system with the 
Event ID disabled so that Stream will create an event ID automatically when you 
start the Channel. On the second system, copy the event ID—which is located in 
the secondary storage: D:\Stream\webroot\<channel name>\. The most 
recently created folder is one that contains the event ID in the name— and config-
ure the enabled event ID on the second system’s Channel with the copied Event ID. 
Both Channels must point to the same CDN entry point. 

Now, if one of the Channels fails, the second system’s Channel will still be stream-
ing, and viewers won’t experience any indication of issues. 

Note: The timecode must be the same type and shared between the two streams. 
Analog LTC is a good choice, because it can be configured so that ingested video 
between two servers can use the same TC source. 

• WebVTT—Enable to create WebVTT output. When using WebVTT, the output 
audio, video, and .vtt files are all in separate folders and files. 

• HLS Version—Specifies which HLS version to use: 3.0 | 4.0 | 7.0.   Default: Version 
4.0. Some devices, such as certain TV models, require HLS 3.0. 

• SCTE-35—Available when HLS 7.0 is selected. When enabled, adds SCTE-35 seg-
mentation date range lines. 

• Segment Format—Available when HLS 7.0 is selected, and allows you to choose 
between the default TS segment file format or fMP4. 

– TS—Transport Stream 
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– fMP4—Fragmented MP4. 

Note: Encryption is not currently supported for HLS fMP4 output. 

• Enable Byte Range—When enabled, the EXT-X-BYTERANGE feature of HLS is used 
and there is a single .ts file for the entire stream. 

When disabled (default), the output is the normal multiple .ts segments and the 
Playlist Type and Elements settings are enabled:

• Playlist Type—Specifies the playlist type to use: Rolling | Appending: 

– Rolling—The Rolling playlist keeps a specific number of Segments, set in 
Elements. Rolling playlists keep a fixed pool of published Segments, which 
reduces storage management and constrains player access to a range of 
Segments.

– Appending—The Appending playlist keeps all Segments. Appending playlists 
store all Segments encoded while the Channel is active and can be used to 
generate VOD assets for library storage.

• Elements—Specifies the number of elements to keep in the Rolling Playlist. The 
minimum number of elements is 5 and the maximum is 100. 

• Encryption—Specifies the encryption type to use: None | AES Encryption | Verima-
trix DRM. (A Verimatrix server must be available in order to use Verimatrix DRM.) 
Complete the following fields that apply:

• Server URL (when Encryption enabled)—For Verimatrix DRM, the server address.

• Key Rotation (when Encryption enabled)—For AES & Verimatrix DRM, sets the 
key rotation time. 

• Key Count (when Encryption enabled)—For AES Encryption, sets the number of 
keys that are automatically generated and rotated-over when encrypting this HLS 
stream. 

• Create Key File (when Encryption enabled)—For Verimatrix DRM, when enabled 
this creates a file with encryption keys. This is needed if the Package is processed by 
the ABR Optimize action. 
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ATS (Adaptive Transport Stream) Packages
Use the ATS Configure Package dialog to configure an ATS package.

 

• Name—Specifies the name of the ATS package.

• Program—Select the program to use for this package from the list you created in 
the Programs panel.

• Enable EBP—When enabled, adds EBPs (Encoder Boundary Points) to the output 
stream. Configure these two fields:

• Segment Duration (when Enable EBP enabled)—Specifies segment duration in 
seconds. Segment duration should be a multiple of GOP duration and determines 
the frequency at which players may switch Variants. Lower segment durations can 
reduce latency.

• Fragment Duration (when Enable EBP enabled)—Specifies fragment duration in 
seconds. 
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DASH Packages
Use the DASH Configure Package dialog to configure a DASH package.

 

• Name—Specifies the name of this DASH package.

• Program—Select the program to use for this package from the list you created in 
the Programs panel.

• Segment Duration—Specifies segment duration in seconds. Segment duration 
should be a multiple of GOP duration and determines the frequency at which play-
ers may switch Variants. Lower segment durations can reduce latency.

• Playlist Name—Specifies the name of the playlist for this package.

• Directory Rollover—When enabled, the Package rolls segments over to a new 
folder at 5-hour intervals. 

• UTC Timestamps—When enabled, the Package changes the timestamps in the 
movie fragments to utilize UTC time. Enabling this option provides UTC timestamps 
for delivery to Unified Streaming’s Origin content delivery system. 

• Coordinated Segments—Only valid for Unified Origin. When enabled, coordi-
nates segment creation (assuming that there is a primary and secondary live 
stream with identical timecode (for example, LTC), and all Packages in the Channel 
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have the same segment length), causing segments to start at a fixed offset from the 
start frame.

The primary application is for redundant streams simultaneously delivered to the 
server, which discards the second one as long as the first is posting successfully. 
Since both Live Stream servers are publishing the same segments, the  Akamai/Uni-
fied Origin/CDN server can start using the backup server’s segments if anything 
happens to posts from the primary. When a stream goes down—the primary Live 
Stream server loses network connectivity, for example—the Akamai/Origin/CDN 
server begins broadcasting the backup stream from the same point that the pri-
mary stream was at when it failed—thus, the viewer won't see a significant jump in 
the video. 

To function properly, you must use the same Dash Package settings on both Live 
Stream systems (matching resolutions/frame rates/bit rates etc. The easiest way to 
accomplish this is to set up your Package in one system and then export the set-
tings to the second system). Now, create a Channel on the first system with the 
Event ID disabled so that Stream will create an event ID automatically when you 
start the Channel. On the second system, copy the event ID—which is located in 
the secondary storage: D:\Stream\webroot\<channel name>\. The most 
recently created folder is one that contains the event ID in the name— and config-
ure the enabled event ID on the second system’s Channel with the copied Event ID. 
Both Channels must point to the same Unified Origin entry point. 

Now, if one of the Channels fails, the second system’s Channel will still be stream-
ing, and viewers won’t experience any indication of issues. 

Note: The timecode must be the same type and shared between the two streams. 
Analog LTC is a good choice, because it can be configured so that ingested video 
between two servers can use the same TC source. 

• SCTE-35—When enabled, inserts SCTE-35 metadata in the selected formats: 

– Binary in Manifest—Adds SCTE-35 event stream tags to the playlist in binary, 
base-64 format.

– XML in Manifest—Adds SCTE-35 event stream tags to the playlist in XML format. 

– SCTE-35 in fMP4—Adds SCTE-35 metadata track to fragmented MP4 files.

• Playlist Type—Specifies the playlist type to use: Rolling | Appending: 

– Rolling—The Rolling playlist keeps a specific number of Segments, set in 
Elements. Rolling playlists will keep a fixed pool of published Segments, which 
reduces storage management and constrains player access to a range of 
Segments.

– Appending—The Appending playlist keeps all Segments. Appending playlists 
store all Segments encoded while the Channel is active and can be used to 
generate VOD assets for library storage.

• Elements—Specifies the number of elements to keep in the Rolling Playlist. 
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• Encryption—Specifies Unencrypted | From Script | Common Encryption. For Script 
encryption, enter the Script to use. For Common Encryption, the following options 
are available for Widevine DRM and Key Types: 

– Widevine DRM—Specifies the Provider and Content Identifier. 

• Key Type, Widevine Key—Provide the information for the Widevine Keys you want 
to include:

– WidevineSD—Specifies the Key Identifier and Key Value.

– WidevineHD—Specifies the Key Identifier and Key Value. 

– WidevineAudio—Specifies the Key Identifier and Key Value.

– PlayReady DRM—Specifies the Key Identifier, Key Value, Key Seed, and License 
acquisition URI. 

– Clear Key DRM—Specifies the Key Identifier and Key Value. 

– GPAC DRM—Specifies the Key Identifier and Key Value. 

• Key Type, Foreign Key—Specifies the Key Identifier and Key Value, and then enter 
information additional Foreign Key data you want to include:

– PlayReady DRM—Specifies the Key Identifier, Key Value, Key Seed, and License 
acquisition URI. 

– Clear Key DRM—Specifies the Key Identifier and Key Value. 

– GPAC DRM—Specifies the Key Identifier and Key Value. 

CMAF (Common Media Application Format) Packages
Use the CMAF Configure Package dialog to configure a CMAF package.

 

• Name—Specifies the name of the CMAF package.
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• Program—Select the program to use for this package from the list you created in 
the Programs panel.

• Segment Duration—Specifies the seconds of segment duration. Segment dura-
tion should be a multiple of GOP duration and will determine the frequency at 
which players may switch Variants. Lower segment durations can reduce latency.

• DASH Playlist Name—Specifies the name of the DASH playlist (default: manifest). 

• HLS Playlist Name—Specifies the name of the HLS playlist (default: playlist). 

• UTC Timestamps—Changes the timestamps in the movie fragments to be based 
on UTC time. Enabling this option provides UTC timestamps for delivery to a Uni-
fied Origin content delivery system. 

• SCTE-35 in HLS Playlist—Adds SCTE-35 segmentation date-range lines to the 
Apple HLS playlist.

• SCTE-35 in Manifest—Add SCTE-35 event stream tag to the DASH playlist. 

• SCTE-35 in fMP4—Add SCTE-35 metadata track to the video stream.

• Playlist Type—Specifies the playlist type to use: Rolling | Appending: 

– Rolling—The Rolling playlist keeps a specific number of Segments, set in 
Elements. Rolling playlists will keep a fixed pool of published Segments, which 
reduces storage management and constrains player access to a range of 
Segments.

– Appending—The Appending playlist keeps all Segments. Appending playlists 
store all Segments encoded while the Channel is active and can be used to 
generate VOD assets for library storage.

• Elements—Specifies the number of elements to keep in the Rolling Playlist. 

RTMP Packages
Use the RTMP Configure Package dialog to configure an RTMP package.

 

• Name—Specifies the name of the RTMP package.
Lightspeed Live Stream User Guide



Using Live Stream Components
Adding and Configuring Packages

220 
• Program—Select the program to use for this package from the list you created in 
the Programs panel.

• Chunk Size—When enabled, sets the RTMP stream to send a Set Chunk Length 
message. The default is disabled.

• Force positive offsets—When enabled, the RTMP stream has positive offsets. This 
can improve stream operation when bframes are included in the RTMP stream. The 
default is disabled (negative offsets). 

Note: To remove bframes from an RTMP stream, you can use the command line 
parameter --bframes 0. Command Line options are only available for x264 and x265 
compressors. For command line parameter entry, see Command Line Options in AVC 
Video Streams.

• Enable Metadata—When enabled, the RTMP stream will pass proprietary meta-
data. This setting is required if SCTE information needs to be propagated within the 
RTMP stream. 

• Connection Timeout—When enabled, the stream output waits the specified num-
ber of seconds for a connection to establish before stopping the attempt. The 
default is 3 seconds. This option may be helpful if there are firewall delays or other 
conditions that can cause connection delays.

RTMP Azure Packages
Use the RTMP Azure Configure Package dialog to configure an RTMP Azure package, for 
streaming to Microsoft Azure.

 

• Name—Specifies the name of the RTMP Azure package.

• Program—Select the program to use for this package from the list you created in 
the Programs panel.

• Chunk Size—Enable for the RTMP stream to send a Set Chunk Length message. 
(Default: disabled). Set the chunk size as needed (default: 1024). 
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• Enable Metadata—When enabled, the RTMP Azure stream will pass proprietary 
metadata. This setting is required if SCTE information needs to be propagated 
within the RTMP Azure stream. 

• Timestamp Interval—When enabled, a UTC Timestamp is emitted at the specified 
interval of frames. The default is every 30 frames.

• Connection Timeout—When enabled, the stream output waits the specified num-
ber of seconds for a connection to establish before stopping the attempt. The 
default is 3 seconds. This option may be helpful if there are firewall delays or other 
conditions that can cause connection delays. 

MP3 Packages
Use the MP3 Configure Package dialog to configure an MP3 package.

 

• Name—Specifies the name of the MP3 package.

• Program—Select the program to use for this package from the list you created in 
the Programs panel.

MP4 Packages
Use the MP4 Package dialog to configure an MP4 package.

 

• Name—Specifies the name of the MP4 package.
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• Program—Select the program to use for this package from the list you created in 
the Programs panel.

• Segment Duration—Enable to break the recorded output into MP4 segments of 
the selected duration. Each created segment is complete and usable. While the 
Stream is active, segments of the selected duration will continue to be created. The 
duration options are 5, 10, 15, 20, 30 minutes, and 1 hour. The default is 5 minutes. 

YouTube Live Packages
Use the YouTube Live Configure Package dialog to configure a YouTube Live package.

When creating a Package for YouTube Live you can only have one Variant per YouTube 
Live Package. 

 

• Name—Specifies the name of the YouTube Live package.

• Program—Select the program to use for this package from the list you created in 
the Programs panel.

• Connection Timeout—When enabled, the stream output waits the specified num-
ber of seconds for a connection to establish before stopping the attempt. The 
default is 3 seconds. This option may be helpful if there are firewall delays or other 
conditions that can cause connection delays.
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Facebook Live Packages
Use the Facebook Live Configure Package dialog to configure a Facebook Live package.

 

• Nam—Specifies the name of the Facebook Live package.

• Program—Select the program to use for this package from the list you created in 
the Programs panel.

• Connection Timeout—When enabled, the stream output waits the specified num-
ber of seconds for a connection to establish before stopping the attempt. The 
default is 3 seconds. This option may be helpful if there are firewall delays or other 
conditions that can cause connection delays.

Adding and Configuring Variants
You create and configure Variants so that you can identify the Renditions and the audio 
and video Encoder Streams to use for each Variant of the Package.

Note: Streams using HEVC encoders, when running in Lightspeed HW compressor 
mode, are limited to running four SD/HD Variants or one UHD/4K Variant at one time. 
Additional HEVC Streams can't be started, due to reaching the limit.
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Select a Package and click the + icon in Variants to add and configure a Variant. You can 
add multiple Variants.

The Configure/Edit Variant dialog provides these options:

• Name—Specifies the name of the Variant.

• Rendition—Select the name of the Rendition to use from one that you created in 
the Programs panel.

• Video Stream—Select a video stream to use, from the ones you created in the 
Encoders panel. 

• Audio Stream—Select an audio stream to use, from the ones you created in the 
Encoders panel. 

• Index Playlist Name—Enable, then enter the name of the index playlist file which 
contains the URLs of the media segment files. 

• Default—Sets this as the first Variant to be chosen by the player to play from the 
first segment, when the Package is HLS or DASH. 

Note: The Default setting is respected and used by some players, but not all. 
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Adding and Configuring Channels
You create channels to specify the Program and Packages you want to play out. Each 
Channel can include up to six Packages, which allows each Channel to stream to one or 
more locations. You select an input source for each Segment that is included in the 
Channel. When you select a Package, the Variant(s) assigned to it are displayed in the 
Variants list. 

When you start the Channel, the active Source is encoded to the Package Variant 
definitions and streamed to the locations you have specified. When a Stream is active, a 
thumbnail preview is displayed for each Variant, as well as statistics for the resources 
being used. 

■ Channels Panel Overview

■ Channel Configuration

■ Live Captioning Input

■ Output Locations

■ RTMP Channel Destination Configuration

■ RTMP Package Destinations

■ RTMP Playback URLs for Akamai

■ YouTube Live Channel Configuration

■ Facebook Live Channel Configuration

■ Selecting the Input Source for a Segment

■ Multiple Renditions or Segments

■ Scheduling Channel Activation Events

■ Modifying Events When a Channel is Active

■ Starting and Stopping a Channel

■ Previewing Channel Output

■ Activated Channel Operation

Channels Panel Overview
The Channels panel displays when you click on Channels in the Component menu. The 
Channels panel displays two sub-panels: The left panel is the Channels list, which 
displays all of the channels you’ve created. The right panel is tabbed; it displays 
Programs and Packages in the selected channel.

Configuring Channels involves selecting a program for the Channel, and adding 
Packages and specifying their implementation.
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Press ? on your keyboard to display the hot key menu for this component.

Click to add a new Channel

Panel menu Programs & 
Packages

Channels list

Channel ToolbarLightspeed Live 
Server Selected Channel

Click the  icon in the Channels toolbar to display the Configure Channel dialog and 
create a new a Channel. 

Select a channel to view its details or modify the channel.

Channels Toolbar

The icons in the toolbar are enabled or disabled, based on the channel’s state. This 
graphic illustrates the icons that are enabled when the selected Channel is not active 
(on the left) and is active (on the right):

Edit Delete View Settings Get Preview Link 
for Captioning

Duplicate DuplicateCreate Schedule

Activate Channel

De-activate Channel

Operations
• Edit—Click to display the Configure Channel dialog and view or update its pro-

grams and packages. See Channel Configuration for details.

• Duplicate—Click to duplicate the selected Channel to create a new one with iden-
tical or similar settings, by editing the channel before you save it with a new name. 
You can duplicate an active channel, but the new one isn’t active until you start it. 

• Delete—Click to permanently remove the selected channel. You can’t delete an 
active channel.
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• Create Schedule—Click to display the Schedule Channel Activation dialog, where 
you can create a schedule for automatically activating the channel. See Scheduling 
Channel Activation Events for details.

• Preview Link for Captioning—Click the Closed Captioning icon to access a URL to 
view the Captioning Channel Preview. See Using Live Captioning Input via IP for 
more information. 

• Start | Stop—Click to start or stop the channel.

Channel Configuration
Use the Configure Channel dialog to configure a channel and it’s Packages. Package 
implementation controls vary by the type of package you select. If a control does not 
apply to a particular package type, it is disabled or is not displayed.

 

• Name—Specifies the name of the Channel.

• Program—Specifies the Program to use for this Channel.

• Package—Click the + icon to add Packages to the Channel, then select the type of 
Package to use and specify the implementation for the Package. You must name 
the Channel and assign a Program before you can add Packages. 
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– CBR Padding—When enabled, specifies the percent of padding to add to a 
Transport Stream to create a more stable bit rate output from a variable bit rate 
input. The range is 1 to 100%. 

– PID—When enabled, specifies the packet identifier values of PMT (Program Map 
Table), video, and audio PIDs.

Note: Only use values in the range of 32 to 8186 for PID settings. Other values may be 
reserved for specific uses.

– Output Location—Specifies the Output Location for each Package and to enter 
information as required for File Path, Publishing Point, etc. Settings vary by type 
of location—see Output Locations for details.

– Output Package Name—Use the Default Name or set a Custom Name. The 
Default Name is the Channel Name. For the Custom Name, type in the Base 
Name and select if you want to add the Date/Time to the Base Name for the final 
output Package name.

– Output File Name—When using an MP4 Package and you require more control 
over the file name, specify the output file name. When no Base Name is specified, 
the Variant name is used. Complete the following:

– Base Name—Specifies the name to use for the base file name. When specified, 
this replaces the Variant name.

– Attach Date/Time—Enable for the date and time to be added to the file name. 
The date/time is added to either the Base Name or the Variant name. 

• Channel Start—Settings to adjust content start time. Available when Advanced 
mode is enabled. 

– Retroactive Start Offset—When enabled, applies the specified start offset, in 
seconds, to the input content. The specified seconds of content is retained and 
captured before the channel is started, and included in the output. The default is 
2 seconds and the range is 0 (zero) to 30 seconds.
The input’s source media is stored in a buffer which allows Live Stream to reach 
back in time and access media processed in the past based on the value of the 
offset. Since Live Stream is always processing an input source’s media, when a 
channel start is initiated any media stored in the buffer is available to be added 
to the output.

Note: Retroactive Start Offset only works for live sources. The source must be running 
long enough to cover the offset time specified. Non-live sources such as a Source 
Playlist or a Video Base Asset won't work because the sources are started the same 
time as the channel, so media samples are not stored before the channel is started. 

• Captioning—Settings for live captioning input. The captions are encoded into the 
channel output. Complete the following to specify captioning settings:
– Port—When enabled, activates the live captioning feature, and sets the port 

number to use for captioning input. (Default: 16161).
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– Channel Delay—When enabled, applies the specified delay, in seconds, to the 
program output before encoding. This delay occurs after the Captioning Preview 
and before the stream is sent out in order to provide the time needed to create 
and add the captions to the input feed. 

Live Captioning Input
See Using Live Captioning Input via IP for information about accessing the Captioning 
Preview and more information about live captioning. 

Output Locations
A variety of Output Locations are provided for Packages. The Publishing Point setting is 
only relevant if you have a web server set up on this server and the location can be 
accessed. The Local Origin Server Output Location is selected by default.

Output Location configuration is performed in the Configure Channel panel—see 
Adding and Configuring Channels.

Note: When a Publishing Point is entered and the channel is activated, selecting the 
Output Preview icon  displays a QR code and a preview link. The QR code is valid 
for HLS | CMAF | DASH output to the Local Origin Server or a File Server with a 
Publishing Point, but not for CDN output. See Previewing Channel Output. 

■ Local Origin Server Output Location

■ File Server Output Location

■ Network Drive Output Location

■ Push to CDN Output Location

■ Pushing to Primary/Backup CDN Output Location

■ Push to Unified Origin Output Location

■ UDP Stream Output Location

■ SRT Stream Output Location

Local Origin Server Output Location

A Local Origin Server output location is the Live Stream server itself—where the stream 
originates. There are no user-configurable controls—the file path and publishing point 
are generated automatically and are not displayed. 

Here is the format for each:

•  File Path—Specifies the folder where files are written with the Channel Name to 
the Lightspeed Live Server's Local Origin Server web root folder: 

D:\Stream\ <channel name>\

For example, if the Channel Name is MyChannel, the auto-generated file path is:
D:\Stream\MyChannel\
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• Publishing Point—Specifies the URL for playback access. The publishing point is 
only relevant if you have a web server set up on this server and the location can be 
accessed. For HLS | CMAF | DASH, the URL is used to create the QR code (Previewing 
Channel Output). The publishing point uses the default App Server port (8089).

http://<local server name>:8089/webroot/<channel name>/<playlist.file>

For example, if your Local Server Name is MyCaptureServer, your Channel Name 
is MyChannel, and your file is playlist.m3u8, the auto-generated Publishing 
Point is:
http://MyCaptureServer:8089/webroot/MyChannel/playlist.m3u8

File Server Output Location

A File Server output location is a path on another computer on your network, which has 
been mapped to a Drive Letter on the Live Stream server, so that your computer can 
access it via a Drive Letter path. Configure these controls:

• File Path (Required)—Specifies a partial folder path as a Drive Letter path on your 
file server as the root for the package files. Packages are written to a new folder 
appended to this path using the Channel Name, using this format:

D:\<File Server Path>\

Don’t place a channel name in this path—Live Stream adds the channel name and 
writes the file/files in the folder.

For example, if the File Server Path is MyStreams and the Channel Name is Boat-
sofPortTownsend, then the file path is:
D:\MyStreams\BoatsofPortTownsend

• Publishing Point—Specifies a partial URL for playback access. Live Stream 
appends the Channel Name as a folder and packages are streamed from this loca-
tion. The publishing point is only relevant if you have a web server set up on this 
server, and the location can be accessed. For HLS | CMAF | DASH, the publishing 
point URL is used to create the QR code. Here is the format: 

http://<servername>:<port>/<File Server Path> 

Don’t place a channel name in this path—Live Stream adds the channel name and 
streams from this folder.

For example, if the servername is MyStreamServer, the File Server Path is 
MyStreams, the Channel Name is BoatsofPortTownsend, and the playlist is 
playlist.m3u8, the URL is:
http://MyStreamServer:8089/MyStreams/BoatsofPortTownsend/
playlist.m3u8

Network Drive Output Location

A Network Drive output location is another computer on your network that your 
computer can access via a UNC path.
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• UNC Path (required)—Specifies a partial folder path as a UNC directory on your 
file server as the root for the package files. Files are written to a new folder 
appended to this path using the Channel Name, in this format:

\\<servername>\<path>\

Don’t place a channel name in this path—Live Stream adds the channel name and 
writes the file/files in the folder.

For example, if the servername is MyStreamServer, the path is \DASHPackages, 
and the Channel Name is BoatsofPortTownsend, then the file path is:

\\MyStreamServer\DASHPackages\BoatsofPortTownsend

• Username (required)—The user name used to connect to the network drive. 

• Password (required)—The password associated this user name.

• Publishing Point—Specifies a partial URL for playback access. Live Stream 
appends the Channel Name as a folder and packages are streamed from this loca-
tion. The publishing point is only relevant if you have a web server set up on this 
server, and the location can be accessed. For HLS | CMAF | DASH, the publishing 
point URL is used to create the QR code. Here is the format: 

http://<servername>:<port>/<File Server Path> 

Don’t place a channel name in this path—Live Stream adds the channel name and 
streams from this folder.

For example, if the servername is MyStreamServer, the File Server Path is 
MyStreams, the Channel Name is BoatsofPortTownsend, and the playlist is 
playlist.m3u8, the URL is:
http://MyStreamServer:8089/MyStreams/BoatsofPortTownsend/
playlist.m3u8
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Push to CDN Output Location

The Push to CDN Output Location streams your content to a Content Delivery Network 
(CDN) such as YouTube Live (HTTP) or Akamai (HTTP/HTTPS).

• Publishing Point (Required)—Specifies the URL for playback access. Publishing 
Point allows the user to specify a base URL so that packages published to a CDN can 
be accessed via that URL. The format of the URL varies by Akamai network and by 
package type and version. See appropriate documentation.

• Playback Base URL—Enable to enter the parent path of the primary event or chan-
nel name. 

• Dual Channel Mode—Enable to enter the following for dual channel mode opera-
tion:

– Publishing Point of Backup Channel—The URL of the CDN publishing point of 
the backup channel.

– Playback Base URL of Backup Channel—The parent path of the event or 
channel name of the backup channel. 

– Playlist Name of Backup Channel—Enter the playlist name of the backup 
channel. 

– Merged Playlist Name—Enter the name of the merged playlist. This playlist 
combines the playlists from the primary and backup channels. 

• HTTP Method—Enable HTTP Method and choose POST | PUT for pushing files to 
the CDN. When disabled, the POST method is used, even if PUT displays as selected. 

• Remove Local Copy—A set of files is cached on the local server until they are 
posted successfully. When you enable Remove Local Copy, Live Stream removes the 
local copy of the HLS or DASH Package files after they are successfully posted to the 
CDN. Also, when the Channel is stopped (either by a user or unexpected error) the 
local files/folders are removed. 

Disable to keep all of the files when the Channel is stopped.

The number of Segments specified in a Package for Elements of the Rolling Playlist   
are retained. When the maximum number of Elements specified in the Package set-
tings is reached, the oldest Segment that has been uploaded is removed. 

When you use the default Rolling setting in Packages, that setting takes prece-
dence and the locally stored Segments are only deleted when the Rolling Limit is 
reached or the Channel is stopped.

When you use the Appending option for the Playlist Type in the Package settings, 
all Segments are kept and only removed after they are posted to the CDN. 
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Pushing to Primary/Backup CDN Output Location

The Push to Primary/Backup CDN Output Location enables you to specify two 
publishing points and publish the same content to Akamai via HTTP/HTTPS to primary 
and backup locations concurrently. When publishing to two publishing points, if one 
connection fails during playback, the other location begins streaming and enables 
players to continue viewing the stream.

The format of the Publishing Point and Primary/Backup Playback Base URLs vary by 
Akamai network and by package type and version. See appropriate documentation.

You should enable Dual Channel Mode for an HLS package (see Apple HLS Packages) 
primary channel—you should not enable it for the backup channel. For the primary 
channel, provide the publishing point/playback base URLs for primary and backup 
channels respectively. Also provide the playlist name of the backup channel, as well as 
the merged playlist name. The primary channel is responsible for creating a merged 
playlist and pushing it to both the primary and backup entry point.

The primary channel and backup channel should be configured with the same settings: 
channel name, program/rendition, package/variants, and encoders. You should start 
the backup channel first, and then start the primary channel. When you play back the 
stream, you should concatenate the playback base URL, the channel name and the 
merged playlist name to obtain the full path playback URL. For example, http://
telestream-i.akamaihd.net/hls/live/261579/hls1/master.m3u8. 

Note: When streaming Apple HLS packages to dual publishing points (primary and 
backup), the master playlist must be merged for both packages on a single encoder, 
and if using separate encoders for Primary and Backup, both encoders must have the 
same merged master manifest playlist files. 
See the Apple developer topic Using HTTP Live Streaming for details. 
See appropriate Akamai documentation for using merged manifests.

• Primary Publishing Point (Required)—The URL where Live Stream’s HTTP PUSH 
requests are directed for publishing the package to the CDN.

• Primary Playback Base URL—The URL where the package can be accessed, which 
is added to the merged playlist. The Playback Base URL enables you to specify a 
base URL so that packages can be accessed via that URL. 

• Backup Publishing Point (Required)—The URL where the package can be 
accessed. The Publishing Point allows the user to specify a base URL so that pack-
ages can be accessed via that URL.

The Publishing Point has the following form: 

http://post.<host name>/<stream id>-b

• Backup Playback Base URL—The URL where the package can be accessed. The 
Publishing Point allows the user to specify a base URL so that packages can be 
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accessed via that URL. The format of the URL varies by Akamai network and by 
package type and version. See appropriate Akamai documentation.

The HLS Base URL has the following form: 

http://<host name>/hls/live/<stream id>-b/<channel name>/playlist.m3u8 

where playlist.m3u8 is the default playlist name, but can be modified by you (see 
Apple HLS Packages or CMAF (Common Media Application Format) Packages).

Note: If you use the HLS Playback URL in a browser other than Chrome or Safari, it will 
only display a list of HLS Transport Stream (.ts) segments.

The DASH Playback Base URL has the following form:
http://<host name>/hls/live/<stream id>/<channel name>/playlist.m3u8
where playlist.m3u8 is the default playlist name, but can be modified by you (see 
Apple HLS Packages or CMAF (Common Media Application Format) Packages).

Note: When the channel is activated, select the Output Preview icon  to display a 
QR code and preview link. The QR code is valid for HLS | DASH | CMAF output to the 
Local Origin Server or a File Server with a Publishing Point, but not for CDN output. See 
Previewing Channel Output. 

• HTTP Method—Enable HTTP Method to choose either POST or PUT when pushing 
files to the CDN. When disabled, the default POST method is used, even if PUT 
shows as selected. 

• Remove Local Copy—A set of files with the rolling setting on the local server are 
always cached until they are posted successfully. Enable Remove Local Copy so that 
when the Channel is stopped (either by a user or unexpected error) the local files/
folders are removed. Disable to keep all of the files when the Channel is stopped. 
(You can configure Package settings to control whether you use Rolling (the default 
setting) or Appending. Rolling retains only the number of segments that the user 
specifies, while Appending keeps all segments.

Push to Unified Origin Output Location

A Push to Unified Origin output location is a proprietary CDN accessible via HTTP/
HTTPS and is only available for DASH Packages.
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• Publishing Point—The URL where the package can be accessed. Publishing Point 
allows the user to specify a base URL so that packages published to Unified Origin 
can be accessed via that URL.

The Unified Origin Publishing Point has the following form: 

http://<origin name>:<port number>/<channel/input location>/
<channel/input location>.isml

For example, if your Origin Name is OriginName, your Port Number is 8080, and 
your Channel Name is Channel1, the Unified Origin Publishing Point is:
http://OriginName:8080/Channel1/Channel1.isml

The Unified Origin Playback URL has the following form:

http://<origin name>:<port number>/<channel/input location>/<channel name>/
<input location>.isml/<playlist file name>.mpd|m3u8.

UDP Stream Output Location

Use the UDP Stream Output Location to deliver Transport Stream media to servers that 
support delivery of Transport Stream video via UDP.

• CBR Padding—When enabled, specifies the percent of padding to add. 

• PID—When enabled, specifies the packet identifier values of PMT (Program Map 
Table), video, and audio PIDs.

Note: Only use values in the range of 32 to 8186 for PID settings. Other values may be 
reserved for specific uses.

• Output Location—Choose from the list of destinations you’ve created.

• IP Address/Host Name—Specifies the IP address | Host Name of the destination.

• Local NIC/IP Address—When enabled, specifies the local Ethernet connection to 
use, when multiple are available on this platform. For ATS Packages, the NIC must 
be specified. When disabled, the output interface is determined automatically.

• Use Server Name as Endpoint—When the output is an ATS package, you enable 
this control to indicate that the endpoint is configured using the server name, 
rather than the IP address. 

• Accurate Timing—When enabled, there is less jitter in the channel, but CPU usage 
is higher. When disabled, CPU usage is lower. 

• Port Number—Specifies the port number being utilized on the destination for 
each variant. For ATS (Adaptive Transport Stream) Packages, there are individual 
port numbers for each Variant in the Package. The default port numbers start at 
1234 and increment to 1235, 1236, and so on. To specify custom port numbers, 
change the values to what you want, within the range of 1 to 65535. 

• Password for Stream Encryption—When enabled, specifies the passphrase for 
encryption (10-79 characters).
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• Encryption Key Length—When enabled, specifies the key length ID. AES-128 uses 
a 16-character (128-bit) passphrase; AES-256 uses a 32-character (256-bit) pass 
phrase.

• Source Description Path—When enabled, specifies the name and fully-qualified 
path to an XML file that contains an MPD element specifying the bit rate, resolution, 
and destination address of the Variants in the Package. For example: D:\LiveS-
tream\SRTOutput\BoatsofPortTownsend_Variants.xml.

SRT Stream Output Location

Use the SRT Stream Output Location to deliver Transport Stream media to servers that 
support delivery of Transport Stream video via SRT. 

• CBR Padding—When enabled, specifies the percent of padding to add. 

• PID—When enabled, specifies the packet identifier values of PMT (Program Map 
Table), video, and audio PIDs.

Note: Only use values in the range of 32 to 8186 for PID settings. Other values may be 
reserved for specific uses.

• Output Location—Choose from the list of destinations you’ve created.

• IP Address—Specifies the IP address of the destination.

• Local NIC/IP Address—When enabled, specifies the local Ethernet connection to 
use, when multiple are available on this platform. For ATS Packages, the NIC must 
be specified. When disabled, the output interface is determined automatically.

• Use Server Name as Endpoint—When the output is an ATS package, you enable 
this control to indicate that the endpoint is configured using the server name, 
rather than the IP address. 

• Accurate Timing—When enabled, there is less jitter in the channel, but CPU usage 
is higher. When disabled, CPU usage is lower.

• Port Number—Specifies the port number being utilized on the destination for 
each Variant in the Package.

• Password for Stream Encryption—When enabled, specifies the passphrase for 
encryption (10-79 characters), and depends on the encryption profile:
- AES-128 encryption requires a 16 character passphrase
- AES-192 encryption requires a 48 character passphrase
- AES-256 encryption requires a 64 character passphrase.

• Encryption Key Length—When enabled, specifies the key length ID. AES-128 uses 
a 16-character (128-bit) passphrase; AES-256 uses a 32-character (256-bit) pass 
phrase.

• Source Description Path—When enabled, specifies the name and fully-qualified 
path to an XML file that contains an MPD element specifying the bit rate, resolution, 
and destination address of the Variants in the Package. For example: D:\LiveS-
tream\SRTOutput\BoatsofPortTownsend_Variants.xml.
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Akamai CDN Publishing Point and Playback URLs
You can publish DASH | HLS | RTMP | CMAF packages to Akamai. The format of the 
publishing point and playback URLs are dependent on several variables: Stream ID, 
Channel Name, and potentially the playlist file name. URLs vary by Akamai network and 
by package type and version. Refer to the appropriate documentation for details.

Streaming to Akamai via HTTPS

When publishing DASH packages to Akamai 4.0 networks using HTTPS, a period (.) is 
used between post and the host name:

https://post.MyHostName-i.akamaihd.net/123456

For example:

https://post.123456.MyHostName.r.akamaientrypoint.net/dash/123456

There are slight differences between A DASH Playback 4.0 network URL has the 
following form:

 http://<Host_Qualifier>.akamaihd.net/dash/live/<6 digit User ID>/<EVENT_NAME>/
<PLAYLIST_FILE>.mpd

For example:

http://x-xx123456-a.akamaihd.net/dash/live/444555/BoatsOfPortTownsend/
BOPT_Playlist.mpd

where the playlist name can be configured in the Dash Package. 

HLS

There are several different HLS formats—some televisions support 3, some support 4. 
Version 7.0 is the latest version.
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RTMP Channel Destination Configuration
RTMP Packages can be delivered to Destinations including Akamai, YouTube Live, 
Limelight, and other destinations—another Lightspeed server or a Wowza server, for 
example.

 

RTMP Package Destinations
Live Stream provides these destinations for RTMP Packages.

■ Custom URL(s) Destination

■ YouTube Live RTMP Destination

■ Akamai RTMP Destinations

■ Limelight Destination

Custom URL(s) Destination
The Custom URL(s) Destination provides broader access to destinations by identifying 
the destination simply by its URL. The Custom URL(s) configuration panel automatically 
displays a URL field for each Variant in your Custom RTMP Channel. You can specify the 
same URL for each variant, or you can specify a unique URL for each.

Note: You can also push the RTMP stream directly to a remote/OVP host or to another 
Lightspeed Live server. The names are case-sensitive. See Creating and Configuring an 
RTMP Source for the Stream Name.

• Destination Username—When enabled, specifies the authorized username to 
access the server. If a username is required, enable this control and enter the user-
name. Otherwise, disable the control.
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• Destination Password—When enabled, specifies the password associated with 
the username, if one is assigned. Otherwise, disable the control.

• URL (Required—one for each Variant)—Specifies the destination URL for the 
variant. 

The publishing point has the following form:

rtmp://<server name>:<RTMP port (default is 1935)/live

For example: rtmp://server.telestream.net:1935/live

Note: RTMPS is also supported, using the form rtmps://...

• Stream Name—Specifies the stream name for this Variant. When left blank, the 
default value used: <Channel Name>-<Variant Name>. You can edit the stream 
name for easier reference. Stream Names are case-sensitive.

YouTube Live RTMP Destination
When configuring an RTMP channel for YouTube, you enter the Server URL and Stream 
name/key from the YouTube Live dashboard. RTMP streaming provides fewer options 
than the method described in YouTube Live Channel Configuration.

• Server URL—Specifies the Server URL from the YouTube Live dashboard.

• Stream name/key—Specifies the Stream name/key from the YouTube Live dash-
board.

Note: If you mistakenly stream more than one RTMP stream to the same YouTube 
account, YouTube will display a unique Offline status. Additionally, it will seem as 
though your RTMP stream is not connecting to YouTube. The status indicates Offline, 
but with an orange stream strength indicator color. 





If you encounter this status, there is a good chance that you have more than one 
active RTMP stream directed to the same YouTube account. 

Akamai RTMP Destinations

Note: When streaming to Akamai via RTMP, you must set --bframes 0 if you are using 
Closed Captions; otherwise the captions will be garbled. This setting should be used 
for all RTMP to social media destinations.

• URL—The URL is optional. The URL is auto-generated from information that is 
obtained from your configurations. Manually entering a URL is useful if you want to 
contribute to a backup entry point. When enabled, specifies the URL for this Chan-
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nel, which may contain multiple Variants. Akamai converts the RTMP streams to 
HLS, and each Variant is used as one of the HLS stream’s Variants.

The publishing point has the following form:

rtmp://<Akamai Entry Point>/EntryPoint/

For example:
rtmp://x.xx12345.i.akaimientrypoint.net/EntryPoint/

• Stream ID (required)—Specifies the six-digit number obtained from the Akamai 
portal when you set up your RTMP entry point.

• Username (required)—Specifies the authorized username to access the server. 

• Password (required)—Specifies the password associated with the username.

• Angle (required)—For Akamai output, you can define a value for the angle, which 
is included in the playback URL. The default is live. 

• Output Package Name—Specifies the type of output package name Default | Cus-
tom. When you select Default, Live Stream uses the Channel name. When Custom is 
selected, compete the following fields: 

• Output Package Name—Specifies the type of output package name: Default | 
Custom. When you select Default, Live Stream uses the Channel name. When Cus-
tom Name is selected, compete the following fields: 

– Base Name—Specifies the base name of the output package name. By default, 
Live Stream uses the Channel name. When Custom is selected, compete the 
following fields: 

– Attach Date/Time—When enabled, appends a date-time stamp to the Output 
Package Name.

Limelight Destination
• Primary URL (required)—Specifies the URL for this Variant.

The publishing point has the following form:

rtmp://<server name>:<RTMP port (default is 1935)/live

For example: rtmp://server.telestream.net:1935/live

• Backup URL—When enabled, specifies the URL for this Variant.

The publishing point has the following form:

rtmp://<server name>:<RTMP port (default is 1935)/live

For example: rtmp://server.telestream.net:1935/live

• Stream Name (required)—Specifies the name of this RTMP stream source.

• Username (required)—Specifies the authorized username to access the server. 

• Password (required)—Specifies the password associated with the username.
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RTMP Playback URLs for Akamai
To playback an RTMP stream from Akamai, use the following URLs:

For Video with Audio or Video Only
The playback URL has the following form:

http://<StreamName>.akamaihd.net/i/<ChannelName>_<Angle>@<StreamID>/
master.m3u8

For example, if your Stream Name is MyStream, your Channel Name is MyChannel, 
your Variant Name is Variant1, you keep the Angle at the live default, and your Stream 
ID is 123456, then the playback URL for video with audio or video only is:

http://MyStream.akamaihd.net/i/MyChannel_live@123456/mas-
ter.m3u8

For Audio Only

The playback URL has the following form:

http://<StreamName>.akamaihd.net/i/<ChannelName>_<VariantName>@<Stre-
amID>/master.m3u8

For example, if your Stream Name is MyStream, your Channel Name is MyChannel, 
your Variant Name is Variant1, and your Stream ID is 123456, the playback URL for 
audio only is:

http://MyStream.akamaihd.net/i/MyChannel_Variant1@123456/mas-
ter.m3u8

YouTube Live Channel Configuration

Note: When streaming to YouTube Live via RTMP, you must set --bframes 0 if you are 
using Closed Captions; otherwise the captions will be garbled. This setting should be 
used for all RTMP to social media destinations (including Akamai).

Creating a Channel to stream to YouTube requires specific settings in Encoders and 
Packages, and creating a connection from Live Stream to your YouTube account in the 
Configure Channels dialog. See Creating a YouTube Live Stream Channel for the 
complete procedure to create a live stream to YouTube.

Facebook Live Channel Configuration

Note: When streaming to Facebook Live via RTMP, you must set --bframes 0 if you are 
using Closed Captions; otherwise the captions will be garbled. This setting should be 
used for all RTMP to social media destinations (including Akamai). 
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Streaming to Facebook Live requires specific settings in Lightspeed Live Stream and 
making a connection from Live Stream to your Facebook account. See Creating a 
Facebook Live Stream Channel in the Social Media Platform Workflows chapter for the 
complete procedure to create a live stream to Facebook.

Selecting the Input Source for a Segment
When a Segment has more than one Source asset, you must select the Source to use. 
From the Input menu, select the input source to use for each Source Placeholder in the 
selected Channel. The available selections are what you have configured in the Sources 
panel.

When a Source Placeholder has not been added to the Segment of a Program, the Input 
panel is not populated. When you activate a Channel that does not have an input 
source, the image or video assets from the Segment are what is provided in the output 
of the Channel. 

Multiple Renditions or Segments
When you select a Package that contains a Program with more than one Rendition, or a 
Rendition with more than one Segment, the Renditions and Segments all appear as 
separate items in the Channel view. 

When you start streaming a Channel, all Renditions and Segments in that Channel are 
activated. The Segment in the upper left is the primary, or Segment that is active first. 
Trigger settings and conditions may cause another Segment to become active first, or 
determine which is active next. The primary Segment is determined by the stacking 
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order in the Programs panel. See Segment Stacking Order Determines which Segment is 
Primary. 

Scheduling Channel Activation Events
The Schedule Channel Activation calendar is used to set schedules for Stream 
activation and stopping. To open the calendar, first select a Channel and click the  
clock icon next to the Start button. Click off of the calendar to close it. 
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Modifying Events When a Channel is Active
Existing Calendar Event schedules can be modified even when a Channel is actively 
streaming. Calendar Events cannot be added or removed when a Channel is active. 

 

Clock Icon Indicates a Schedule
The icon by each Channel changes to a clock icon when a schedule exists on that 
channel. The clock icon displays red when the Channel is active and gray when inactive. 
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Configuring Event Schedules
Click the + icon to open the Configure Channel Event dialog so you can set the event 
schedules. 

 

The Configure Channel Event dialog provides these options:

• Title—Specifies the title of the stream activation event. You must create a unique 
name for each event in the Channel. 

• Schedule—Choose from these schedule options:

– Once—Schedules an event that will occur one time, from the start date and time 
to the end date and time specified.

– Daily—The event will occur every day, on the days within the date range, and 
within the start and end times that are set. 

– Weekly—Sets the event to occur on selected days of the week, within the 
specified date range, and within the start and end times that are set. 

– Monthly—The event will occur once a month on the date set, on the months 
within the date range, and occur within the start and end times that are set.

• Event Time—Sets the start and end time of the event. To change the time you can 
type in a value or use the scroll arrows. 

• Range—Sets the date range for daily and monthly schedules, or the choose days of 
the week for weekly schedules. To change the date you can type in a value, use the 
scroll arrows, or select the down-arrow to open a date selection calendar. 
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Starting and Stopping a Channel
After all settings have been configured, select a Channel and click the large green Start 
button to activate the Channel. Click the large red Stop button to deactivate the 
selected channel.

When you start the stream, the selected Source is encoded in the output format you 
specified to the location you have specified. You can also select other Channels and 
activate them to stream concurrently. 

  

Note: When you activate stream (by pressing Start), configuration settings cannot be 
changed for that stream. A red lock icon  displays in the upper right corner of 
components and settings that are used by the stream. When you press Stop to de-
activate the stream, you can edit components again. 
While components are locked, some settings can still be duplicated, and existing 
Calendar Events can be modified.

Previewing Channel Output
When the channel’s output location is Local Origin Server, or File Server | Network Drive 
you provide a Publishing Point, the Output Preview icon becomes active when you 
start the stream; otherwise the Output Preview button is not active.

Select the Packages tab to access the Output Preview icon. 

Output Preview Icon

When you click the Output Preview icon a QR code and link display that you can use to 
access the preview location to verify that the output is live. The QR code is valid for HLS 
| DASH | CMAF output to Local Origin Server | File Server | Network Drive with a 
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Publication Point, but not for CDN output. You can scan the QR code or click the link to 
access the preview location. 

Activated Channel Operation
The following image shows an activated Channel. A thumbnail preview of the Stream is 
displayed on the Packages tab for each Variant. The information bar at the bottom of 
the window displays the output location and statistics for the resources being used, 
and the dot or clock next to each Channel turns red when the Channel is active. The dot 
changes to a clock icon when a calendar schedule exists on that channel. 

Output Information

The Output Information bar is divided into two panels:

• Channel—The Channel panel provides information for the currently selected 
Channel that is active.

• Machine—The Machine panel provides the total resource usage statistics for all 
Lightspeed Live Servers that are currently operating in the system. Select an active 
Channel to view the Output Information bar. 

Note: When the full text of the channel Output Location is too long to display, hover 
over the value to see the full location path in a tooltip.
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Output InformationRed for Active Channel
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Streaming to Social Media 
Platforms
This chapter describes setting up prototype workflows for streaming live to YouTube 
Live and Facebook Live.

Topics
■ Creating a YouTube Live Stream Channel

■ Creating a Facebook Live Stream Channel
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Creating a YouTube Live Stream Channel
Streaming live to YouTube requires specific settings in Lightspeed Live Stream and 
making a connection from Live Stream to your YouTube account. 

Follow these steps to stream live to YouTube using the YouTube Live Package method:

1. Create the Program you want to use to stream live to YouTube. See Adding and 
Configuring Programs.

2. Create the audio and video Encoders you want to use. See Adding and Configuring 
Encoders. Only certain encoder settings are allowed; see YouTube Live Encoder 
Stream Settings. 

3. In Packages, Click the + menu to create a new Package and select YouTube Live. 
Enter the name for the Package and select the Program you want to use. See Adding 
and Configuring Packages. 

4. Add a Variant to the Package; select the Rendition, Video Stream, and Audio Stream 
encoders that you created for YouTube in step 2. Only one Variant is allowed for a 
YouTube Package. See Adding and Configuring Variants.

5. Click the + menu to add a new Channel. The Configure Channel dialog displays.

 

6. Type a name for the Live Stream Channel, select a Program, then add a Package and 
select the Package you created for YouTube:

7. Select your Social Media Account in the User Name field.

If you haven’t yet authenticated your YouTube account in Live Stream, go to Social 
Media Accounts and perform that task. Then, return.

8. Click Save to accept the settings. This creates the Channel and connects to your 
YouTube account. 

Adding Events
1. Select the new Channel and click the Pencil icon  to open the Configure 

Channel dialog.
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2. From the Event menu you can select (Default Channel) or (New). When you select 
(New), configure the following options: 

– Event Title—Specifies the name for the event.

– Planned Start Date and Time—Set the planned start date and time, for 
notification of your subscribers. (This does not start the live Stream. Press the 
Start button to start the live stream. See step 17 below.)

– Planned End Date and Time—Set the planned end date and time. This is only 
for subscriber notification and does not stop the live stream. 

– Broadcast Description—Create an optional description.

– Tags—Specifies any search or description tags you would like for the live stream.

– Privacy—Select the privacy setting you want for the live stream.

– Closed Captions—Turn on Closed Captions if they are included in the live 
stream. When enabled, the captions from the source are included. If you want to 
select from C608 or C708 caption text tracks in your input source, see Adding and 
Configuring Programs. Options for adding captions are also available in YouTube.

– Category—Select the YouTube category associated with the live stream. 

– Delete Video from YouTube After Broadcast—Enable this to delete the video 
so it cannot be watched at a later time. 

 

3. Click Save. The Channel is now ready to stream live. 

4. Select the Channel you just saved and click the Start button . 
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5. Go to your YouTube channel and from the menu on the left select Live Streaming > 
Events. 

6. On YouTube, you can select the thumbnail to view the live stream, or select Edit or 
Live Control Room to manage the live stream.

7. After the program has concluded, click the Stop button in Live Stream to deactivate 
the channel . 

Sending Multiple Streams to YouTube from One Channel
You can create up to six Secondary Packages in the Configure Channel dialog to send 
multiple version of the video stream to different YouTube accounts or brand channels. 

The options for Secondary Packages are the same as Primary Packages. 
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Creating a Facebook Live Stream Channel
Streaming to Facebook Live requires specific settings in Lightspeed Live Stream, 
changing the Facebook app privacy settings, and making a connection from Live 
Stream to your Facebook account. Please refer to Facebook Live help for their current 
maximum time limit for the live stream. 

The following are some timing parameters to keep in mind when creating Facebook 
live streaming channels:

• The scheduled start time cannot be greater than 1 week in the future, or less than 
10 minutes from the current time.

• A Facebook live stream cannot be activated more than 10 minutes before or after 
the planned start time.

Changing Facebook App Privacy Settings
The default privacy settings for your user is Only Me for apps in Facebook and must be 
changed for the Live Stream video to display for friends or to public viewers. The 
privacy settings for Pages, Groups, and Events is already set by Facebook to Public, and 
can’t be changed. 

To change your user app privacy settings in Facebook:

1. Log into your Facebook user account.

2. Click the down-triangle in the top right of Facebook and select Settings. 

3. Click Apps in the left menu.

4. Hover over the Live Stream app and click the pencil icon to edit its settings.

5. Change App Visibility to Public or Friends. 

Note: If you set your Live Stream app privacy settings in Facebook to Friends, then 
Live Stream can use the Only Me or Friends privacy values but not Public, even if you 
select Public in Live Stream. If you set your privacy settings to Public, then you can 
select from all options in Live Stream: Only Me | Friends | Public. 

Configuring a Live Stream to Facebook Channel
Follow these steps to stream live to Facebook using a Facebook Live Package:

1. Add and authenticate your Facebook Live account in Settings > Social Media 
Accounts. See Social Media Accounts.

2. Create the Program you want to use to stream live to Facebook. See Adding and 
Configuring Programs.

3. Create the audio and video Encoders you want to use to stream live to Facebook 
Live. See Adding and Configuring Encoders. Only certain encoder settings are 
allowed, see Facebook Live Encoder Stream Settings. 
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4. In Packages, Click the + menu to create a new Package and select Facebook Live. 
Enter the name for the Package and select the Program you want to use. See Adding 
and Configuring Packages. 

5. Add a Variant to the Package; selecting the Rendition, Video Stream, and Audio 
Stream encoders that you created for Facebook Live. 

6. In Channels, click the + menu to add a new Channel. The Configure Channel dialog 
opens. (For a detailed explanation of configuring channels, see Adding and 
Configuring Channels).

7. Enter a name for the Channel, select your Program, and add one or more Packages 
you created for Facebook Live.

8. Select your Social Media Account in the User Name field.

If you haven’t yet authenticated your Facebook Live account in Live Stream, go to 
Social Media Accounts and perform that task. Then, return and continue.

9. Click Save to update the channel and begin using it.

Now that you have completed the channel configuration, you can either start the 
channel dynamically or you can set up a schedule.

Setting up a Schedule
1. Select the Channel you just saved and click the Pencil icon  to open it for 

editing.
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2. For Schedule, select one of these connection methods:

– Go Live Now—When you start the Channel the stream goes live immediately.

– Schedule for Later—The video starts later at the time and date you set. A 
message is posted on the viewing location and a message may be sent to 
potential viewers, depending notification settings, stating the planned start date 
and time.

After you start the channel stream, the following status messages are added to the 
Schedule name and will update when the status changes:

– [Unpublished]—The video is live but you have hidden it on your Timeline so it 
can’t been seen.

– [Scheduled_Unpublished]—The scheduled event has been created but has not 
started. 

– [Scheduled_Live]—The event is live but video is not yet appearing. 

– [Scheduled_Expired]—The live video was not started within 10 minutes of your 
planned start time.

– [Scheduled_Canceled]—The scheduled event has been canceled. 

– [Live]—Indicates the channel is currently streaming live.

– [Live_Stopped]—The live stream has been stopped.

– [Processing]—After you stop the channel, indicates that processing is occurring.

– [VOD]—(Video On Demand) Indicates that the video is available to view on 
Facebook after the live stream event has ended.

3. The following options are available, depending on your Schedule selection:

– Planned Start Date and Time—Set the start date and time (Available when 
Schedule for Later is selected). The planned start time you set must be at least 10 
minutes, or more, in the future from the current time. If less than 10 minutes, the 
live stream is canceled and the channel will need to be reconfigured to make a 
new connection. The planned start time cannot be greater than 1 week in the 
future. 

– Event Title—Specifies the name for the event.

– Broadcast Description—Create an optional description. It’s a good idea to have 
a description because this is displayed with the video. 

– Secure Connection (SSL)—Enable to use secure connection, utilizing RTMPS. 

– Delete after Broadcast—Enable this to have the video deleted from Facebook 
so it cannot be watched at a later time. 
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– Post To—Select one of these options for the video stream destination:

User—Your user Timeline.

Pages—Pages you have created and own in Facebook. When you select this 
option your Pages become available to select. 

Groups—Groups you have created and own in Facebook. When you select this 
option your Groups become available to select. 

Events—Events you are an administrator for. When you select this option your 
Events become available to select. 

4. When User is selected, the following Privacy options are available:

– Public 

– Friends 

– Only Me

5. Click Save to close and save the Configure Channel dialog changes.

6. Select the new Channel you just created, click the Program tab and choose an Input 
Source for the Segment(s). 

7. Select the Channel and click the Start button . Live Stream connects to 
Facebook and starts the video stream immediately, or later, depending on your 
schedule selections. 

Note: A Facebook live stream can not be started more than 10 minutes before or after 
the planned start time. 

8. Go to the destination on Facebook and view your live streaming video. 

Note: You may need to refresh the page to see the live video, and refresh again later 
after you’ve stopped the live stream to see the saved playable video in your Timeline.

9. After the program has concluded, click the Stop button in Live Stream to deactivate 
the channel .
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Using the Same Channel to Stream Again to Facebook
You can stream again to Facebook using the same channel. To reactivate the channel, 
select Go Live Now or Schedule For Later from the Schedule menu and set the schedule. 
You can change the name and description if desired. The Post To settings cannot be 
changed when reusing a channel to stream. 

Sending Multiple Streams to Facebook from One Channel
You can create up to six Secondary Packages in the Configure Channel dialog to send 
multiple version of the video stream to different Facebook destinations, such as your 
Pages, Groups, or Events. 

The options for Secondary Packages are the same as Primary Packages. 

Note: You cannot send a live stream to YouTube and Facebook in the same Channel.
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